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Intended use of the system

The BodyTom 64 system is intended to be used for x-ray computed
tomography applications for anatomy that can be imaged in the 85cm
aperture. The CT system is intended to be used for both pediatric and adult
imaging and as such has preset dose settings based on weight and age. The
CT images can be obtained either with or without contrast.

The BodyTom 64 system can be used for low dose lung screening. The
screening must be performed in compliance with the approved and
established protocols as defined by professional medical societies.

*Please refer to clinical literature, including the results of the National Lung
Screening Trial (N. Engl J Med 2011;365:395-409) and subsequent literature
for further information.

BodyTom 64 Clinical benefit

Computed Tomography (CT) provides real time imaging of bone, soft tissue
and blood vessels that can provide detailed information to diagnose, plan
treatment for, and evaluate many conditions in adults and children.
Additionally, the detailed images provided by CT scans may eliminate the
need for exploratory surgery.

Consumer information
Proprietary rights

NeurolLogica® and BodyTom 64® are registered trademarks of NeurolLogica
Corporation, a subsidiary of Samsung Electronics Co., Ltd., in the United
States, other countries, or both. Catphan® is a registered trademark of
Phantom Laboratory, Inc. ACR Appropriateness Criteria® is a registered
trademark of the American College of Radiology. Image Gently” is a
registered trademark of Society for Pediatric Radiology. Teflon®isa
registered trademark of E.Il. DuPont and Company. TB Quat™ is a trademark
of ABC Compounding Co. Wex-cide™ is a trademark of Wexford Labs, Inc.,
product number Wexcide128.
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Legal disclaimer

This user manual is intended as a guide for material supplied by NeurolLogica
Corp. It provides the operator with necessary information to carry out
specific procedures and maintain NeurolLogica produced equipment. Use this
manual in conjunction with instruction and training supplied by qualified
NeurolLogica personnel.

Any information or descriptions contained in this manual may not be
reproduced and released to any of the general public or used in conjunction
with other professional instruction without written consent of NeurolLogica
Corp., USA — a subsidiary of Samsung. Direct any written inquiries to the
appropriate address found in the section “Contact information” on page 24.

Unauthorized copying of this user manual may not only infringe copyright but
also reduce the ability of NeurolLogica Corp. to provide accurate and up-to-
date information to users: limited and restricted operators and
administrators.

This user manual, though complete and accurate, may not provide answers to
undocumented changes or unexpected results that could occur from system
anomalies.

Contact information

Keep user information readily available to contact Customer Service about
general assistance or reporting on serious incidents (should they occur).

In the case of a serious incident or adverse event, please notify NeurolLogica
at the below contact information and establishments local competent
authorities.

To provide any comments, suggestions, or corrections to this user manual,
write to and include chapter title and page number:

Neurologica Corporation

Customer Service 14 Electronics Avenue, Danvers, MA 01923 USA
USA and Canada 1-888-564-8561

International 1-978-564-8561

Email support@neurologica.com

If you have any questions about faults or errors on the system, battery or
charge issues, or mechanical issues with the scanner, contact a Technical
Representative.
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If you have questions about the clinical use of your system, building protocols,
creating MPRs, imaging artifacts, creating a clinical workflow or process,
logging in or access issues, and general usage of the system, contact
Customer Service.

Winckels Medical Australian Sponsor Brazilian Authorized

Devices Expertise Distributor

Europe Bergerweg 18 Level 8/15 Talavera VR Medical

6085 AT Horn Road Importadora e
PO Box 646 Distribuidora de

The Netherlands Produtos Médicos Ltda
North Ryde NSW 2113

+31 (0)475 582285 Tel | Australia Rua Batataes, 391,

conjs. 11, 13 e 82 andar
+31(0)475 582278 Fax | M +61(0)412 563 016

Tel CEP: 01423-010-Sao
Paulo

T +61 (0)2 8114 1535

Tel CNPJ:

EC (REP 04.718.143/0001-94

F+61 (0)2 8114 1599

Tel Resp. Técnica: Dra.
Cristiane Aparecida de

c E Customer Service: Oliveira Aguirre- CRF-SP
2862 1-800 060 168 21079

Registro ANVISA n®:
80102511464

Damage in transportation

Closely examine all packages at the time of delivery. If you see damage,
notate “damage in shipment” on all copies of the freight bill before you
accept or sign for delivery (by the facility receiving agent).

Whether damage is noted immediately or concealed (noticed after delivery),
damage must be reported to carrier immediately upon discovery, or within 14
days after receipt, and content and containers held for inspection by carrier.

Keep in mind — the transportation company will not pay a claim for damage if
an inspection is not requested within the 14-day period.
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User requirements

The equipment can only be operated by users who have received professional
medical education and training, such as radiologic technologists, physicians,
radiologists, and other medical specialists.

Users should be trained professionals who are certified to operate such
systems before scanning or diagnosing patients. This training must include
medical and x-ray education, as well as NeurolLogica applications training.

Everyone that uses this equipment must read, understand, and follow all
instructions, precautions, and warnings.

Keep this user manual near the equipment. It is important to review the
procedures and safety precautions periodically.

Essential Performance

The BodyTom 64 has the following essential performance factors mitigated by
design:

e Over Radiation protection

e Re-scan prevention

e Stray Radiation exposure prevention

e Diagnostic performance

About this user manual

The instructions in this user manual describe how to use the NeurolLogica
BodyTom 64 Computed Tomography (CT) system, manufactured by
NeurolLogica Corp. BodyTom 64 is the trade name for the CT system and
NL4100 is the device model.

This user manual does not provide medical explanations but does suggest
potential applications for some of the software features. This user manual
describes potential safety problems and how to avoid them.

Anyone who operates this system should have received training before
attempting to scan or diagnose patients, to include medical and x-ray
education, as well as Neurologica applications training.

This manual is made available in electronic format to the customer as part of
each product delivery.

For electronic manuals, please go to: Forms.samsungneurologica.com.
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Click on “Downloads” and choose “CT Manuals”. The site will ask for the serial
number of your product and a password. The password can be provided from
Field Service.

Translation of this manual is available for any country that does not allow for
English labeling. Please reach out to NeuroLogica directly if translation is
required.

Identified symbols and system classifications

The specifications and details of this user manual may change to improve the
product or to enhance its performance.

Throughout this user manual, a yellow triangle with a black border and
exclamation point is used to draw attention to those conditions or situations
that fit one or more of the following criteria, which are definitions from ANSI
Z535.5:

DANGER Indicates a hazardous situation, which if not avoided will
result in death or serious injury.

WARNING Indicates a hazardous situation, which if not avoided could
result in death or serious injury.

CAUTION Indicates a hazardous situation, which if not avoided could
result in minor or moderate injury.

Conventions used in this user manual

Table 1: Conventions used in this user manual
To perform a string of commands, this user
manual will present them as follows:

Commands to Customize > System.

perform actions
This means click Customize and then click

System.

When content refers to commands, windows,
screens, dialog boxes, popups, tabs, buttons,
Bold options, keyboard keys, statuses, and modes,
these items appear in bold for faster
identification, especially in a procedure.
Identifies a word that is emphasized for your
attention.

Italic
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Convention Use

Numbered steps

Numbered paragraphs represent sequential
steps that require you to take the action in
the sequence provided — unless otherwise
instructed.

Procedures that are numerical mean that the
sequence is important to follow. You may
perform some procedures out of the
recommended sequence; however, the
results may vary.

Note

The appearance of a note is as such:

Note Indicates additional information to
help you operate this product.

Hyperlink (an
electronic cross-
reference)

A cross reference appears in the electronic
(.pdf) user manual as a hyperlink. To retrieve
an electronic copy of this user manual (in
.pdf), click Help > User Manual from the
workstation.

A hyperlink is a quick way to go to another
area of the user manual with a simple click.
Hyperlinks appear like this: “Understanding
the types of users” on page 98. In this case,
hover the mouse pointer over the gray
hyperlink text. Hold the Ctrl key on your
keyboard and click the mouse button. After
you click the hyperlink, the hyperlink takes
you to the referenced area in the user
manual.

Click vs right-click

In this user manual, click means to press the
left mouse button. This user manual never
says ‘left click’ as it is assumed that is the
traditional way to click; however, it does point
out when to right click the mouse button.

Understanding the use of “you” in this user manual

Unless specifically noted, the implied “you”, in this user manual, is the
user/operator. It is assumed users/operators are certified and medically
trained personnel, qualified to use these systems.

The following identifies those actions each user is permitted to perform:

Administrator

Full access to the system and its configurations.
Can create protocols, User ID’s, and passwords,
as well as access all functions of the system.

User Requirements
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Modified access to the system. Users with
Limited access can modify protocols during
scanning but cannot create and save protocols;
has no access to system configurations.

Users with Restricted access can scan with the
system but are unable to make any changes to
protocol parameters while scanning, they also
have no access to system configurations.

Limited operator

Restricted operator

Active and inactive objects

When a menu command, option, button, tab, field, is gray, the item is not
active or enabled. When an item is gray, it can mean additional or required
tasks must be completed first or you do not have permission to access that
option. An active menu command, option, button, tab, and field means you
can use the item to perform an action. Active items are green and/or
highlighted.
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Chapter 1 Compliance and Safety Requirements

It is important that you are aware of and familiar with compliance and safety
requirements to ensure you, the patient, and the systems are safe at all
times.

IEC classification and symbols

R In accordance with International Safety Standard IEC 60601-1, the
BodyTom 64 CT scanner is classified as Type B equipment; Class 1
equipment, internally powered equipment, and continuous
connection to the supply mains in standby state and for specified
loading.

Type B equipment provides an adequate degree of protection against shock,

regarding:

« Allowable leakage current.

« Reliability of the protective earth connection.

e (In accordance with the International Safety Standard IEC 60601-1), the
manufacturer is not responsible for any consequences caused by the
unauthorized modification of this equipment.

o Earth leakage current.

WARNING Equipment is not suitable for use in the presence of a
flammable anesthetic mixture with air or with oxygen or
nitrous oxide.

WARNING Equipment is not suitable for use with oxygen or oxygen
enriched atmospheres.

BodyTom 64 Computer Tomography systems comply with Class I- Type B
equipment as defined in IEC 60601-1 standard.

Mode of operation is a continuous connection to the supply mains in standby
state and for specified loading conditions.

The BodyTom 64 CT scanner is patient-environment equipment.

Table 2: Applicable symbols

Symbol Description

NS Alternating current

@ Protective earth (ground)
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Symbol ‘ Description ‘

Functional Earth

Caution: consult accompanying documents

Caution: risk of electrical shock

>

Electrostatic sensitive devices

ﬂ Type B equipment

X-ray warning

X-ray source assembly emitting

Non-ionizing radiation

Warning: laser in use

Warning: Laser Radiation Do Not Stare into Beam
Class 2 Laser Product

Laser Output and Standards Information Label

Warning: FDA Laser Information

Warning: high temperature

@ Emergency switch

Crush warning

Foot/toe crush warning when lowering machine

4 System up
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Symbol Description

v

System down

Temperature limits

Keep away from rain for packaging

O e

Humidity limit for packaging

Warning: battery charging

Fuse usage

Refer to instruction in user manual/booklet

Medical Device Symbol

Legal Manufacturer Symbol

cus Intertek ETL (Edison Testing Laboratories) Mark
Intertek
EC |REP European Authorized Representative Symbol
c € CE Mark or Conformité Européenne ; number
2862 below CE represent Notified Body number

WARNING This x-ray unit may be dangerous to patient and operator
unless safe exposure factors and operating instructions are

observed.

Chapter 1
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Environmental specifica

CAUTION The specified envir
hours a day, seven

Table 3: Operating environment

tions

onment must be constantly maintained: 24-
days a week.

Operating
Ambient temperature

152 C to 352 C (599F to 952 F)

Relative humidity

20% to 80% (non-condensing)

Altitude
Storage
Temperature

0-3048m (0-10,000 ft.)

-252 Cto 702 C (-132 F to 1582 F)

Relative humidity
Transport

Temperature

20% to 85% (non-condensing)

-202 C to 602 C (-42 F to 1402 F)

Relative humidity
Powering system
Time period prior to
powering the system

20% to 85% (non-condensing)

24 hours?

Floor \ \
Flatness <+/1 0.120in. (3mm) per 10ft. (3.048m)
Recommended minimum | e 1 et (3.048m x 4.572m)

scan area

Note For good image qu
keep the system fr
flatness specificati

ality, the recommended practice is to
ee from vibration and to maintain the
on noted.

If the system is in a facility outside the noted operating temperature, it is
recommended to allow the noted time for the system to acclimate to the

environment.

Table 4: System operating parameters and specifications

100-120V~+10%

208-240V~ +10%

Voltage range

Nominal voltage for U.S. 120, 240

Circuit protection

20 amps 30 amps

NEMA 5-20R NEMA 6-30R

Facility outlet

Outline of outlet:

Chapter 1 Compliance and Safety Requirements
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Frequency 50 or 60Hz 50 or 60Hz
Battery capacity Fully charged, 12 hours typical
Typical usage 110-120V~ 60Hz 230-240V~ 50Hz
.. 125V, 2 pole, 3 wire 250V, 2 pole, 3 wire
Wiring . .
grounding grounding

Main power supply’s

. 0.105Q
apparent resistance
Heat dissipation
(when system is not 55kwW

idle)

Considerations when preparing gantry for use

CAUTION  Check for obstructions before moving and system setup.

CAUTION  Monitor scanner motion to prevent collision with surrounding
environment and foreign objects.

CAUTION  Press the red EMERGENCY STOP button immediately in case
of abnormal or unexpected motion.

WARNING Verify scanner is on its centipedes (fully down position) prior
to positioning patient at scanner entrance.

WARNING Make sure all extremities are not under scanner while
lowering or raising it.

WARNING In the case of a single pendant failure, the additional pendant
is available for use to prevent loss of system function.

WARNING Always keep patient in view. Ensure that the patient can be
seen when the operator is near the scanner control panel and
EMERGENCY STOP button. Never leave patient unattended
when the patient is in the gantry.

e Neurologica advises complying with local regulations and/or site
recommendations as specified by the facility physicist or certified
representative for the following:
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« Use mobile x-ray protective-shielding devices. Technologists should be at
the correct location and consider wearing personal radiation protective
equipment.

« Aradiation safety plan in the working area boundaries, to optionally
include as needed, mobile x-ray protective shielding devices. Otherwise
assign a larger, working area to avoid radiation to the public. Effective
dose for people outside the working area should be less than 0.25mSv
annually (equals to 5 uSv weekly). The air kerma rate 0.3 meters away
from the working area will be smaller than 2.5 uGy/h. Have monitoring
and personal dose management for occupational exposure and related
public health care personnel.

o There should be a working plan before scanning. The plan should include
CT condition, time, location, working area, scanning plan, and site-clearing
method; clearly state the responsibilities of working, protection, and
management personnel. Keep a good record of the whole process.

e Restrict the working control and monitor area. Place obvious warning signs
at the control-area boundaries to prevent unauthorized personnel from
entering. Installation of a working status indication light is recommended.

o In accordance with the safety plan, self-monitor during the scanning
process. A certified radiation representative should monitor the working
area and take measurements immediately if abnormal circumstances are
detected. Additionally, this should be reported to the local environmental
administrative and health departments. There should be a public notice
at the working area, to include the nature of work, time, location, control
area, name of the working department, person in charge of the project,
contact telephone number, radiation report telephone number.

Site specification

Table 5: System operating parameters

Operating voltage 100-240 VAC~
Operating frequency 50Hz-60Hz
Apparent resistance of supply mains at

120VAC 0.3 ohms
Operating current at 120VAC 13 amps
Heat dissipation 1672 watts
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CAUTION For domestic purposes, scanner can be powered using either

Table 6: Battery operating parameters
Operating voltage 480 to 585 VDC
Output current (peak) 100 amps

120V~ or 240V~. If the scanner is using 120V~, the facility’s
circuit must be capable of providing 20 amps (single phase). If
the scanner is using 240V~, the facility’s circuit must be
capable of providing 30 amps (single phase). If other devices
are connected to the same circuit, the facility’s circuit breaker
may trip and, therefore, prevent the scanner from being ready
when needed.

Site specification for enclosed CT room

Table 7: Site specification

Issue \ Comment
Receiving area Secured
Near availability of a trash receptacle for

Packing material and waste
dunnage

12ft. x 15ft. room with a finished level floor;

Room dimensions for use .
recommended the room be well lit

Power availability 120VAC/20amp wall outlets (2x)
Floor flatness <+ 0.120in. (3mm) per 10ft.
Floor strength Site must be able to support product weight

Note Not all beds are compatible with this system. Please

contact Customer Service for assistance.

NeurolLogica advises complying with local regulations and/or site
recommendations as specified by the facility physicist or certified
representative for the following:

There should be enough space inside the CT room. The area should not be
less than 30m2. Any side should not be less than 4m. Leaving any
unnecessary items inside the room is prohibited.

Carpet and soft material cannot be used on the floor. There should not be
obstacles on the floor. Ensure flat surface area no less than 12ft. x 15ft.
level degree <3mm per 10ft.

Appropriate protection measures should be taken to protect staff and to
ensure annual-dose-rate is less than 0.25mSv (equals to 5 uSv weekly).
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Hazardous substances

Table 8: Hazardous substances

Substance/material ~ Weight/system
Lead 7.69 kg (17.0lbs.)
Cadmium 0.036kg (0.0791bs.)
Mercury Okg (Olbs.)
Hexavalent chromium Okg (Olbs.)
PolyBrominated Biphenyls (PBB) <0.46kg (11b.)
PolyBrominated Diphenyl Ethers (PBDE) <0.46kg (11b.)

Part numbers and product-marking plates

Table 9: Core-system-component part numbers and product-marking plate locations
Product-marking plate

Component Part number

locations

Near the main input plug or on
0-NL4100-000 | the side of the system. See
10-00345-0001 | Figure 1: Product-marking
plate on scanner below.

BodyTom 64 gantry

BodyTom 64 40-00157-000 On the back of the
workstation workstation.
QA phantom 10-00268-001 On the back of the phantom.

Note The applicable components making up the BodyTom 64 CT
scanner is identified with the nameplate statement “This
product complies with radiation performance standards,
21 CFR sub-chapter J.”

Figure 1: Product-marking plate on scanner
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Table 10: Core-system component dimensions

Component / mode Size Lx W x H
256.5cm x 104cm x 199cm
Scan - X .
101in. x 41in. x 79in.
BodyTom Transport 256.5cm x 104cm x 205.7cm 3510 lbs.
64 NL4100 P 101in. x 41in. x 81in. 1592 kg
85cm
B
ore 33in.

Figure 2: Scanner dimensions including drive bar

Table 11: Workstation dimensions

Component Size (inches) Size (centimeters) =~ Weight Weight
LxWxH LxWxH (Ibs) ()

BodyTom 64

Workstation 26.3x24.4x79.8 | 66.8x62.0x202.7 207 94

Cart

Class 1 Type B medical devices

This equipment generates, uses, and can radiate radio-frequency energy. The
equipment may cause radio-frequency interference to other medical and non-
medical devices and to radio communications. To provide reasonable
protection against such interference, this product complies with emission
limits for Class 1 medical devices as stated in EN 60601-1-2.
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However, there is no guarantee that interference will not occur in a particular

installation. If this equipment is found to cause interference (which can be

determined by switching the equipment on and off), the user should attempt

to correct the problem using one or more of the following measures:

o Re-orient or relocate the affected device(s).

« Increase the separating space between the equipment and the affected
device.

o Power the equipment from a source different from that of the affected
device.

o Consult the point of purchase or the service representative for further
suggestions.

NeuroLogica Corp. is not responsible for any interference caused either by
the use of interconnect cables other than those recommended or by
unauthorized changes or modifications to this equipment. Unauthorized
changes or modifications could void the user’s authority to operate the
equipment.

To comply with the regulations applicable to an electromagnetic interface for

a Group 1 Class A medical device, note the following:

e Allinterconnect cables to peripheral devices must be shielded and
properly grounded.

e Use of cables not properly shielded and grounded may result in the
equipment causing radio-frequency interference in violation of the
European Union’s Medical Device Directive and FCC regulations.

CAUTION Ensure there is no potentially detrimental
interaction of system’s irradiation with a patient’s
active and implantable medical devices and/or
body-worn and active medical devices.

CAUTION Do not use devices that intrinsically transmit radio
waves, such as a cellular phone, radio transceiver,
mobile radio transmitter, radio-controlled toy, and
so on. Use of these devices near this equipment
could cause this equipment to malfunction. Keep
power of these devices turned off when near this
equipment. Medical staff in charge of this
equipment is required to instruct technologists,
patients, and other people who may be around
this equipment to fully comply with the above
regulation.

« Medical staff in charge of this equipment are required to instruct
technologists, patients, and other people who may be around this
equipment to fully comply with the above regulations.
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Focal spot

Nominal size is: ~1.2 x 1.4mm
Size limit is: ~1.2 to 1.7mm width and ~1.4 to 1.9mm length.

Testing standard for reference is as follows:
o IEC60336:2005

Focal spot centering is within 1mm of center of bolt pattern. Maximum
motion due to gravity in X, Y, and Z axis is 0.1mm.

Maximum motion from anode rotation is 0.1mm.

Maximum motion from anode heating in X axis is 0.1mm. Maximum motion
from anode heating in Z axis is 0.3mm.

Anode input power

The maximum anode cooling rate is 8,750W (12,250 HU/sec).
The maximum anode heat dissipation is 3,400W (4,760 HU/sec).

The nominal anode input power is 42kW.

Continuous anode input power when applied at the nominal, x-ray, tube-
voltage is 150kV, 23mA.

Filtration

Table 12: Filtration
Tube Voltage (kV) 100 120 140

Half-value layer (aluminum
equivalent)

Filters consist of 0.0014in. [0.036mm] of copper and 0.086in. [2.18mm] of
aluminum, along with a variable thickness bowtie filter made from Teflon®.

6mm 7mm 8mm

X-ray tube’s total filtration of irremovable layers is 1.0mm of equivalent
aluminum.

Source to Detector distance (SID)

The SID value is 1041.9mm.
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Compliance statement

Note All editions and years of revisions for standards noted in
this chapter are static as of Revision 00.

The BodyTom 64 system complies with the regulatory requirements of the

following:

« AAMI ES60601-1 Issue: 2005 Version - Medical Electrical Equipment, Part
1: General Requirements for Basic Safety and Essential Performance;
Amendment No. 2: 2010/05/30.

o CAN/CSA-C22.2 No. 601.1-M90(R2005) Issued: 2003/11/01 Medical
Electrical Equipment — Part 1: General Requirements for Safety; General
Instruction No. 1: 1990, Supplement 1: 1994, Amendment 2: 1998,
General Instruction No. 2: 2003.

e CENELEC EN 60601-1 2nd Edition, Medical Electrical Equipment - Part 1:
General Requirements for Safety, includes Amendment A1:1993 and
A2:1995.

e« CENELECEN 60601-1 3rd Edition, Medical Electrical Equipment - Part 1:
General Requirements for Safety.

o (CSA C22.2#60601-1 Issued: 2008/02/01 Ed 3 Medical Electrical Equipment
- Part 1: General Requirements for Basic Safety and Essential Performance.

o |IEC60601-1 Issued: 2005/01/01 Ed 3 Medical Electrical Equipment Part 1:
General Requirements for Basic Safety and Essential Performance.

o |EC60601-1-1 (2000) 2nd Edition: Medical Electrical Equipment, Part 1:
General Requirements for Safety - Collateral Standard: Safety
Requirements for Medical Electrical Systems.

e |EC60601-1-2:2014 Ed4.0 Medical Electrical Equipment - Part 1-2: General
Requirements for Basic Safety and Essential Performance - Collateral
Standard: Electromagnetic Disturbances

« |EC60601-1-3 (2008), Medical Electrical Equipment Section 1-3: General
Requirements for Safety. Collateral Standard: General Requirements for
Radiation Protection in diagnostic X-ray Equipment.

« |EC60601-1-4 (2005), 3rd Edition Consolidated Edition, Medical Electrical
Equipment Part 1-4: General Requirements for Safety — Collateral
Standard: Programmable Electrical Medical Systems.

o |IEC60601-1-6 Issued: 2008/12/08 Ed 2 Medical Electrical Equipment - Part
1-6: General Requirements for Safety. Collateral standard: Usability.

o |EC60601-2-28 (1993) Medical Electrical Equipment, Part 2: Particular
Requirements for the Safety of X-ray Source Assemblies and X-ray Tube
Assemblies for Medical Diagnosis.

o |EC60601-2-32 (1994) Part 2-32, Particular Requirements for Safety
sections 2.32 Specification for Associated Equipment of X-ray EqQuipment.
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o |EC60601-2-44 (2009) Medical Electrical Equipment -Part 2-44: Particular
Requirements for the Safety of X-ray Equipment for Computed
Tomography.

« |EC 60825-1:2007 Safety of Laser Products - Part 1: Equipment
Classification, and Requirements 2nd Ed.

» International Electrotechnical Commission (IEC) International Standards
Organization, when applicable.

» Intertek Testing Service (ITS), an independent testing laboratory.

o Medical Device Good Manufacturing Practice Manual issued by the FDA
(Food and Drug Administration). Department of Health, USA.

e Neurologica Corporation is ISO 13485:2016 and MDSAP certified.

EMI/EMC terms

Electromagnetic Compatibility

Electromagnetic Compatibility (EMC) is the branch of electrical sciences that
studies the unintentional generation, propagation, and reception of
electromagnetic energy with reference to the unwanted effects
(Electromagnetic Interference (EMI)) that such energy may induce. The goal
of EMC is the correct operation, in the same electromagnetic environment, of
different equipment, which use electromagnetic phenomena and the
avoidance of any interference effects.

To achieve this, EMC pursues two different kinds of issues. Emission issues
are related to the unwanted generation of electromagnetic energy, to the
countermeasures that should be taken to reduce such generation, and to
avoid the escape of any remaining energies into the external environment.
Susceptibility or immunity issues, in contrast, refer to the correct operation of
electrical equipment in the presence of unplanned electromagnetic
disturbances.

Interference, or noise, mitigation, and hence EMC is achieved by addressing
both emission and susceptibility issues, that is., quieting the sources of
interference, making the coupling path between source and victim less
efficient, and making the potential victim systems less vulnerable.
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Electromagnetic Interference (EMI)

Electromagnetic Interference (EMI), also called Radio Frequency Interference
(RFI) is an unwanted disturbance that affects an electrical circuit due to
electromagnetic radiation emitted from an external source. The disturbance
may interrupt, obstruct, or otherwise degrade or limit the effective
performance of the circuit. The source may be any object, artificial or natural,
that carries rapidly changing electrical currents, such as an electrical circuit,
the sun, or the northern lights.

Susceptibility

Susceptibility is the capability of an electronic system to respond to unwanted
electrical energy.

EMI/EMC compliance

This equipment complies with IEC 60601-1-2 EMC standard for medical
devices.

The BodyTom 64 system is suitable to be used in an electromagnetic
environment, as per the limits and recommendations described in the tables
hereafter:

o Emission Compliance level and limits (see Table 14).

Note This system complies with the above-mentioned EMC
standard when used with supplied cables. If different
cable lengths are required, contact a qualified service
representative for advice.

Table 13: Acronyms and abbreviations
Acronym and

abbreviation Definition

AEC Automatic Exposure Control

CBF Cerebral Blood Flow

CBV Cerebral Blood Volume

CcT Computed Tomography

CTA CT Angiography

CcTP CT Perfusion

CTDlyol Volume Computed Tomography Dose Index
CTDIw Weighted average Computed Tomography Dose Index
DICOM Digital Imaging Communication in Medicine
DLP Dose Length Product (DLP)

DHCP Dynamic Host Control Protocol
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Definition

Acronym and
abbreviation

EMC Electromagnetic Compatibility

EMI Electromagnetic Interference

FOV Field Of View

HIS Hospital Information System

HU Hounsfield Unit

IBC Iterative Bone Correction

MAR Metal Artifact Reduction

MIP Maximum Intensity Projection

MPPS Modality Performed Procedure Step
Multi-Planar Reformation, sometimes referred to as

MPR . .
Multi-Planar Reconstruction

MTT Mean Transit Time

PACS Picture, Archiving, and Communication System

QA Quality Assurance

RIS Radiology Information System

RSO Radiation Safety Officer

RFI Radio Frequency Interference

SCP Service Class Provider

SCU Service Class User

WARNING Medical, electrical equipment needs special precautions
regarding EMC and needs to be installed and put into service
according to EMC information provided in accompanying
documents.

CAUTION  Portable and mobile RF communications equipment can
affect medical electrical equipment.

CAUTION Do not use or stack the equipment or system with other
equipment and if adjacent or stacked use is necessary, the
equipment or system should be observed to verify normal
operation in the configuration in which it will be used.

Note The EMC tables and other guidelines included in this user
manual provide information to the user essential in

determining the suitability of the equipment or system for

the electromagnetic environment of use, and in managing
the electromagnetic environment of use; to permit the
equipment or system to perform its intended use without
disturbing other equipment and systems or non-medical
electrical equipment.
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Note The EMISSIONS characteristics of this equipment make it
suitable for use in industrial areas and hospitals (CISPR 11
class A). If it is used in a residential environment (for
which CISPR 11 class B is normally required) this
equipment might not offer adequate protection to radio-
frequency communication services. The user might need to
take mitigation measures, such as relocating or re-
orienting the equipment.

Table 14: Emission declaration for BodyTom 64 systems

BodyTom 64 system is intended for use in electromagnetic environment specified below.
The user of the BodyTom 64 system should assure that it is used in such an environment.
Emissions test

\ Compliance Electromagnetic environment guide

BodyTom 64 systems use RF energy only
for internal function. Therefore, RF

IEC 61000-3-2

Voltage
fluctuations/flicker

RF emissions CISPR 11

Harmonic emissions,

emissions, IEC 61000-3-3

RF emissions CISPR 11 Group 1 emissions are very low and are not likely to
cause any interference in nearby electronic
equipment.

Class A BodyTom 64 systems are predominantly

Class A

Complies

intended for use in non-domestic
environments, and not directly connected
to the Public Mains Network. BodyTom 64
systems are predominantly intended for
use (for example, in hospitals) with an
appropriate power supply (see operation
manual) and recommended shielding for
portable use.

Table 15: EMC Immunity declaration for BodyTom 64 systems

BodyTom 64 systems are intended for use in the electromagnetic environment specified
below. The customer or user of an BodyTom 64 system should assure that it is used in
such an environment.

Immunity

test

Electrostatic
discharge (ESD)
IEC 61000-4-2

IEC 60601-1-
2
test level

+8kV contact +8kV contact

+2kV, +4kV, +2kV, £4kV,
+8kV, 15kV air +8kV, 15kV air

Compliance Electromagnetic
level

environment guidance

Floors should be wood, concrete,
or ceramic tile. If floors are
covered with synthetic material,
relative humidity should be at
least 30%.
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BodyTom 64 systems are intended for use in the electromagnetic environment specified
below. The customer or user of an BodyTom 64 system should assure that it is used in
such an environment.

\ IEC 60601-1- . :
Immunity ) Compliance Electromagnetic
test level environment guidance
test level
+2kV for power | +2kV for
Electrical fast supply lines power supply Mains power quality should be
transient/burst +1kV for lines £1kV for | that of a typical commercial or
[EC 61000-4-4 input/output input/output hospital environment.
lines lines
+1kV line-line +1kV line-line Mains power quality should be
Surge IEC . . . .
£2kV line- * 2kV line- that of a typical commercial or
61000-4-5 . .
ground ground hospital environment.
0% UT; 0.5 cycle | 0% UT; 0.5
At 0°, 45°, 90°, cycle At 0°,

Voltage dips,
short
interruptions,
and voltage
variations on
power supply

135°, 180°,
225°,270° and
315°

0% UT; 1 cycle

70% UT; 25/30

45°,90°, 135°,
180°, 225°,

270° and 315°
0% UT; 1 cycle

70% UT; 25/30

Mains power quality should be
that of a typical commercial or
hospital environment. If the user
of a BodyTom 64 system requires
continued operation during
power interruptions, it is
recommended that the BodyTom

input lines IEC .
61000-4-11 cycles cycles §4 system be ppwered from its
internal batteries.
0% UT; 250/300 | 0% UT;
cycles 250/300 cycles
. IEC 60601-1-2 Compliance Electromagnetic environment

Immunity test .

Test Level level guidance.

Power
frequency (50/
60Hz) magnetic

30 A/m, 50Hz

30 A/m, 50Hz

Power-frequency magnetic-fields
should be at levels characteristic
of a typical location in a typical

field IEC 61000- or 60Hz or 60Hz commercial or hospital
4-8 environment.

Clause 8.10 Table 17 Per Table 17 IEC 60601-1-2:2014
Clause 8.11 Table 18 Per Table 18 IEC 60601-1-2 ed4.1:2020
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BodyTom 64 systems are intended for use in the electromagnetic environment specified
below. The customer or user of an BodyTom 64 system should assure that it is used in
such an environment.

Immunity

test

IEC 60601-1-
2
test level

3 Vrms 150kHz

Compliance
level

Electromagnetic
environment guidance

Portable and mobile RF
communications equipment
should be used no closer to any

to 80MHz 3Vrms part of the BodyTom 64 system,
6 Vrms in ISM 6 Vrms including cables, than
Iclzocngfgé%(ilﬁg band 150kHz to | 80% AM at recommended separation
80MHz 1kHz distance calculated from the
80% AM at equation appropriate for
1kHz transmitter frequency.
Recommended separation
distance: See Table 16.
Radiated RF IEC 3 Vrme 80MHa Ir}terfgrence may T(cc(:jur i.nhvi;inity
61000- 4-3 t0 2.7GH2 E1=3 V/m (0] equ.lpment ma'r ed with the
(alternative ’ 80% AM at following symbol:
80% AM at |
method: IEC 1kHz 1kHz ':':'Eifl’
61000-4-21)

Note: The wireless receiver operates within the following bands.

2.412 to 2.462 GHz (11 channels)
5.180 to 5.240 GHz (4 channels)
5.260 to 5.320 GHz (4 channels)
5.500 to 5.700 GHz (8 channels, excluding 5.600 to 5.640 GHz)
5.745 to 5.825 GHz (5 channels)

The preferred frequency band is 5.189 to 5.240 GHz at 40MHz
bandwidth.
The wireless transmitter operates within the following frequency
bands and power.

802.11b:

Typ. 26%1.5 dBm @ 1 Mbps, Typ. 26+1.5 dBm @ 2 Mbps
Typ. 26£1.5 dBm @ 5.5 Mbps, Typ. 25£1.5 dBm @ 11 Mbps
802.11g:
Typ. 23£1.5 dBm @ 6 to 24 Mbps, Typ. 22+1.5 dBm @ 36 Mbps
Typ. 20£1.5 dBm @ 48 Mbps, Typ. 19+1.5 dBm @ 54 Mbps
802.11n (2.4 GHz):

Typ. 23%£1.5 dBm @ MCS0/8 20 MHz,
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Typ. 18+1.5 dBm @ MCS7/15 20 MHz

Typ. 23+1.5 dBm @ MCS0/8 40 MHz,

Typ. 17+1.5 dBm @ MCS7/15 40 MHz

802.11a:

Typ. 23£1.5 dBm @ 6 to 24 Mbps, Typ. 21+1.5 dBm @ 36 Mbps
Typ. 20£1.5 dBm @ 48 Mbps,Typ. 18+1.5 dBm @ 54 Mbps
802.11n (5 GHz):

Typ. 23+1.5 dBm @ MCS0/8 20 MHz,

Typ. 18+1.5 dBm @ MCS7/15 20 MHz

Typ. 23+1.5 dBm @ MCS0/8 40 MHz,

Typ. 18+1.5 dBm @ MCS7/15 40 MHz

The device includes 4 dBi gain antennas

Countermeasures against EMC related issues

Generally, it is very difficult to grapple with issues related to EMC. It may take
a variable amount of time and cost to identify issues causing interference.

General countermeasures of electromagnetic interference with other
equipment:

Electromagnetic interference may be alleviated by positioning other
equipment far from the system.

Electromagnetic interference may be mitigated by changing relative
location (installation angle) between system and other equipment.
Electromagnetic interference may be eased by changing wiring locations
of power/signal cables of other equipment.

Electromagnetic influence may be reduced by altering the power-supply
path of other equipment.

Electromagnetic environment specified (see Table 15 on page 45).
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Table 16: Recommended separation distances
Recommended separation distances between portable and

mobile RF communications equipment and the BodyTom 64
system

BodyTom 64 system is intended for use in an electromagnetic environment
in which radiated RF disturbances are controlled. The user of the BodyTom
64 system can help prevent electromagnetic interference by maintaining a
minimum distance between portable and mobile RF communications
equipment (transmitters) and the BodyTom 64 system as recommended
below, according to the maximum output power of the communications
equipment.

jigiiee 150kHz to 80MHz to 800MHz to
maximum 8OMHz 300MH3z 2.5GHz
output Power
(P) if Separation Separation Separation
transmitter distance distance distance
Watts (W) meters? meters? meters 1
0.01 12 12 .23
0.1 .38 .38 .73
1 1.2 1.2 2.3
10 3.8 3.8 7.3
100 12 12 23

For transmitters rated at a maximum output power not listed above, the
separation distance is estimated using the equation in the corresponding
column, where P is the maximum output power rating of the transmitters in
Watts (W) according to the transmitter manufacturer.

Note At 80MHz and 800MHz, separation distance for higher
frequency range applies.

Note These guidelines may not apply in all situations.
Electromagnetic propagation is affected by absorption
and reflection from structures, objects, and people.

" Separation distance according to frequency of transmitter (m)
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Table 17: Test specifications for ENCLOSURE PORT IMMUNITY to RF wireless communications

equipment

Test MERS Distance _'I_";‘::U”'ty
Frequency Band?  Service? Modulation ®»  Power
e (W) (m) Level
(V/m)
Pulse
3 R
385 380- | retra 400 | Modulation® | 0.3 27
390
18Hz
FMm ¢
GMRS
430- 460, +5kHz
450 470 deviation 2 0.3 2
FRS 460
1 kHz sine
710 Pulse
704- LTE Band Modulation )
745 787 13,17 0.2 0.3 9
780 217Hz
810 GSM
800/900
870
TETRA
800, Pulse
B} c b
800 iDEN 820, | Modulation ® 2 0.3 28
960
030 CMDA 18Hz
850,
LTE Band
5
1720 GSM
1800;
1845 Pulse
1700- CMDA Modulation )
1990 1900; 2 03 28
217Hz
1900;
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Test Max Distance 'Il'n;::umty
Frequency Band?  Service? Modulation ®  Power
(MHz) (W) (m) Level
(V/m)
DECT,;
LTE Band
1’ 3' 4'
25; UMTS
Bluetooth,
WLAN,
802.11 Pulse
2400- b/g/n, Modulation ®)
2450 2570 2 0.3 28
RFID 217Hz
2450,
LTE Band
7
5240
Pulse
WLAN
5500 >100- g02.11 | Modulation | 0.3 9
5800
a/n 217Hz
5785

Table 18: Test specifications for ENCLOSURE PORT IMMUNITY to proximity magnetic fields

Test Frequency Immunity Test

Modulation

(MH2z) Level (A/m)
134.2 kHz Pulse modulation 2.1 kHz 65
13.56 MHz Pulse modulation 50 kHz 7.5
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Use recommendations

This product complies with IEC 60601-1-2 standard for medical devices and
with radio frequency emission requirements per CISPR11 Group 1 Class A
standard limits. The BodyTom 64 system is predominantly intended for use in
hospitals.

Do not use devices that intentionally transmit RF signals (cellular phones,
transceivers, or radio-controlled products) in the vicinity of this equipment as
it may cause performance outside the published specifications. Keep the
power to these types of devices turned off when near this equipment.

Adhering to the distance separation (recommended in Table 16 on page 49)
between 150kHz and 2.5GHz, will reduce disturbances recorded at the image
level, but may not eliminate all disturbances; however, when installed and
operated as specified herein, the system will maintain its essential
performance by continuing to safely acquire controlled, radiological, x-ray
exposures in a mobile radiography environment. For example, a 1W mobile
phone (800MHz to 2.5GHz carrier frequency) is put 2.3 meters apart from the
BodyTom 64 system (to avoid image interference risks).

The use of accessories, transducers, and cables, other than those specified,
may result in degraded, electromagnetic compatibility of the BodyTom 64
system.

The medical staff in charge of this equipment is required to instruct
technologists, patients, and other people who may be around this equipment
to comply fully with the above equipment requirements.

Installation recommendations

This system complies with above-mentioned EMC standard when used with
supplied cables. To minimize interference risks, the following requirements

apply.
Cable shielding and grounding

All interconnect cables to peripheral devices must be shielded and properly
grounded. Use of cables not properly shielded and grounded may result in
the equipment causing radio-frequency interference.
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Adjacent components and equipment

BodyTom 64 system should not be used adjacent to or stacked with other
equipment; if adjacent or stacked use is necessary, the BodyTom 64 system
should be tested and verified to make sure normal operation in the
configuration in which it is used. Consult NeurolLogica and Facility Technical
Support staff regarding device/system configurations.

Static magnetic field limits

To avoid interference on the BodyTom 64 system, static-field limits from the
surrounding environment are specified. The static field is specified as less
than <1 Gauss around the unit.

Electrostatic discharge environment and recommendations

« Toreduce electrostatic-discharge interference, install a charge-dissipative
floor-material to avoid electrostatic charge-buildup.

« The relative humidity must be at least 30 percent.

« The dissipative material must be connected to the system ground-
reference.

Facility IT-NETWORK

The BodyTom 64 system utilizes the IT-NETWORK for the customer (as
applicable) to communicate with the modality worklist and for supplemental,
image-storage space. As part of the installation, the applicable IT-NETWORK
is reviewed to create the appropriate setup for the system. Setup is done to
ensure no potential concerns arise with the system.

CAUTION It is possible that the IT-NETWORK connection from the system
could result in previously unidentified issue(s) to the
respective population. Should this occur, contact Customer
Service right away to identify, analyze, evaluate, and resolve
the issue(s).

CAUTION It is possible that any changes to the IT-NETWORK made by the
facility could introduce a new issue where Customer Service
needs to be contacted to address the concern, right away.

Changes to the IT-NETWORK include — but are not limited to the following:
e Changes in network configuration

o Connection to additional items

« Disconnection to items

e Updating equipment

Chapter 1 Compliance and Safety Requirements Page 53 of 412



BodyTom 64 User Manual Revision 04

e Upgrading equipment.

Hazard information

Review this material before using the system and observe basic, common-
sense safety rules when operating this scanner.

General safety considerations and statements

Review the following before using the system (Scanner and Workstation (as
applicable)) to observe basic, common-sense safety rules when operating the

scanner:
o Become familiar with the functional hardware to help recognize serious
problems.

» Do not use scanner or workstation if it appears damaged or fails.
» Wait for qualified personnel to correct any problem.

Note The scanner is provided with a video-camera monitoring-
system to help navigate the unit while being transported
within a facility.

WARNING The health software is installed on a medical device and is
required for its operation. In order to securely remove the
software from use, the system must be decommissioned.

WARNING Modification of this equipment is not allowed.

WARNING Equipment maintenance of non-medical electrical equipment
should not be performed in the patient environment.

CAUTION  All non-medical electrical equipment will comply with
relevant IEC and ISO safety standards.

CAUTION Federal law restricts the use of this device without a
prescription by a physician.

CAUTION  Always store and/or use unit in a well-ventilated area. Keep
air pollution to a minimum. Keep floor clean at all times.

CAUTION Do not touch parts of non-medical electrical equipment in
patient environment and patient simultaneously.

CAUTION  For disposal of any material emanating from the system;
follow local regulations.

CAUTION This system was designed for use by individuals trained in CT
system operation. The user should be familiar with this user
manual before scanning patients.
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CAUTION

WARNING

WARNING

WARNING

WARNING

CAUTION

CAUTION

CAUTION

CAUTION

WARNING

WARNING

It is the user’s responsibility to make sure that after
installation or subsequent modification, the system is in
compliance with the requirements of collateral standard IEC
60601-1.

Installation of this product is performed in accordance with
Installation Manual (1-NL4100-059). All installation processes
and qualified personnel are outlined in that document.

Proper disposal of batteries is required to ensure compliance
with environmental safety guidelines. Contact authorized
NeurolLogica representative for instructions.

Observe safety-exposure factors and operating procedures to
protect patient from physical harm during contact with this x-
ray scanner.

Observe safety requirements to prevent excessive dose
exposure to patient and/or operator.

Improper system (including workstation) usage could
endanger patients and/or users and void the warranty if not
operated correctly.

Should the workstation encounter a computer related virus,
be sure to contact Technical Support for assistance with
removing said virus from the equipment.

Radiation dose exposure to patients should not exceed
maximum of 1Gy CTDI.

For proper disposal of material at equipment’s end-of-useful
life; contact Neurologica for instructions.

Equipment in which protection against electric shock relies on
basic insulation only, should not be used in this system.

If the system fails to move due to loss of power, the patient
can be easily removed from the scanner by moving the
patient bed.

Four, foot crush hazard labels are affixed to the scanner in four places, above
the four soft bumpers. The following shows a safety label:
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Figure 3: Identifying the scanner’s safety label(s) — foot-crush-hazard label(s)

Laser safety

There are four lasers used with the BodyTom 64 system as indicated in Figure
4 on page 57: 1 laser (Sagittal) at position 1, 1 laser (Axial or Transverse) at
position 2 (which is mounted internally and spins within the system’s bore),
and 1 set of external lasers (Coronal and Transverse/Axial) at position 3.

WARNING Viewing the laser output with certain optical instruments (for
example, eye loupes, magnifiers, and microscopes) within

100mm may pose an eye hazard.

WARNING Complies with 21 CFR 1040.10 and 1040.11 except for
conformance with IEC 60825-1 Ed. 3., as described in Laser

Notice No. 56, dated May 8, 2019.

Laser parameters

o Lasers1and 3 (see Figure 4):

« Wavelength = 650nm
e Output Power = 1mW

o Laser 2 (see Figure 4):

« Wavelength = 650nm
e Output Power =4mW
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Figure 4: Laser aperture’s direction

CAUTION Instruct the patient to close his/her eyes before turning ON
the alignment light.

CAUTION Closely monitor infants and infirm patients to prevent them
from accidentally staring into the beam.

CAUTION Class 2 laser radiation when open. Do not stare into the
beam or view directly with optical instruments.

CAUTION  Use of controls or adjustments or performance of procedures
other than those specified herein may result in hazardous
radiation exposure.

CAUTION  The warning label for “laser in use” is located on the front of
the scanner cover and inside the scanner to identify the
presence of a laser.

Scanner mobility safety

CAUTION  Due to the mobility of the system, an external interlock is not
available; however, a prescribed scan can, at any time, be
terminated from the scanner or the workstation. When the
user activates the scan, a 10-second, countdown-clock, scan
delay (adjustable to 99 seconds) triggers. This countdown
allows the user time to perform needed tasks before the scan
begins.
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CAUTION

WARNING

WARNING

WARNING

To prevent healthcare provider injuries, a single healthcare
professional should not move the scanner and workstation.
Although one person can drive the BodyTom 64 when moving
the scanner about the facility, NeuroLogica recommends two
people move the scanner (lengthwise, only) to ensure no
collisions occur when maneuvering through tight hallways
and around corners. Be especially cautious when moving the
system about an inclined floor.

To prevent involuntary movement, do not position scanner
on an incline while in Transport mode.

Do not move the system right or left if transport on an incline
becomes necessary. Always keep the system in a straight
motion.

Contact Technical Support for assistance when movement is
required on an incline.

Note Be sure there are no obstacles in front of the scanner
while you move the scanner.

If the system needs to be moved over a threshold it is
critical that the scanner be oriented so that it is driven in
the forward or reverse direction. The scanner does not
have the capability of moving laterally over thresholds.

CAUTION

CAUTION

CAUTION

CAUTION

Check to ensure proper clearance is provided to allow removal
of patient from scanner in case of a power failure. This is
accomplished by moving patient’s support (after unlocking
wheel-locks) away from scanner.

To prevent patient entrapment or entanglement with
accompanying equipment, slowly move scanner away from
patient by using control panel switches or pendant controls
while observing patient.

The scanner is equipped with a video camera to help the
operator prevent collisions when transporting system to
different locations that could otherwise result in personal
injury or facility damage.

Do not station or operate the system on an uneven floor. The
flatness requirement is 0.12in. over 10ft. or 3mm over 305cm.
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CAUTION

Floor level

Prior to transporting the scanner, verify that the power cord is
unplugged from wall to avoid damage to cord and outlet, and
avoid tripping. Verify that the ethernet cable is unplugged
from the workstation to avoid damage to the cable and
connector.

For proper operation, the system must be operated on an even, level, hard

surface.

Carpeting

Do not use the system on a carpeted floor. Poor image quality could result
due to unevenness of the floor.

Electrical safety

WARNING

WARNING

WARNING

CAUTION

WARNING

WARNING

The system’s external AC power cord should be checked prior
to use to verify there are no exposed wires or damaged
insulation/prongs. Damaged prongs could result in sparking
and fire. In case of such damage, contact Customer Service,
immediately.

To separate the device from AC power simply disconnect the
power cord from the wall and turn off the main breakers,
located on the same side of the scanner as the power cord.

Access to the main breaker is critical for safety. Do not
position the scanner so that the access to the breaker is
diminished.

Check to ensure the AC outlet is working properly before
plugging in the system’s AC power cord. Neurologica
recommends using a dedicated outlet for powering the
BodyTom 64 system, only.

To prevent electrical shock, do not connect items that are not
specified as part of the system, including the workstation.

To prevent electrical shock, do not remove the covers from
the equipment. The covers protect the user and the patient
from moving parts or electrical shock. Hazardous voltages are
present within this equipment. The covers provide protection
from radiation exposure given off from the x-ray tube. The
covers also protect the equipment.
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WARNING

WARNING

WARNING

WARNING

WARNING

WARNING

WARNING

CAUTION

An electrical shock hazard: no user should apply serviceable
parts; refer to qualified service personnel for any service.

Always electrically isolate this equipment from the main
electrical supply before cleaning and disinfecting it to prevent
short-circuiting or possible electrical shock.

Never position the mobile system and/or workstation in a
manner that prohibits access to unplugging it or prohibits
pressing the EMERGENCY STOP button.

To minimize shock hazard, the system chassis must be
connected to an electrical ground. The system is grounded
through the ground conductor of the supplied, three-
conductor power cord. The power cord must be plugged into
a three-conductor electrical outlet receptacle. Do not alter
the ground connection.

Avoid all contact with any electrical conductor as follows:

« Allow only qualified personnel who know the proper
procedures and use the proper tools to install, adjust,
repair, or modify the equipment.

« Only use this equipment in rooms or areas that comply
with all applicable laws (or regulations having the force of
law) concerning electrical safety for this type of
equipment.

« Always electrically isolate this equipment from the main
electrical supply before cleaning and disinfecting it.

« The detachable cord is the disconnecting device, which is
used to remove mains power from the wall socket.

« The system is internally powered.

For Class 1 equipment (for example, the workstation, AC
power cord, and so on) using an alternate internal source: a
warning to use the alternate source if the integrity of the
protective earth conductor is in doubt.

Do not position the system so that it is difficult to access the
AC power cord.

Protect the system power cord against mechanical damage.

Where the integrity of an external, protective conductor, in the installation or
its arrangement, is in doubt, equipment is operated from its internal,
electrical power source.
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Parts of non-medical electrical equipment in the patient environment that,
after removal of covers, connectors, and so on, without the use of a tool, may
be contacted by the operator during routine maintenance and calibration, will
operate at a voltage not exceeding 25VAC or 60VDC or peak value supplied
from a source that is separated from the supply mains in accordance with one
of the methods described in IEC 60601-1.

CAUTION

CAUTION

CAUTION

WARNING

CAUTION

CAUTION

All systems within the patient environment will provide the
same level of safety as medical equipment complying with IEC
60601-1.

To help prevent tripping hazards, use care in the arranging of
any cords (for example, AC cord, ethernet cable, and so on)
when connecting to the system/workstation.

To prevent damaging electrical outlet cords, check to ensure
they have been removed and properly stored before
transporting the scanner.

The BodyTom 64 CT scanner contains high-voltage circuits for
generating x-rays. Only trained and qualified personnel
should be permitted access to the internal parts of this
equipment.

Use the Universal Serial Bus (USB) terminal located near the
EMERGENCY-STOP (E-STOP) button for archiving to USB, only.
Do not use the USB terminal located near the E-STOP for
connecting any other device to equipment.

For proper disposal of material at the end of the useful life of
the equipment, contact NeuroLogica for instructions.

Mechanical safety

WARNING

WARNING

WARNING

WARNING

In case of unwanted movement or motion, press the
EMERGENCY STOP (E-STOP) button.

Physically assist all patients on and off the bed and into
position on the scan board. Adjust the bed to the specified
height for patient loading and unloading (see “Positioning the
patient” on page 94).

Adjust scanning platform to specified height for patient
loading and unloading; see “Positioning the patient” on page
94.

When positioning the scanning platform, be careful when
moving the scan table to avoid having it hit the scanner
covers.
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WARNING Position any lines (Vs and so on) attached to the patient so
the lines cannot catch on the scanner during scanner travel.

CAUTION  Prevent pinching or crushing of the patient’s extremities.
Keep patient’s hands on the side of his/her body. Always
watch the patient and equipment carefully during scanner
movement.

CAUTION To prevent pinching or crushing of the operator’s feet/toes,
be sure extremities are not positioned under the scanner
when it is being lowered from Transport mode to Scan mode.

WARNING Equipment maintenance of non-medical electrical equipment
should not be performed in the patient environment.

WARNING Maintenance checks and all service must be performed by
NeurolLogica trained service personnel.

CAUTION  Ask patient to scoot up into universal scan board or manually
aid them into position.

CAUTION  When the scan board is in place, be especially careful when
moving the bed to avoid driving it into the gantry covers.

CAUTION  Periodically check all accessories for damage and remove
them from service if damaged or cracked.

Radiation safety

Two Dangerous to patient and operator labels are affixed to both sides of the
scanner, just above the operator controls. See Figure 5 on page 63.
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Figure 5:

Dangerous-to-patient/operator safety-warning label location (left) and

label (close-up, right)

WARNING

CAUTION

CAUTION

WARNING

CAUTION

CAUTION

CAUTION

Improperly used x-ray equipment may result in unwanted
radiation exposure. Read and understand the instructions in
this user manual before attempting to operate this
equipment.

Use technique factors prescribed by the radiologist or
diagnostician. Use a dose that produces the best diagnostic
results with the least x-ray exposure.

All persons authorized to use the equipment must
understand the dangers posed by excessive x-ray exposure.
NeurolLogica recommends use of protective materials and
devices.

Everyone having anything to do with x-ray must take
adequate steps to insure protection against injury.

The use of this device requires its users to receive proper
training in accordance with local and national laws.

Never perform calibration with patients in the scanner or
while personnel are present in the vicinity of the scanner to
prevent exposure to unwanted radiation.

Amber indicator lights (on the top of the scanner) illuminate
during x-ray exposure.

Chapter 1 Compliance and

Safety Requirements Page 63 of 412



BodyTom 64 User Manual Revision 04

CAUTION  Ensure that there is no potential for detrimental interaction
of the system’s irradiation with a patient’s active implantable
medical devices and/or body-worn, active, medical devices.

X-rays can only be produced during the following conditions:

e The scanner is in the Scan mode position.

e The workstation is connected.

« The START button is activated when the patient is registered, the protocol
is selected, the Begin button is clicked, and the protocol is prepared. The
START button on the scanner’s control panel illuminates when the
scanner is ready to begin. See Figure 7 on page 65 to identify the START
button.

Fire and explosion safety

DANGER  This equipment is not suitable for use in presence of a
flammable anesthetic mixture with air or with oxygen or
nitrous oxide.

DANGER  This equipment is not suitable for use in the presence of
oxygen or oxygen-enriched atmosphere.

« Fire regulation for the type of medical area being used
should be fully applied, observed, and enforced. Fire
extinguishers should be provided for both electrical and
non-electrical fires.

« All operators of the BodyTom 64 scanner should be fully
aware of and trained in the use of fire extinguishers and
the firefighting equipment, and in local fire procedures.

WARNING Only use extinguishers on electrical or chemical fires that are
specifically labeled for those purposes. Using water or other
liquids on an electrical fire can lead to fatal or other serious
injury.

If it is safe to do so, attempt to isolate the equipment from

electrical and other supplies before attempting to fight a fire.
This will reduce the risk of electrical shocks.

EMERGENCY STOP button

CAUTION Check the EMERGENCY-STOP (E-STOP) button at least one
time a month to ensure proper function.

CAUTION Every user should take a few minutes to locate the E-STOP
before scanning the first patient.
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CAUTION In case of emergencies, stop scanner movement immediately
by pressing the E-STOP red push-button located on the
scanner, below the control panel.

Figure 6: BodyTom 64 E-STOP locations (right and left)

Figure 7: Close-up of the scanner control panel and the E-STOP button

Note When the E-STOP button is activated, the moving gantry
may overrun by less than 10mm.

Battery safety and information

The System battery capacity icon shows an indication of the scanner’s battery
capacity, which is identical to the indicator on the scanner. The user should
always check the indicator on the scanner to verify the batteries’ status; there
are 145 lithium-ion batteries in the scanner; 144 are used for scanning and
the remaining battery is used for moving the scanner while in transport mode.

CAUTION The system unit contains batteries and will always be charging
when plugged into AC mains.
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CAUTION

In case of battery leakage, do not handle the batteries
themselves nor continue to operate the system. Contact
Neurologica for service. See “Contact information” on
page 24.

Battery replacement and disposal

WARNING

WARNING

WARNING

WARNING

Battery replacement is to be performed by authorized and
trained NeurolLogica service personnel, to ensure proper
disposal of hazardous material.

Dispose batteries in accordance with federal, state, and local
regulations.

Do not incinerate batteries.

Contact an authorized Neurologica representative for
appropriate, product-disposal instructions.

Scanner battery capacity

The range is 0 to 100. Battery voltage and current are used to calculate the
system’s battery capacity based on charging state.

Figure 8: Scanner battery capacity icon

Run time operation

During normal, run-time operation, the battery capacity is calculated one
time, per second. The battery capacity indicator is updated on the scanner’s
display screen as well.

Note The battery capacity indicator on the scanner’s display
screen is displayed in 5% increments when above 10%.
When 10% and below, the displayed capacity isin 1%
increments. That is, above 10% capacity, the displayed
value is always rounded to the closest multiple of 5 (for
example, 93 gets rounded to 95, 42 gets rounded to 40, 47
gets rounded to 45, and so on).
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State changes

After each periodic update, capacity is checked to make sure it does not fall

below certain thresholds, as follows:

e Low voltage alarm state
When battery capacity goes below 25%, a periodic alarm will sound. It will
remain in this state until the battery capacity has gone back up to 27% or
higher. The Start and Cancel buttons when scanning will not illuminate if
the battery is too low.

e Low voltage lock-out state
When the battery capacity goes below 1%, the scanner screen-display
buttons are disabled and starting a scan is prohibited; for example, the
ability to move the scanner and certain protocol buttons are disabled. It
will remain in this state until the battery capacity has gone back up to 2%
or higher. The low voltage alarm will continue to be active in this state.

Predictive scanning

Before each scan, battery usage for that scan is predicted based on the
selected load factors (for example, kV, mA, scan time) and is compared
against the available battery capacity. If there is not enough battery capacity
to scan, a popup appears on the workstation screen. The user can cancel the
scan at that time or continue the scan, with the understanding that the scan
may abort due to a low-power fault.

Under voltage protection

When the system battery voltage drops below the low-voltage cutout-level
while unplugged, a system power-down sequence is initiated.

Workstation

The Workstation battery capacity icon shows an indication of the
workstation’s battery capacity. On the workstation’s main screen, place the
mouse pointer over the battery icon to see the capacity of the battery,
ranging from 0 to 100%. The user should always check the screen to verify
the status of the batteries.

Figure 9: Workstation battery capacity icon

Note The workstation does not report proper battery capacity
and status if a network connection is not made.

Chapter 1 Compliance and Safety Requirements Page 67 of 412



BodyTom 64 User Manual Revision 04

If the scanner’s display screen is black, the system is
not charging and/or the batteries are permanently
damaged. A service call is required.

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

CAUTION

In newer workstations, the workstation reports battery
capacity on the workstation remote power display (under the
monitor). The battery system is designed to be replaced by
authorized and trained NeurolLogica service personnel, only.

The workstation will not report the proper battery capacity
and status if a network connection is not made.

The system can only be charged from a correctly rated wall
outlet. A rating information plate is located on the product
system label (lower backside panel or lower left side panel, see
Figure 1: Product-marking plate on scanner on page 37).

The system (including the workstation) should be plugged in at
all times, when not in Transport mode, being transported or in
scanning use, to help maintain battery life and proper system
operation. Failure to do so could result in permanent battery
damage, which will require a service technician to repair.

The system may not complete a scan when below 25% battery
capacity while unplugged.

If the system is unplugged and battery capacity reports to be
0%, permanent battery damage can occur.

The power cord selection must not be less than 110v/12A
(USA) and 220v/7.5A (EU and Asia), made of 2.08mm
(diameter) copper wire in accordance with local power supply
cable standards.

Note Medical grade power cords should be used at all times.

Scanner X-ray tube capacity

The percentage of the tube capacity required for a scan = ((kV x mA x scan
time(s))/180000) x 100%. Approximately 0.11% capacity is regained each
second during cooling.

Figure 10: Scanner X-ray tube capacity icon
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Maintenance and service

WARNING

WARNING

WARNING

CAUTION

Equipment maintenance of non-medical electrical equipment
should not be performed in the patient environment.

Maintenance checks and all service must be performed by
Neurologica trained service personnel. Service personnel
use Service manual (1-NL4100-062) to effectively perform
needed service and preventive maintenance and inspection
of the system. See “Contact information” on page 24 for
Neurologica’s contact information.

The only calibration performed by the user on this system is
called daily calibration and is described in detail later in this
user manual. All other calibration needs that arise must be
performed by trained service personnel at NeurolLogica Corp.
See “Contact information” on page 24 for NeurolLogica’s
contact information.

Service personnel must complete training at NeurolLogica
Corp. for the system and its accessories prior to conducting
any service activities.

Users are not to perform service or maintenance on the
system at any time. This includes battery maintenance.

Note Neurologica recommends that a quarterly preventive
maintenance be conducted by NeurolLogica’s service
personnel/trained facility bioengineer.

Instructions for replacing serviceable parts are identified
in the Service Manual (1-NL4100-062).

Cybersecurity

WARNING Upon detection of a cybersecurity threat to the system or

workstation, do the following:

« Immediately contact Technical Support.

« Discontinue use of system (enabling the EMERGENCY-
STOP if needed).

« Remove any ethernet and/or wireless connection that
has been made with the facilities’ IT-network.
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Continued use of the system can occur after Technical
Support has assessed the situation and provided the go-
ahead to do so.

Note Neurologica Corp. recommends the customer facility
utilize an IT-network that provides sufficient means of
cybersecurity control to help maintain the requirements of
HIPAA.

Contraindication(s)

There are no contraindications associated with CT scanning.

Personnel privileges and terminology
Qualified operator

The operator as determined by the healthcare facility and assigned by a user
with administrative privileges — who by their education, certification,
experience, and training, are sufficiently qualified to competently perform
clinical scans on the CT system. See “Understanding the types of users” on
page 98 for a description of the types of users.

Operator of record

The operator of record is an operator or health care professional currently
logged onto the CT system with a unique User ID and password identifier.

Scanning privileges

Scanning privileges are granted to a qualified operator, assigned by a user
with administrative privileges, to conduct clinical scans on the CT system. This
privilege level allows use of all clinical protocols to scan the patient.

Protocol privileges

Protocol privileges are granted to a qualified healthcare professional, as
determined by the healthcare facility, and assigned to users with
administrative privileges, who by their education, certification, experience,
and training, is sufficiently qualified to competently save or modify clinical
protocols on the CT system. A healthcare professional with protocol
privileges does not necessarily need scanning privileges on the CT system.
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Administrative privileges

Administrative privileges are granted to qualified healthcare professionals as
determined by the healthcare facility who by their education, certification,
experience, and training, are sufficiently qualified to competently assign,
maintain, and oversee the assignment of personnel to scanning privileges
and/or protocol privileges on the CT system they administer. Healthcare
professionals with administrative privileges do not necessarily need scanning
privileges or protocol privileges on the CT system.

Clinical operation

CT system operation that involves scanning patients and/or creating or editing
protocols intended for use on patients.

Clinical scanning

CT system operation that involves scanning of patients.
Clinical protocol

A protocol on the system intended for use on patients.
Kernel

The kernel or filter is defined as the reconstruction algorithm or mathematical
equation used for convolution of the attenuation profiles and reconstruction
of the CT images. The choice of the kernel determines the noise level and the
contrast resolution of the reconstructed images.
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Chapter 2 System Overview

The BodyTom 64 CT system lets you scan patients in a room or ward, an
Emergency Room (ER), Operating Room (OR), Radiology, and procedure
rooms.

This chapter provides a brief introduction to the BodyTom 64 system.
You will learn how to use the BodyTom 64 system (to see an illustration,
see Figure 11 on page 73) —in subsequent chapters.

Note Whether you turn on the scanner or the workstation
first does not matter; however, it is advised to power
up the BodyTom 64 system hardware first, to allow
time for the scanner to warm up.

BodyTom 64 system

The BodyTom 64 is a 64-slice, mobile, battery-operated CT scanner and
software system with Axial, Helical, and Dynamic, capabilities.

The BodyTom 64 core system consists of the scanner, the workstation,

and the phantom holder. Consider the following:

e The scanner and workstation communicate using a wireless
connection. They communicate using an ethernet connection, if
necessary.

e The BodyTom 64 workstation is a computer with custom software
that allows the user to employ pre-defined, system protocols or
devise unique protocols for performing patient studies. It also allows
the user to update patient information and store images. The
viewing portion of the BodyTom 64 workstation allows the user to
view images in more detail and includes tools to help facilitate
diagnosis by a physician.

e The maximum scout length is 2000mm.

« The scanner can create a slice-thickness of 0.6mm, 1.2mm, 2.4mm,
4.8mm, and 9.6mm in Axial mode.

o In Axial mode, the BodyTom 64 scans 9.6mm of anatomy with
each rotation.
o The maximum scan-range in Axial mode is 900mm.

o The scanner can create a slice-thickness of 0.6 x 0.6, 1.2 x 0.6, 1.2 x
1.2,2.4x1.2,2.4x2.4,4.8x 2.4, and 4.8 x 4.8 in Helical mode.

o In Helical mode, the BodyTom 64 scans 30.7mm of anatomy at a
pitch of 0.8.
o The maximum scan-range in Helical mode is 2000mm.
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e In Dynamic mode, the BodyTom 64 scans 38.7mm of anatomy.
« The scanner is compatible with surgical navigation, HIS, RIS, and
PACS.

QA stand and phantom
BodyTom or gantry
BodyTom workstation

Bed with patient near bore

B WN -

Figure 11: BodyTom 64 system configuration

For information on cleaning and storing the scanner, see “Cleaning the
scanner and workstation” on page 346 and/or “Storing the system” on
page 348.

Overview of the scanner control panels

Control panels appear on the right and left side of the scanner. The
scanner control panel allows the operator to start and stop a scan. All
motion and x-ray generation can also be quickly stopped using the
EMERGENCY STOP button. After the patient is registered and you select
a protocol, you must start the scan from the scanner control panel,
which is located under the scanner’s display screen. The operator
control panel lets you power on the scanner, lift, and lower the scanner,
and lock scanner functions.

Note To determine where personnel should stand during a
scan, consult with the hospital physicist. See “Scatter
radiation” on page 236.
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Controls on the left end of the scanner

Figure 12: Left end of the scanner

Table 19: Left end of the scanner

Scanner control Description

Video camera shows what is in
front of the scanner during
transport.

The scanner’s display screen
shows the status of the scanner
and workstation (see Table 25 on
page 112 for a list and description
of each status symbol).

Chapter 2 System Overview Page 74 of 412



BodyTom 64 User Manual Revision 04

Scanner control ‘ Description

START and CANCEL buttons (to
the left) and the EMERGENCY-
STOP (E-STOP) button (to the
right) on the scanner control
panel.

Ethernet port to connect to the
workstation, and four additional
data-access ports on the data
interface panel.

120VAC/20A and 240VAC/30A
plugs.

The pendant; see “Overview of
the pendant” on page 79 for
more information.
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Controls on the right end of the scanner

Figure 13: Right end of the scanner

Table 20: Right-end of the scanner

Scanner control Description

The scanner’s display screen
shows what the video camera
captures and where the scanner
is moving during transport.

It also shows the status of the
scanner and workstation (see
Table 25 on page 112 for a list
and description of each status
symbol).
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Scanner control ‘ Description

START and CANCEL buttons (to
the left) and the EMERGENCY-
STOP (E-STOP) button (to the
right) on the scanner control
panel.

Drive bar and enable bar
(arrow).

Key lock, the Power-ON and
Power-OFF buttons for scanner,
and the Rocker-Switch-Lift Up
and Down buttons on the
operator control panel.

The pendant; see “Overview of
the pendant” on page 79 for
more information.
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Identifying operator control panel buttons

Figure 14: Operator control panel buttons and indicators

Operator

control panel
P Name

buttons and
indicators

LOCK

Table 21: Operator control panel buttons and indicators

Use the key to lock or unlock the

Description

operator control panel buttons. If
the key is in the locked position all
scanner buttons are disabled. If
the key is in the unlocked position
all scanner buttons are enabled.

OFF

Press to power down the entire
scanner.

During shutdown, the light blinks
until the shutdown task is
complete.

TRANSPORT

Press to activate Transport mode.
Use the Rocker-Switch-Lift Up and
Down buttons to put the scannerin
Transport mode and the drive bar
to transport the scanner.

ON

Press to power up the scanner.

During power-up, the light blinks
until power-on task is complete.

BATTERY
BARS

Indicates the scanner’s battery
charge level.

Each bar represents 10% of charge.
If plugged into an AC outlet, the
last bar blinks indicating the system
batteries are charging.
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Operator
control panel

Name Description
buttons and P

indicators

Press and hold the UP or Down
Rocker-Switch-Lift button to raise
or lower the scanner.

Rocker- .
. . Lowering the scanner to floor level
Switch-Lift
makes the scanner ready to scan.
Up and .
Down Raising the scanner makes the
scanner ready for transport.
buttons

When the button is inactive, it is
dim; when the button is active it is
illuminated.

Overview of the pendant

The pendant lets you move the scanner, turn on and off the lasers, zero
reference the scanner, and program scan and rest positions for the
scanner. See Table 22 for a list of what each button activates.

Table 22: Pendant buttons

\Button \Description Action
[lluminates when
POWER power is supplied to
pendant.
Turns on all

positional lasers.
While the lasers are
on, the scanner
spins for the
internal laser to be
seen within the
scanner opening.
Moves the scanner
forward
approximately
30cm. This is the
distance between
the internal and
external lasers.

LASER

GO TO SCAN
PLANE
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Pendant Button Description \

Action

Sets the scanner to

ZERO zero before startin
REFERENCE g
a scout or a scan.
wove [T
BACKWARD g
scanner backward
(slow)
10mm per second.
wove T
FORWARD g
(slow) scanner forward
10mm per second.
MOVE E;T;?;ngnig\?es the
BACKWARD g
(fast) scanner backward
60mm per second.
MOVE E:)T;?;ngnig\?es the
FORWARD g
(fast) scanner forward
60mm per second.
Allows the user to
SET MEMORY | Program Scanand
Rest positions for
the scanner.
Moves the scanner
SCAN to the Scan Position
POSITION saved using the Set
Memory feature.
Moves the scanner
REST to the Rest Position
POSITION saved using the Set

Memory feature.

DANGER Store the pendant in its holder when not in use to prevent
accidental and/or unintentional contact by patient and/or

users.
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Figure 15: BodyTom 64 remote-control pendant

The scanner’s position appears on the positional display on the front of
the scanner. You can use the pendant to zero reference the scanner.
The display shows a positive or negative positional number.

Figure 16: Scanner’s positional display

Note The two light panels on either side of the scanner’s
position indicate x-ray is active, when lit. The scanner
produces an audible alert during scanning.
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Overview of the workstation

Figure 17: Workstation with leaded-glass shield (optional installation)

The workstation is an accompanying part of the scanner; it is the
computer and control unit that operates most functions of the system.
All basic information related to the workstation (for example, operating
distance, warnings and cautions, connectivity, functionality, etc.) appear
in Chapter 4 Basic Workstation Operations. The workstation includes
the computer, monitor, ethernet connections, and the remote controls.
The workstation also includes the Uninterruptable Power Supply (UPS).
The workstation can be installed with an optional leaded-glass shield
(shown in Figure 17) for additional protection.

The workstation enables you to easily move it wherever you need it to
go. The workstation is designed to let you navigate in and out of
elevators, over doorway thresholds, or on any type of floor including
carpet, with ease.

The workstation can be set up either wirelessly or hardwired to the
scanner. The administrator makes sure wireless is enabled before you
create a wireless connection between the workstation and the scanner
(with System Configuration > Scanner Setup). See “Remote Support
Setup” on page 130 to learn how the administrator enables the wireless
connection.

Note Wireless connections can be slower than a hardwired
connection. If an unexpected delay or disconnection,
due to environmental/bandwidth interference, occurs
when using wireless, it is recommended to hardwire an
ethernet cable to the scanner for continued
communication.
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After respective peripherals are properly plugged in,
make sure all applicable power switches are in the on
position before using the system.

For any devices connected to an AC outlet, make sure
the outlet is providing required power.

CAUTION When not in use, the scanner and workstation should always
be plugged into power outlets to ensure maximum efficiency.

The system should be stored in an area with limited access to
prevent inadvertent damage.

See “Powering on and off the BodyTom 64 system” on page
87.

Note Be sure to keep the workstation plugged in when it is
not in use to charge the battery. Charge time while
off is ~ (approximately) 2 hours; while in use, charge
time is ~ 8 hours.

CAUTION Verify that the ethernet cable is unplugged from the
workstation to avoid damage to the cable and outlet during
transport.

Note Before using the workstation, be sure to read and
understand how to clean and maintain it. See
“Cleaning the scanner and workstation” on page 346.

The product safety coverage of the workstation (Safety Certified to IEC
60950 standards) was evaluated and deemed acceptable for use with the
BodyTom 64 to appropriate IEC 60601-1 and/or IEC 60601-1-1
harmonized national standards.

The workstation will be kept outside the patient environment as defined
by IEC 60601-1-1. BodyTom 64 is suitable for use inside a patient
environment.

CAUTION Do not connect or use equipment beyond what is specified by
NeurolLogica Corp.; this practice may lead to a reduced level of
system safety.
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The recommended distances, provided in Figure 18, relate only to
distances specified by IEC 60601-1 and do not relate to specific distances
required for ionizing radiation and/or stray radiation protection for

operators and bystanders.
'y

]
1.5m{4.92ft)
1

|
¥

2.5m{8.2ft)

1.5mA{4.92f) 1.5m{4.92ft])

L L L,

Figure 18: Workstation safe distance location (two views)

Workstation remote power controls

The following are found on the workstation:
« Remote power controls

e Microphone and controls

e Speaker and controls

Figure 19: The remote power display

See “Using the workstation” on page 98.

Note The microphone and speaker are plugged in to the USB
port on the back of the monitor. If the port is
changed, you will need to reboot the workstation.
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Workstation UPS

The workstation uses an Uninterruptable Power Supply (UPS) to supply
power to the workstation for approximately (~) 6-8 hours when the
workstation is unplugged. The UPS is located inside the workstation.
This feature allows the new workstation to run when it is not plugged in
to a wall outlet.

Workstation considerations before use

Before using the workstation, consider the following:

If a problem is detected with the workstation, make sure repairs or

adjustments are made to it before using it.

Make sure the workstation operates easily and freely, and all parts

work smoothly.

Check for excess noise, vibration, or a change in the ease-of-use.

o Noise, vibration, or change in ease-of-use can be signs of a
problem and a need for servicing.

Be sure to read its warnings carefully and completely before using the

workstation. Do not attempt to service the workstation. Only skilled

service personnel are permitted to service the workstation. See

“Hazard information” on page 54.

CAUTION Users are not to perform service or maintenance on the

system at any time. This includes battery maintenance.

CAUTION Failure to heed these warnings may cause injury to the user, to

others, or damage to the equipment.

Note NeurolLogica recommends that a quarterly preventive

maintenance be conducted by NeurolLogica’s service
personnel/trained facility bioengineer.

Instructions for replacing serviceable parts are
identified in the Service Manual (1-NL4100-062).

Keyboard and mouse

The workstation comes with a keyboard and a mouse (1 for left-mouse

button;

D0 0 g

Figure 20: Workstation keyboard and mouse
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Workstation power cord

The power cord lets you power up the workstation.

Consider the following:
e Plug style will vary depending on factory installed elements based on
geographic location and voltage requirements.

CAUTION The power cord selection must not be less than 110v/12A (USA)
and 220v/7.5A (EU and Asia), made of 2.08mm (diameter)
copper wire in accordance with local power supply cable standards.

Note Medical grade power cords should be used at all times.

Parts that potentially come into contact with the
patient

While you use the system, be mindful that the patient may come into

contact with the following parts:

e The BodyTom 64 system, especially the painted, external surfaces of
the system’s covers.

e Universal transfer board, if purchased.
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Chapter 3 Basic Scanner Operations

Basic scanner skills include powering on and off the scanner, learning how to
use and navigate the operator and scanner control panels, how to use E-
STOP, and how to use the Rocker-Switch-Lift UP and DOWN buttons to lift
and lower the scanner.

Scanning basics you should know before scanning a patient include how your
system should be set up, how to position the scanner and the patient before
the scan, and how to start a scan from the operator control panel.

Note It is recommended that the scanner is on for at least 60-90
minutes prior to performing the daily air calibration or
scanning patients.

It is recommended practice that the scanner is plugged in
and turned on even when it is not in use.

Powering on and off the BodyTom 64 system

The BodyTom 64 is not intended to be turned on and off; however, if the
system should lose power, it is advised to power on the scanner first, to allow
time for the scanner to power up.

To power up the scanner

1. Press the Scanners Power-On until the green light blinks.

Figure 21: Scanner Power On button

2. Wait until the scanner is fully powered up, prior to powering up the
workstation.

To power down the scanner

1. Press and hold the scanners Power-Off button until the greenlight blinks.
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Figure 22: Scanner Power Off button

Note The Scanner’s tube heat must be below 20% before the
scanner powers down. If the tube is too hot, a message
will display on the LCD scanner control panel instructing
you to wait until the tube heat is low enough to safely
power off the scanner.

Consider the following:

e Make sure the scanner is properly plugged in whenever possible; be sure
the outlet(s) provide the required power. Plugging the electrical cord into
the wall charges the batteries; the batteries are the only power source
that allows the scanner to perform scans.

e When plugging in the scanner, make sure the cable lays flat on the floor to
ensure the safety of hospital personnel. In addition, make sure that the
floor behind the scanner is free of any obstructions or debris that could
interfere with the centipedes during scanning.

Figure 23: AC cord and storage on scanner (120V left plug in or 240V right plug out)

Figure 24: Scanner’s power cord receptacle for 120VAC and 240/VAC

Be sure to keep the workstation plugged in when it is not in use to charge the
battery. Charge time while off is ~2 hours; while in use, charge time is ~8
hours.

Chapter 3 Basic Scanner Operations Page 88 of 412



BodyTom 64 User Manual Revision 04

Checking a connection between the workstation and the
scanner

To check if a wireless connection exists between the scanner and the
workstation, look for the Wireless connection icon on the scanner’s display
screen:

Note You must be logged into the workstation before this icon
is visible on the scanner’s display screen.

If the workstation is connecting to the scanner by hardwire, check if the
supplied ethernet cable is connected between the workstation and scanner.

Figure 25: Scanner hardwired to the workstation with an ethernet cable to data-
access ports

The administrator makes sure wireless is enabled when creating a wireless
connection between the workstation and the scanner (with System
Configuration > Scanner Set Up, through the workstation). See “Remote
Support Setup” on page 130.

Note Make sure that the wireless setup in System Configuration
has been done before making a wireless connection
between the workstation and the scanner. See “Scanner
Setup” on page 129 and “Remote Support Setup” on page
130.

Wireless connections can add lag time when compared
with a hardwired setup. If an unexpected delay or
disconnection occurs when using wireless, it is
recommended to hardwire an ethernet cable to the
scanner for continued communication.
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Moving and transporting the scanner

To move the scanner, the scanner must be in Transport mode. The Rocker-
Switch-Lift UP and DOWN buttons are located on the side of the scanner, on
the operator control panel. These UP and DOWN buttons prepare the
scanner to move up for transporting or down for positioning the scanner
before scanning a patient. To set the scanner in Transport mode, go to the
operator control panel and follow the procedure below.

Note If the scanner has been calibrated for multiple rooms, you
must select the room prior to scanning to ensure the
correct floor-calibration file is loaded. See “Selecting a
room for the BodyTom 64 ” on page 184.

Before transporting the scanner, verify that the ethernet
cable is unplugged from the workstation to avoid damage to
cable and receptacle. Verify that the power cable is
unplugged from the wall to avoid damage to the cord and
outlet.

1. Press the Transport button.

CAUTION

Figure 26: Transport button on the operator control panel

2. Press and hold the Rocker-Switch-Lift UP button to raise the scanner off
the centipedes for transport.

Figure 27: Rocker-Switch-Lift UP (top) and DOWN (bottom) button

Note Hold the top Rocker-Switch-Lift UP button until the
scanner is completely raised and on its castor wheels. The
top Rocker-Switch-Lift UP button illuminates when it is in
the up position as shown in Figure 27.

3. Grip the drive bar with both hands.
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Figure 28: Drive bar front

Figure 29: Drive bar

Note The drive bar is equipped with an enable bar. The enable

bar is a darker soft rubber material located on front of the
drive bar. While holding the drive bar, squeeze the
rubberized enable bar to activate system motion. If you
let go of the enable bar, the scanner stops.

4. Move the scanner.

The following points explain how to hold the drive bar to move it forward,
backward, left, and right:

Push forward with both hands and use equal pressure to move the
scanner forward.

Push with the right hand to turn the scanner left; push with left hand
to turn the scanner right.

Pull back on the drive bar to move the scanner in reverse.

Note

A three-point driving technique is required to turn in
smaller spaces.

CAUTION NeurolLogica recommends two people move the scanner

within the facility: one to steer and another, in front of the
scanner, to insure there are no obstacles. Two people
ensures there are no collisions while maneuvering through
tight hallways and around corners.
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WARNING If a loss of control is encountered while moving the system,
release the enable bar to stop ALL movement.

WARNING When transporting, use the video camera and scanner’s
display screen as guides to avoid hitting objects.

CAUTION To prevent potential for injury from overbalancing and/or
tipping, do not attempt to turn this system on an incline
during transportation.

WARNING Do not move the system right or left if transporting on an
incline becomes necessary. Always keep the systemina
straight motion. Contact Technical Support for assistance
when movement is required on an incline.

CAUTION The BodyTom 64 scanner is larger than most medical
equipment. Therefore, NeurolLogica recommends proper
training and practice.

Drive direction of scanner

Figure 30: Scanner drive direction (right side view)

Safety bumper system

The scanner’s transport system is equipped with an active, safety-bumper
system. Each safety bumper is electronically controlled to terminate motion
in the direction in which the system is moving when the bumper is activated.
If a bumper is pressed due to a collision, the drive system is disabled in that
direction. All other directions are still enabled to allow you to reposition the
scanner away from any impact area. The activation force needed to trigger
the bumper system is approximately 7lbs.
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Figure 31: Bumper system

Positioning the scanner before a scan

WARNING Never raise or lower the scanner when the patient is
positioned in the system’s bore. Always move the patient
and table away from the bore before raising or lowering the
system itself.

1. Ensure the scanner is in Scan mode.

To move the scanner, see “Moving and transporting the scanner” on page
90. See also “Performing a scan” on page 255.

2. To lower the scanner, press and hold the Rocker-Switch-Lift DOWN button
until the scanner is completely lowered on its centipedes.
The Rocker-Switch-Lift DOWN button illuminates when the scanner is
completely lowered on the centipedes.

3. Align the patient and table with the scanner, ensuring the patient is in the
center of the Field Of View (FOV), also ensure that the scanner will not
collide with the patient, patient support and/or any life supporting devices
prior to scanning.

Note Be sure the floor is clear of debris or anything that can
cause interference with the scanner’s centipedes.

4. Make sure the patient scan table is locked.

CAUTION Make sure to lock the patient bed or scan table to prevent it
from moving during the scan.

5. Adjust the scan table height so that the patient is centered within the
bore.
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Figure 32: Patient centered in bore (height positioning)

Positioning the patient using the laser lights

WARNING Before scanning, position the patient in such a way that
extremities, hair, life-support equipment, etc. have sufficient
clearance to prevent contact with scanner and or when used
with accessories and options, such as head frames, scan
boards, etc.

WARNING Make sure the patient is supported properly when positioned
(both height and alignment) to prevent injury during
scanning.

WARNING Make sure the foot pedal brake on the scan table/bed is
engaged to prevent it from moving during the scan.

WARNING Never raise or lower the scanner buttons on the operator
control screen when a patient is positioned in the system’s
bore. Always slide the scan table away (by disengaging its
brake) from the system before raising or lowering the system
itself.

CAUTION The following-instructions for patient positioning should be
performed in accordance with NeurolLogica Corp.’s clinical
training.

CAUTION If the patient becomes nauseated or is unable to be still
(motionless), stop the scanner immediately using the E-STOP
button.

Note To determine where personnel should stand during a scan,
consult with the hospital physicist. NeurolLogica
recommends a distance of 8-10 feet.
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The scanner provides a rotating laser-light to guide you to properly position
the patient. The laser indicates the center of the scan plane. The laser light is
always centered on the actual x-ray beam. For multi-slice protocols, this
means that the laser light will indicate the middle position of all simultaneous
acquisitions being acquired. There is no offset between the laser-light plane
and the actual scan-plane. The accuracy of the position of the laser plane,
with respect to the scan plane, should be +/- 2mm.

There are four laser lights: one Sagittal, one Axial or Transverse (which is
mounted internally and spins within the system’s bore) and one set of
external Coronal and Transverse/Axial lasers. Keep the following in mind:

« To adjust vertical or horizontal positions, use table and bed controls, only.
o To adjust Z axis, walk the scanner to position using the pendant.

See “Overview of the pendant” on page 79 to see how buttons act.
1. Position the patient on the bed.

2. Align the bed to the scanner and make sure there is sufficient clearance
around the patient by positioning the patient in the center of the FOV.

Figure 33: Phantom positioned in center of FOV

3. Use the pendant positioning buttons to center the patient within the bore.
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Figure 34: Pendant use for positioning lasers upon patient

4. On the pendant, press the LASER button to turn on all positional lasers.

Figure 35: Positioning lasers upon patient
See the laser precautions in “Laser safety” on page 56.

5. Use the scanner’s positional display to identify the position of the scanner.

Figure 36: Positional display

6. Consider the following:
« If the patient is conscious, request the patient remain still with eyes
closed throughout the entire scan.
« If the patient is unconscious, secure the patient.
« Follow the appropriate facility guidelines when scanning unconscious
patients if the patient’s eyes remain open.

Operating the E-STOP button

Chapter 3 Basic Scanner Operations Page 96 of 412



BodyTom 64 User Manual Revision 04

Figure 37: BodyTom 64 E-STOP locations (right and left)

Figure 38: E-STOP button on the scanner control panel on both the left and right
sides of the scanner

1. Press the E-STOP button to perform the following:
« Stop the system (if it loses control).
« Stop all system motion and x-ray.
« Remove power to the gantry drives and x-ray system.
« If the scanner starts to move unexpectedly.

2. Make sure to resolve the situation.

Note When E-STOP is activated, the moving gantry may overrun
by less than 10mm.

Restoring the system from E-STOP

If you have pressed the E-STOP button to stop the system, follow these steps
to restore the system, using E-STOP.

1. Make sure any hazard is removed.

2. Twist the E-STOP button clockwise until the button pops out to restore
the system after pressing the E STOP button.
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Chapter 4 Basic Workstation Operations

Basic workstation information includes understanding the different kinds
of user access, learning how to power on and off the workstation, and
getting familiar with the workstation screen, its menus, and tabs.

Note Whether you turn on the scanner or the workstation
first (see Chapter 4) does not matter; however, it is
advised to power up the BodyTom 64 system hardware
first, to allow time for the scanner to warm up.

Understanding the types of users

There are three User Levels available on the workstation: administrator,
limited operator, and restricted operator. User ID’s and passwords can

be created for individual users, and specific User Levels can be assigned
to each user. The following define the access levels for each User Level.

Full access to the system and its configurations. Can
Administrator create protocols, User ID’s, and passwords, as well as
access all functions of the system.

Modified access to the system. Users with Limited
access can modify protocols during scanning but

Limited
cannot create and save protocols; has no access to
system configurations.
Users with Restricted access can scan with the
. system but are unable to make any changes to
Restricted y y &

protocol parameters while scanning, they also have
no access to system configurations.

Using the workstation

The workstation uses an Uninterruptable Power Supply (UPS) to supply
power to the workstation for ~6-8 hours when the workstation is
unplugged. The workstation includes a computer, the remote power
display, and a microphone and speaker.

Identifying the workstation’s remote power display

The Power On button on the remote power display allows you to power
on the workstation.
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Figure 39: Workstation remote power display

The following describes the action of each workstation power-control

button.

Table 23: Workstation power-control buttons

Workstation

power- Button or
control indicator name
button

UPS battery level

Description

Shows the battery usage; each
LED represents 20 percent of
battery power.

When the system has power, the

Power-On LED light illuminates.
When the system is at or less
Alarm than 20 percent battery power,

an alarm sounds, and the LED
light illuminates to warn you.

Power-On and

Press and hold the Power-On /
Power-Off button for 3-5

Power-Off seconds to turn on and off the
workstation.
Press this button to silence the
Mute

alarm.
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Identifying the microphone, speaker, and controls

Figure 40: Microphone, speaker, and controls

Table 24: Speaker control buttons
Microphone

Name Description

button
Press the Mic Mute button to
mute the microphone.

g Microphone NeurolLogica recommends using
mute the Mute button located on the
bottom right of the workstation

screen.

Click the Mute button, on the
bottom right of the workstation
screen to mute the microphone
and speaker.

The Speaker button appears on
the bottom right of the
Speaker workstation screen when the
speaker is activated to hear the
patient.

Press the “-“ button on the left
side of the speaker to decrease
the volume, press the “+” button
Volume on the right side of the speaker
to increase the volume. The
speaker has illuminated volume
lights to indicate volume level.

Mute

| +
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Powering the workstation

Figure 41: Remote power display on workstation

Note Depending on the workstation, the Power-On and/or
Power-Off button may not be in this location.

To power up the workstation

1. Press and hold the workstation’s Power-On/Power-Off button on the
remote power display until the green light blinks.

To power down the workstation

1. Press and hold the workstations Power-On/Power-Off button on the
remote power display until the green light blinks.

Note The workstation does not allow you to wait for the
computer to shut down before communicating to the
workstation to shut down; this is because the workstation
sends a toggling signal to the computer. If the computer is
off, it will turn back on. The workstation must already be in
the process of shutting down by the time the computer is
fully turned off.
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Logging in to the workstation

To gain access to the workstation application, you must provide the
system with credentials. These credentials consist of a User ID and

password. Make sure you have a valid User ID and password before you
log into the system.

If you do not have a valid User ID and password, ask your supervisor or
administrator for one.

1. Click the User ID dropdown and select your User ID.

Figure 42: User ID dropdown box

Figure 43: User ID dropdown list

2. Click in the Password field and type your password. Passwords are
case sensitive.
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Figure 44: Password text box

3. Click the Login button.
If the User ID and/or password are invalid, a prompt appears to re-
enter the information.

Note You have a limited number of login attempts before
the system locks the account. An administrator can
unlock the account. See “System and User
Configuration and Setup” on page 117 for more details
about unlocking an account.

When the User ID and password are verified, you are logged into the
system.

The main screen to the workstation software appears with the Patient
Registration tab open.

Figure 45: Patient Registration tab
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4. Verify that the correct User ID appears at the top center of the
screen.

Figure 46: User ID, current date, and time

If the correct User ID does not appear, contact your supervisor or
administrative user to verify the account.

Locking and unlocking the workstation

The Lock button indicates whether your system is in Lock or Unlock
mode. This button is a toggle, if the workstation is locked, the Unlock
button shows, if the workstation is unlocked, the Lock button shows.

To prevent unwanted personnel from accessing the system, you should
lock the workstation if you intend to leave the area for any period. When
you lock the workstation, it remains on, but no one can access it without
supplying a User ID and password.

Using Lock if you need to step away from the workstation

1. Click the Lock button located at the top-and center of the
workstation screen.

Figure 47: System Lock button

The Lock/Unlock System popup appears.
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Figure 48: Lock/Unlock System popup to lock the workstation

2. Enter the User ID and password by selecting the option from the
dropdown and entering information in the Password field.

3. Do one of the following:
e Click the Lock button to lock your system.
When you select this option the Lock button changes to the
Unlock button.
e Click the Cancel button to return to your work.

Using Unlock to view your work

1. Click the Unlock button.

Figure 49: Unlock button

The Lock/Unlock System popup appears.
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Figure 50: Lock/Unlock System popup to unlock the workstation

2. Enter the User ID and password by selecting the options from the
dropdown and entering information in the Password field.

3. Do one of the following:
e Click the Unlock button to unlock your system.
When you select this option, the button changes to the Lock
button.
e Click the Cancel button to return to your work.

Navigating around the workstation’s main screen

The workstation screen shows similar information, even if the screen
elements change when you perform different actions. These constant
screen elements are as follows:

Appears in the top left corner of the screen and
Main menu options shows the File, Tools, Customize, and Help
commands.

Appears in the center of the screen and displays
User, date, and time a greeting for the user, the signed-in user’s
name, the current date, and time.

Appears in the top right corner of the screen
and displays status information for both the
scanner and workstation.

Scanner and
workstation status

The main screen to the workstation software always opens with the
Patient Registration tab.
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Brief overview of the main menu

The main menu provides you access to the basic functions from the
commands: File, Tools, Customize, and Help.

The main menu appears on every screen and is always located in the
same location, regardless of what you are doing.

Figure 51: Main menu

Note To select commands, click the first command and the
subsequent commands. For example, if you see
Customize > System that means, click Customize from
the main menu and then click System.

Brief overview of the File menu

When you log off, restart, or shutdown the application and/or the
workstation, you must use your User ID and password to log back in.

Logging off the system

1. Click File from the main menu.

Figure 52: File menu

The File dropdown appears.

Figure 53: File > Log Off

2. Click Log Off from the dropdown to Log Off the workstation software.
The Login popup appears.
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Figure 54: Login popup

This is also the login and shutdown portal. You can login or shutdown the
workstation from this popup.

Restarting the application
You can restart the application software using the following steps.

1. Click File from the main menu.

Figure 55: File dropdown menu

2. Click Restart Application.
The following Restart Application popup appears.

Figure 56: Restart Application popup

3. Perform one of the following:
o Click the Yes button to restart the application software.
o Click the No button to return to the screen.

Chapter 4 Basic Workstation Operations Page 108 of 412



BodyTom 64 User Manual Revision 04

Brief overview of the Tools menu

This menu provides you with tools to store and print, set up protocols,
and test your system to ensure it is operating as specified.

Figure 57: Tools dropdown menu
1. Click Tools from the main menu.

2. Click one of the following from the dropdown:

The Store/Print Queue displays the status of
studies being archived. You will learn more
about how to store to various media later in
this user manual; see page 117.

Allows users with Administrative privileges
to create, modify, delete, and/or upload
Protocol Manager protocols to the scanner. You will learn
more about how to use Protocol Manager
later in this user manual; see page 185.

The tool that verifies the system is at its

Store/Print Queue

Quality Assurance optimum performance. You will learn more
(QA) about QA later in this user manual see page
216.

Brief overview of the Customize menu

This menu provides you with tools to set up the system as well as define
user profiles.

Figure 58: Customize dropdown menu

1. Click Customize, then one of the following sub commands from the
drop-down list:

Allows users with Administrative privileges to
customize site-related settings; see “Chapter 5

System System and User Configuration and Setup” on page
117.
Allows you to customize layouts in the system as
User well as set the password. See “Chapter 5 System

and User Configuration and Setup” on page 117.
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Allows you to identify and select the room the
scanner will be used in. See "Selecting a room for
the BodyTom 64Selecting a room for the ” on page
184.

Select Room

Getting Help from the Help menu

NeurolLogica Help includes an online user manual and information about
the system. It also provides remote support from NeurolLogica Technical
Support for file transfer, remote upgrades, or system review and
support. When you enter a six-digit number, Technical Support will take
control of the system to retrieve files or review the issue in question.

Figure 59: Help dropdown menu

Getting an online user manual

To open a .pdf version of this user manual:
1. Click Help from the main menu.

2. Click User Manual from the dropdown list.
A PDF version of this manual will be opened.

Getting remote support
1. Click Help from the main menu.

2. Contact NeurolLogica Technical Support.
See “Contact information” on page 24.

3. Click Remote Support from the dropdown list.
The Support Connection window appears.
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Figure 60: Support Connection browser window

When connected to Remote Support, a NeurolLogica Technical
Support representative will supply a six-digit code to start a remote
support session, which allows the support representative to review
your system and troubleshoot the issue.

Getting information about the product and NeuroLogica
To get additional information about the product and NeurolLogica:

1. Click Help from the main menu.

2. Click About from the dropdown list.
The About Us popup appears.

Figure 61: About Us popup

The following information is found:

Identifies the current software versions for the

Version(s) system
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Licensed To Identifies who the product is licensed to.

Station AE Identifies the title for your workstation (for PACS
Title purposes).

Licensed Identifies any licensed packages available on the
Packages system.

Getting to know the status bar

The status bar appears in the top-right portion of the screen. The status
bar provides a quick view of the system’s current state. Details for the
icons on the status bar are in the tables below.

Figure 62: Scanner and workstation status bar

Table 25: Status bar icons
Status bar Status bar icon
icon name

Status description

Identifies x-ray as on or off.

The icon changes from a
Radiation status gray/black icon when x-ray is off,
to a rotating yellow/black icon
when x-ray is on.

Identifies the system’s current
state.

The orb changes color depending
System state on the state the system is in.

See Table 26 on page 114 for a
list of the different orb colors and
system states they identify.
Identifies the system’s current
Scanner position | position relative to its zero
reference.

Identifies when E-STOP is
engaged. The icon will flash
when E-STOP is pressed.

System E-STOP
status
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Status bar Status bar icon
icon name

Status description

System tube heat
status

Indicates the current X-Ray tube
heat status. The values are color
coded as follows:

Blue 0% - 19%

Yellow 20% - 50%

Orange 51% - 75%

Red 76% - 100%

NOTE: The scanners tube heat
must be below 20% before the
scanner powers down. If the
tube is too hot, a message will
display on the LCD scanner
control panel instructing you to
wait until the tube heat is low
enough to safely power off the
scanner.

Scanner battery
capacity status

Indicates the remaining scanner
battery percentage available. The
capacity values are color coded
as follows:

Green 100% - 51%

Yellow 50% - 25%

Red 24% - 0%

System air
freshness status

Indicates the air freshness status;
it is recommended that an air
calibration be performed:

e Every eight (8) hours.

e  When the air freshness
status falls below 50%.

e [f the scanner is moved to an
area with a dramatic change
in humidity and/or
temperature.

The calibration status values are
color coded as follows:

Green 100% - 51%

Yellow 50% - 25%

Orange 24% - 0%

After calibration it returns to
100%.
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Status bar Status bar icon

icon name

Status description

Workstation
battery capacity
status

Indicates the remaining
workstation battery capacity
available. The capacity values are
color coded as follows:

Green 100% - 21%

Yellow 20% - 11%

Red 10% - 0%

You will be prompted to plug the
workstation into an outlet to
charge if the battery capacity is
low; a scan cannot complete
when the battery capacity is 10%
or lower.

When the workstation reaches
the red capacity range, the
system will shut down. A
message informs you that the
system will shut down due to low
battery.

The lightning bolt icon signifies
that the workstation is currently
charging and goes away when
unplugged.

Image storage
space status

Indicates the available disk space
for image storage. The available
space values are color coded as
follows:

Green 100% - 51%

Yellow 50% - 20%

Red 19% - 0%

The system changes states as it performs different actions. The
following table indicates what state the system is in and the colored orb

that correlates to that state.

Table 26: System state orbs

Orb \Color State
Dark gray The system is in an unknown state.
Light gray The system is powering up or down.
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Orb Color \State

Dark purple | The system is busy.

Purple The system is completing air calibration.

Light purple | The system is archiving.

Blue The system is idle.

Green The system is ready to perform a scan.

Light yellow | The system is planning.

Dark yellow | The system is preparing.

Light orange | The system is reconstructing.

Dark orange | The system is scanning.

Pink The system is not ready.

Red The system is in fault.

The workstation tabs

To perform a patient examination, you will use the following five tabs on
the workstation:

Figure 63: Workstation tabs to perform a patient examination

The tabs include active tabs which will be green, and inactive tabs which
will appear gray. The active tabs are Patient Registration, Post
Reconstruction, and Patient Browser. The Acquisition and Viewing tabs
require additional steps to be performed before they become active.
The following actions are available in each tab:

Patient Allows you to register a patient either manually or
Registration from the hospital’s database sites.
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Allows you to select a protocol and perform the

Reconstruction

Acquisition examination. This tab is inactive until a patient is
registered.
Post Allows you to manipulate raw data in different

parameters and settings after your scan is
completed.

Patient Browser

Allows you to view, manipulate, and archive scans
already performed.

Viewing

Allows you to view patient images. This tab is
inactive until a study is loaded from Patient Browser.

In the following chapters, you will learn how to perform necessary steps
to conduct a patient examination and learn how to manipulate and store

the data you acquire.
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Chapter 5
Setup

System and User Configuration and

A user with administrative privileges must set up the BodyTom 64 system
configurations for other users. System configuration is used to set up the
scanner to meet site-specific needs. Most windows contain self-explanatory
instructions and refer to elements that are known to the administrative user
with radiological education and training.

Configuration includes setting up user permissions, or access privileges to
manage other users, as well as servers, what is available through settings,
presets, and other preferences for the use of the system at a site. Many
system configurations are permissible to the administrator, only. While
other configurations are permissible to users without administrator access.

Note You must have administrative access privileges and be
logged in as an administrator to set configurations for
the site.

Incorrect changes to the system configuration may make
the system inoperative.

The following table shows the System Configuration options that appear
when you click Customize > System and provides a brief description of each.

Table 27: System configuration tabs

Tab name Description

General Allows the a(#ministrator‘to set syst(-.:'m configurations
Settings such as hos.pltal name, wireless settings, and dose
report settings.
User Allows the administrator to create and edit user
Accounts accounts and permissions.
DICOM Allows the administrator to set up DICOM servers for
Servers archiving, such as PACS or HIS/RIS.
DICOM Allows the administrator to view and configure DICOM
] tags for HIS/RIS, MPPS, and Patient, Study, Series, and
Setting
Image modules.
Audio Allows the administrator to upload default audio files
X ] with protocols; also lets the administrator record, play,
Configuration s
and remove audio files.
Dose Allows the administrator to set up dose notifications,
Configuration | dose alerts, and configure dose limits for specific scans.
Windowing Allows the administrator to view and modify kernel and
Presets window width and window center presets.
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Tab name \ Description
. . Allows the administrator to view and log all changes as
Audit Trail . . . . & . &
Viewer well as actions in the system, including user logins,
patient registrations, and series updates.
Image Allows the administrator to view and modify how
Orientation images are oriented in the system.
. Allows the user to activate custom kernel options for
Filter Kernels . .
both Axial and Helical scans.

Setting user accounts

Only a user with administrative access can update another user’s account,
add a new user, delete a user, and lock or unlock a user’s access.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the User Accounts tab.

Figure 64: User Accounts tab
3. For the User ID field, enter the User ID name.

4. For the User Level field, enter one of the following user levels:

Full access to the system and it’s configurations.
Administrator Can create protocols, User ID’s, and passwords,
as well as access all functions of the system.
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Modified access to the system. Users with
Limited access can modify protocols during
scanning but cannot create and save protocols;
has no access to system configuration.

Users with Restricted access can scan with the
Restricted system but are unable to make any changes to
operator protocol parameters while scanning, they also
have no access to system configuration.

Limited operator

5. For the Last Name field, enter the user’s last name.
6. For the Enter First Name field, enter the user’s first name.

7. For the Password field, enter the user’s password.

Note The password must contain 8 to 12 characters, and must
include one number, one symbol and one letter.

8. For the Verify Password field, re-enter the user’s password to confirm
the password.

Figure 65: User account fields filled in

9. Click the Save button.
The user is added to the list.

Chapter 5 System and User Configuration and Setup Page 119 of 412



BodyTom 64 User Manual Revision 04

The Save Aborted popup appears if your password does not meet the
rule for passwords. If this is the case, return to the step above, and
fulfill the password rule.

Figure 66: Save aborted popup message — Password requirements

10. Click the Close button to exit.

Setting or updating a user’s information

1. Click Customize > System, from the main menu.
The System Configuration dialog box appears.

2. Click the User Accounts tab.

3. Select a user from the list of users.

Figure 67: List of users
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4. Modify the user’s information; for example, password, or user’s first and
last name.

Note The password must be 8-12 characters and include at
least a letter, number, and symbol.

The user’s changes take effect after clicking the Update button. Itis

recommended that you log off and log back on and check that the
password is working.

5. Click the Update button to keep the change(s).

The Update Aborted popup appears if your password does not meet the
rule for passwords. If this is the case, return to the step above, and
fulfill the password rule.

Figure 68: Update Aborted popup message — Password requirements

6. Click the Close button to exit.

Unlocking a user account

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the User Accounts tab.

3. Select the user to unlock from the list of users in the panel.
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Figure 69: List of users not selected

4. Click the Unlock button.

The user’s changes take effect after clicking the Update button. Itis
recommended that you log off and log back on and check that the
password is working.

Deleting a user

Note The administrator user cannot be deleted.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the User Accounts tab.

3. Select the user to delete from the list of users.
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Figure 70: List of all available users

4. Click the Delete button.
The Action Succeeded popup box appears.

5. Click the Ok button in the Action Succeeded popup.
6. Click the Close button to exit.
Modifying the order of the users in the accounts list

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the User Accounts tab.
3. Select the user order to modify from the list of users in the panel.

4. Click the Down arrow to move the user down the list.
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Figure 71: Down arrow

5. Click the Up arrow to move the user up the list.

Figure 72: Up arrow
The Up arrow will not activate until you move down the list of users.

6. Click the Save button under the user list to keep the new user list order.
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Figure 73: Save button for list order

7. Click the Save button next to the Update button to keep other changes.

8. Click the Close button to exit.

Assigning general settings

Perform the following to set how the hospital, workstation’s application,
scanner, and remote support are configured.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the General Settings tab.
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Figure 74: General Settings tab

3. The following tabs are only available to the administrator:

Hospital Setup Sets up hospital information specific to the site.
Application Sets up application information the user will
Setup experience.

Scanner Setup Sets up scanner IP address information.
Remote Support | Sets up IP address information to allow

Setup NeurolLogica remote support.

The following sections provide detailed information related to the
options available in the General Settings tabs.

Hospital Setup sub tab

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the General Settings tab.

3. Click the Hospital Setup sub tab.
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Figure 75: General Settings > Hospital Setup subtab

4. Enter the institution name in the Institution Name field.

Note The name appears on all images.

5. Enter the department name in the Department Name field.
6. Enter the institution address in the Institution Address field.

7. Click the following options that are applicable:

« When Auto Store is selected and you Finalize a scan, the system will
automatically send the images to the Default PACS server defined on
the DICOM Servers tab. (see System Configuration > DICOM Servers
> Servers). The status of your export will appear in the bottom right
of the Patient Browser screen.

e Click the Use Device AE in Server Setting option to apply the
BodyTom 64 AE title tag to DICOM when the operator archives the
image data to PACS.

o If enabled when sending images to PACS, this option will include
the BodyTom 64 AE setting as a DICOM tag.

8. Enter the system name (for example BodyTom 64) in the Station AE Title
field.

9. Enter the name you want to call the archive option in the “Push To”
Text box.
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10. Click the Save button to keep your changes.
The Save Successful popup appears.

11. Click the Ok button in the Save Successful popup.

12. Click the Close button to exit.

Application Setup subtab

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the General Settings tab.

3. Click the Application Setup sub tab.

Figure 76: General Settings > Application Setup subtab

4. Click and/or enter information for the following options that apply:
The Auto Lock feature can be used to
automatically lock the workstation
screen after a user defined Idle Time is
reached.

Allows the user to automatically display
Automatically Show the Store/Print Queue status when
Store/Print Queue images are set to archive to a network
device.

Displays the Dose Report on the screen
when the Finalize button is clicked.

Auto Lock

Show Dose Report
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A dose report will not be generated until
the operator clicks the Finalize button
on the Acquisition tab.

Generates a Dose SR (Structured Report)
along with the dose report when the
Finalize button is clicked.

Displays the Stored Results at the
bottom of Patient Registration.

Allows the user to automatically start

Automatically Generate
Dose SR

Show Stored Query Results

Prompt for Auto any additional reconstructions added to

Reconstruction a scan series after the exam is
completed.

Allow Manual Patient Allows the user to manually register a

Registration patient.

Default Pediatric Patient If selected, the Protocol Manager will

Type default to the pediatric protocols.

Change Password Interval | Sets the number of days before a

(Days) password change is required.

5. Click the Save button to keep your changes.

6. Click the Close button to exit.

Scanner Setup subtab

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the General Settings tab.

3. Click the Scanner Setup sub tab.
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Figure 77: General Settings > Scanner Setup subtab

4. Click and/or enter information for the following options that apply:
Scanner IP address Sets the scanner’s IP address in the field(s).
Sets up wireless information regarding the
connection from the workstation to the
scanner.

Point to Point Wireless | For Scanner Network Adapter, enter the
adaptor, for example, Wireless to Scanner.
For Scanner Wireless Profile, enter the
wireless identifier in the field.

5. Click the Save button to keep your changes.

6. Click the Close button to exit.

Remote Support Setup subtab

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the General Settings tab.

3. Click the Remote Support Setup subtab.
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Figure 78: General Settings > Remote Support Setup subtab

4. Click the Remote Support Network Connection dropdown to select one
of the following network connections:
e Wireless to Scanner
e Wired to Network

5. Click the Use Static IP option to enter the Static IP Setup data for the
following:
e System IP Address
e System Subnet
e System Gateway

6. Enter the DHCP Setup to enter IPs for the following:
o DNS Server (Preferred)
o DNS Server (Alternate)

7. Click the Save button to keep your changes.

8. Click the Close button to exit.
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Managing DICOM servers

Digital Imaging Communication in Medicine is the definition of the
acronym DICOM. DICOM servers are used to export images from the
scanner. The System Configuration > DICOM Servers tab allows a user with
administrative rights to access all the DICOM devices connected to the
scanner.

See DICOM standards on the NEMA.org website for a full description of
settings and actions that are available.

Note You must have administrative privileges and be logged in
as an administrator to access and modify DICOM servers.

Incorrect changes to the DICOM servers may make the
system inoperative.

DICOM servers are set up by the field-service engineer and the appropriate
IT person at the hospital.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Servers tab.

Figure 79: DICOM Servers tab
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The following tabs appear:

Lists existing servers based on type:
Store and Worklist

Store: |dentifies a storage server.

Worklist: Identifies servers in a database you can

Servers
query from.

Also displays server details and options, with
controls for saving, updating, deleting, and echoing
servers.

Displays a list of PACS by Server Name, Type, and In
List — to send to by default.

Displays controls for PACS Options and HIS/RIS
Options.

PACS List

Options

Figure 80: DICOM Servers tabs

3. Go to the following sections to assign specific actions to the DICOM
server.

Assigning a server as a store or worklist server

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Servers tab.
The Servers tab is active.
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Figure 81: DICOM Servers > Servers tabs

3. Click one of the following options:

Store

A storage server, typically a PACS server that archives
images and patient information. The images and data
can later be imported from the server to another
system or the same system. It is partly a backup and
partly a waypoint for transferring data from the system
the scans were acquired on to another system for
viewing.

Worklist

A database of patient information that can be queried
to generate a list of patients based on name, modality,
procedure date, and other variables. These patients
are usually hosted on a server within the facility and
the information can be imported from the server when
trying to acquire all a patient’s information before a
procedure is run. This eliminates the need to manually
enter patient information at the time of the procedure.

4. Under Details, enter the server’s name in the Server Name text box.

5. For the HIS/RIS and PACS Network Connection, click the dropdown to
identify the following:
« Wireless to Scanner
¢ Wired to Network

6. Click the Point to Point Wireless check box if it applies.
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7. Click the Wireless Profile dropdown to select the appropriate profile.
8. Inthe Server AE Title text box, enter the server AE title.

9. Inthe Device AE Title text box, enter the BodyTom 64 AE title.

10. In the Server IP Address text boxes, enter the server |P address.

11. In the Port text box, enter the port identifier.

12. In the Connection Timeout text box, enter the number of seconds
before the connection timeout is activated.

13. Click the Use Static IP option to identify the following:
e System IP Address
e System Subnet
e System Gateway

14. To set the server as a default server, click the Default Server check box.

15. To set the server as the default surgical navigation server, click the
Default Navigation check box.

16. To enable the storage commitment, click the Enable Storage Commit
check box to send a message back to system that confirms the storage
was successful; it is an extra confirmation from PACS that the images
were received.

17. To gather responses, click the Listen for Responses check box.
For every image that is sent, the system will wait for acknowledgement
before sending the next image.

18. To gather 12-bit images, click the 12-bit Images check box.

19. Click the Save button, to keep your work.

Figure 82: Action Succeeded popup message — Server saved
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The new server should appear in the list box to the left.
20. Click the Ok button.

21. Click the Close button to exit.
Modifying a server

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Servers tab.
3. Click server type: Store or Worklist.
4, Select a server from the list.

5. Modify the parameters.
See “Assigning a server as a store or worklist server” on page 133.

6. When all your changes are made, click the Update button.
A message appears that explains the update was successful and includes
the update(s).

Figure 83: Action Succeeded popup message — Server updated

7. Click the Ok button.

8. Click the Close button to exit.

Echoing a server

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Servers tab.
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3. Click a server type: Store or Worklist.
4. Select the server to echo from the list.

5. Click the Echo button.
The status of the server appears.

Figure 84: Echo Successful and Echo Failed popups

6. Click the Ok button.
If the echo was unsuccessful, determine why and repeat step 5 until you
are successful.

7. Click the Close button to exit.

Deleting a server

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Servers tab.
3. Click a server type: Store or Worklist.

4. When the server you want to remove is available, click the server from
this list.

5. Click the Delete button.
The server is removed from the list; the Action Succeeded popup
appears.

6. Click the Ok button.

7. Click the Close button to exit.

Moving a server up and down the server list

1. Click Customize > System from the main menu.
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The System Configuration dialog box appears.
2. Click the DICOM Servers tab.
3. Click a server type: Store or Worklist.
4. Select the server to move up or down the list.

5. Click the Up arrow to move the server up the list; click the Down arrow
to move the server down the list.

Figure 85: Up and Down arrows to move up and down server list

6. Click the Save button to save the server order.

Chapter 5 System and User Configuration and Setup Page 138 of 412



BodyTom 64 User Manual Revision 04

Figure 86: Save button

The Action Succeeded popup appears.
7. Click the Ok button.

8. Click the Close button to exit.

Saving DICOM servers to a PACS list

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Servers tab.

3. Click the PACS List tab to view available servers.
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Figure 87: DICOM Servers > PACS List tab

4. Double-click the light-gray checkmark under In List.
Each checkmark adds the server to the PACS listing. The checkmark
turns green when active.

5. Click the Save button.
The PACS List Saved popup appears.

Figure 88: PACS List Saved popup message — PACS saved
6. Click the Ok button.

7. Click the Close button to exit.

Selecting PACS options

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.
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2. Click the DICOM Servers tab.

3. Click the Options tab.

Figure 89: DICOM Servers > Options tab

4. Under PACS Options, click the Enable Storage Commit to verify that
patient information and data archived to the PACS server was received.
« If Enable Storage Commit is not selected, it is assumed and accepted
that the data was received.
« If Enable Storage Commiit is selected, the workstation sends a
request to the PACS server to verify that the data was received.

5. If the Enable Storage Commit check box is selected, perform the
following:
o Enter the appropriate title in the System Called AE Title text box.
o Enter the port identifier in the Port text box.
e Enter the number of seconds before a connection timeout in the
Connection Timeout (secs) text box.
e Enter 30 seconds or 60 seconds.

6. Under Purge Options, make selections based on the understanding that
any studies archived to the PACS server are deleted from the
workstation on a regular basis, depending on the selected interval;
identify the following:
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7.

10.

Select one of the following from the dropdown:
Everyday, Weekly, or Monthly. When you select
the first Purge Interval dropdown and select
Weekly or Monthly, the inactive dropdown is
active to let you select the day of the week or the
first of the month.

Purge Interval

Changes the hour, minute, and second interval;

. use the buttons to increase those time elements.
Time

Figure 90: Time (increase and decrease time) arrows

Under the HIS/RIS Options, enter the maximum number of results sent
back from a query worklist in the Query Max text box.
There is no maximum limit.

Click the Send MPPS check box to apply a service that allows a modality
to better coordinate with image storage servers by giving the server a
list of objects to send before or while sending such objects.

Under Import Options, click the Use C-GET check box to pull information
from a PACS server when importing from the server (as opposed to
archiving to it).

The administrator sets this to pull from PACS from anywhere, so the
machine does not have to be set up as a reliable destination on the
PACS machine. PACS, typically needs to equate a computer’s IP address
with an AE title; however, C-GET accepts that the calling IP is a
legitimate device.

The Neurologica BodyTom 64 scanner automatically uses C-Move when
importing from PACS. If the operator wants to use C-GET instead, the
user can select C-Get.

Click the Save button.
The PACS List Saved popup appears.

Figure 91: PACS List Saved popup

Chapter 5 System and User Configuration and Setup Page 142 of 412



BodyTom 64 User Manual Revision 04

11. Click the Ok button.

12. Click the Close button to exit.

Assigning DICOM settings

DICOM settings include many kinds of settings. The administrator can add
or remove optional information to be displayed using actions described in
this section.

See DICOM standards on the NEMA.org website for a full list and
description of DICOM tags.

Note You must have administrative privileges and be logged in
as an administrator to access and modify DICOM settings.

Incorrect changes to the DICOM settings may make the
system inoperative.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the DICOM Settings tab.

Figure 92: DICOM Settings tabs (six)
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3. Click the HIS/RIS Query tab to select the types of HIS/RIS query results
the user will see when performing a HIS/RIS query.
See “Selecting PACS options” and go to step 6, for more information.

Note Even numbered DICOM tags are public DICOM tags as per
the DICOM standard. Odd numbered DICOM tags are
vendor specific.

Green checkmarks are optional DICOM tags and orange
checkmarks are required per the DICOM standard and
cannot be modified.

Figure 93: DICOM Settings > HIS/RIS Query

4. Click the Modality Performed Procedure Step (MPPS) tab to select the
types of MPPS information the user will see.
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Figure 94: DICOM Settings > MPPS

5. Click the Patient Module tab to select the types of Patient Module
information the user will see.

Figure 95: DICOM Settings > Patient Module

6. Click the Study Module tab to select the types of Study Module
information the user will see.
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Figure 96: DICOM Settings > Study Module

7. Click the Series Module tab to select the types of Series Module
information the user will see.

Figure 97: DICOM Settings > Series Module

8. Click the Image Module tab to select the types of Image Module
information the user will see.
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Figure 98: DICOM Settings > Image Module

9. Click the Save button to save your changes.

10. Click the Close button to exit.

Assigning audio configuration

Default audio files are installed on the workstation. Audio files can be
attached to protocols and sent to the scanner. Each audio file has an
indication if it has been sent to the scanner.

Note You must have administrative privileges and be logged in
as an administrator to access and modify audio
configurations.

Incorrect changes to the audio configurations may make
the system inoperative.

Finding and listening to audio files

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Audio Configuration tab.
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Figure 99: Audio Configuration tab

3. Review the audio files that exist on the Workstation.

Figure 100: Audio files list

4. To listen to an audio file, select the name from the workstation list and
click the Play button.

5. To exit the Audio Configuration, click the Close button.
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Recording and saving an audio file

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Audio Configuration tab.
The available audio files appear under Workstation.

Figure 101: Audio files list

3. Enter the name of your new audio file in the File name text box.
4. Click the Record button.

5. Record your audio file.

6. Press the Stop button.

7. To review, highlight your new recording and press the Play button.
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Figure 102: New audio file

8. When you like your recording, highlight the file, and press the Transmit
button to copy the file into the audio folder for your scanner protocols.

9. Click the Close button to exit.

Transmitting an audio file

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Audio Configuration tab.
The available audio files appear under Workstation.

3. Select the audio files under Workstation audio files to transfer to the
scanner.

4. Click the Transmit button.
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Figure 103: Audio files transmitted to save to the scanner

5. Click the Close button to exit.

Deleting an audio file

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Audio Configuration tab.
The available audio files appear under Workstation.

3. Select the audio file you want to delete from the list.
4. Click the Delete button.

5. Click the Close button to exit.

Assigning dose report

The dose report is created at the end of the scan and can be customized to
include DICOM specific tags.

Note You must have administrative privileges and be logged in
as an administrator to access and modify dose report
settings.
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1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Dose Configuration tab.

3. Click the Dose Report tab.

Figure 104: Dose Report tab

4. Select the DICOM tags you want to see in the dose report.
A dose report is generated after the exam is finalized; the black area
includes dose report information like the following.

Figure 105: Generated dose report

5. Click the Save button.

6. Click the Close button to exit.
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Applying dose configuration

Note You must have administrative privileges and be logged in
as an administrator to access and modify dose
configurations.

Incorrect changes to dose configuration settings may
make the system inoperative.

Note You can check the Audit Trail to review the audit log that
details what dose limit was removed, by whom, and the
date and time it took place.

Dose configuration consists of both Dose Notifications and Dose Alerts.

Dose Notification

Notifies the user when the planned CTDIyoand/or
DLP value of a single series will exceed the defined
value.

Dose Alert

Notifies the user when the planned CTDIyc and/or
DLP value from the combination of all planned
series will exceed the defined value set in System
Configuration. Dose Alerts represent a value
which would be well above an institution’s
established CTDI/DLP range to the given
examination and warrant a more stringent review
and consideration before proceeding.

Setting Dose Check

See Appendix A on page 380 for information on protocols, CTDIyel, and DLP.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Dose Configuration tab.

3. Click the Dose Check tab.
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Figure 106: Dose Configuration > Dose Check

4. Click one of the following Dose Check Type options:
Notifies the user when a pre-defined
CTDlvoior DLP value will be exceeded on
a series-by-series basis.

Notifies the user when a pre-defined
CTDlvolor DLP value will be exceeded
from a combination of all planned series
or scans.

Dose
Notification

Dose Alert

Note The default Dose Alerts which are set at 1000mGy
CTDIl and 5000mGy*cm DLP are designed to prevent the
patient from receiving any possible deterministic effects
due to excess dose. However, the system allows these
values to be modified by the user. Any modifications to the
Dose Alerts should be done by qualified medical personnel.

5. Click one from the following Scan Type options.

All Identifies all scan types.

Axial Identifies only Axial scan types.
Helical Identifies only Helical scan types.
Dynamic Identifies only Dynamic scan types.

6. Define the Dose Limit by entering the following:
o Enter the CTDlyoi (mGy) value in the text box.
o Enter the DLP (mGy.cm) value in the text box.
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7. Click the Save button.
The Save Successful popup appears.

Figure 107: Save Successful popup — Dose Check successfully saved
8. Click the Ok button.

9. Click the Close button to exit.

Assigning Dose Configuration to a patient protocol

Dose Configuration limits are used to prevent users from selecting kV or mA
values that are not appropriate for the given patient types, such as
pediatrics etc.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Dose Configuration tab.

3. Click the Dose Configuration subtab.

Figure 108: Dose Configuration > Dose Configuration for adult and pediatric

4. Click one of the following:
Selecting Adult shows the pre-defined adult
protocols, stored by anatomical area.

Adult
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Pediatric Selecting Pediatric shows the pre-defined pediatric
protocols, stored by anatomical area.
The Trauma orb can be used to store protocols
Trauma commonly used for emergency scans.

5. Click the colored orb that marks the anatomical region to apply the dose
to.

Figure 109: Anatomical orbs

6. Click a scan type from the following list:

Axial Identifies only Axial scan types.
Helical Identifies only Helical scan types.
Dynamic Identifies only Dynamic scan types.

7. Enter a description for the Dose Configuration in the Description text
box.

8. For Pediatrics enter the Minimum and Maximum Weight and Length
information.

9. Under the Max Power settings, click the kV dropdown and select the
maximum allowed kV.

10. Click the mA dropdown and select the maximum allowed maA.
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Figure 110: Pediatric Dose Configuration Parameters

11. Click the Save button to save your work.
If the level overlaps an existing level, you are prompted to adjust.

Figure 111: Invalid Parameter popup message — Dose setting kV already exists

If the save is successful, the Save Successful popup appears.

Figure 112: Save Successful popup message — Maximum dose saved
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12. Click the Ok button.

13. Under the Saved Doses list box, check that your dose configuration
appears, if so, go to the next step.

14. Click the Close button to exit.

Updating saved dose

To modify a saved Dose Configuration.
See “Setting Dose Check” page 153 and/or “Assigning Dose Configuration to
a patient protocol” on page 155.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Dose Configuration tab.

3. Select the desired Saved Dose from the Saved Doses list.

Figure 113: Saved Doses List
4. Modifying values causes the Update button to become active.

5. Click the Update button.
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Figure 114: Save Successful popup message — Maximum dose saved
6. Click the Ok button.

7. Click the Save button to save your work.

Note If the level overlaps an existing level, you are prompted
to adjust.

8. Click the Close button to exit.

Deleting a saved dose limit
To remove a saved Dose Configuration.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Dose Configuration tab.

Figure 115: Dose Configuration > Dose Check tab

3. Click an already-saved dose, under the Saved Doses list.
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4. Perform one of the following:
« To delete a saved dose from the Saved Doses list and clear the
restriction, select the dose, and click the Delete button.
« To delete all the saved doses in the Saved Doses list and clear all
restrictions saved, click the Delete All button, which returns all
settings for that selection to the maximum scanner default.

Note If there are no saved doses or limits, the operator will be
able to scan using the maximum 140kV and 300mA
available on the scanner.

5. Click the Save button.
The save success message appears and, because the CTDIvol (mGy) and
DLP (mGy.cm) are empty, there is no longer a limit applied.

The Save Successful popup appears.

Figure 116: Save popup message — Maximum dose saved

6. Click the Ok button.

7. Click the Close button to exit.

Applying Windowing Presets

Windowing presets allow you to define window width and center presets
for specific anatomical locations as well as specific reconstruction kernel
presets. An Administrative User can delete or update the default Window
Presets as well as create new Windowing Presets.

Note You must have administrative privileges and be logged in
as an administrator to access and modify the windowing
presets.
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Editing kernel presets

Note Kernel presets are pre-installed in the system; kernel
presets can be set and modified.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Windowing Presets tab.

Figure 117: Windowing Preset tab

3. Click the Kernel Presets tab.
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Figure 118: Windowing Presets > Kernel Presets tab

4. Click the Scan Type dropdown to select one of the following scan types:
o Axial
e Helical

5. Click the Sharpness dropdown to select a sharpness from the list.
Sharpness is the reconstruction algorithm, and the available Sharpness
values are based on the scan type.

Figure 119: Sharpness dropdown

6. Enter the Window Width in the Width text box.
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Window Width describes the range of Hounsfield units, or shades of
gray, displayed across the image. The Window Width controls the
contrast of the image. Low Hounsfield numbers below the range are
displayed as black, while High Hounsfield numbers above the range are
displayed as white.

7. Enter the Window Center in the Center text box.
Window Center describes the Hounsfield number in the center of the
Window Width. Window Center controls the brightness or density of
the image.

8. Click the Save button to save your work.
The Action Succeeded popup appears.

Figure 120: Action Succeeded popup message — Preset saved
9. Click the Ok button.

10. Click the Close button to exit.

Setting Window Presets

Window presets allow you to define Window Width and Window Center
presets for specific anatomical locations, such as bone, brain, lung, and soft
tissue.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Windowing Presets tab.
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3. Click the Window Presets subtab.

Figure 121: Window Presets tab

4. Enter the name of the window preset in the Name text box.

Figure 122: Window Presets > Name

5. Enter the width of the window preset in the Width text box.
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Figure 123: Window Presets > Width

6. Enter the center for the window preset in the Center text box.

Figure 124: Window Presets > Center

7. Click the Save button to save your work.
The Action Succeeded popup appears.
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Figure 125: Action Succeeded popup message — Preset saved

8. Click the Ok button.

9. Click the Close button to exit.

Editing a window preset

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Windowing Presets tab.
3. Click the Window Presets subtab.

4. Click a preset that exists in the Window Presets listing.

Figure 126: Listing update
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5. To edit the preset, make your changes in the Name, Width, and/or
Center text boxes.

6. Click the Save button to save your changes.
The Action Succeeded popup appears.

Figure 127: Action Succeeded popup message — Preset saved

7. Click the Ok button.

8. Click the Close button to exit.

Deleting a preset

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Windowing Presets tab.
3. Select the preset.

4. Click the Delete button.
The Action Succeeded popup appears.

Figure 128: Action Succeeded popup message — Preset deleted

5. Click the Ok button.
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6. Click the Save button to exit.

Setting up the Audit Trail Viewer

The Audit Trail Viewer gives a user with administrative access the ability to
view all activities performed by anyone logged into the system. This
includes changes to protocols, deletion of images, as well as
acknowledgement of alerts etc.

Note You must have administrative privileges and be logged in
as an administrator to access the Audit Trail Viewer.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Audit Trail Viewer tab.

Figure 129: Audit Trail Viewer tab

3. From the Audit Trail Viewer tab, use the calendar to select a date range
to view.

« To select a single date, position the mouse pointer in the top box
and click the date on the calendar to find audits for that date.

« To select a date range, click the desired start date on the calendar.
This will automatically populate the top box of the From range. Click
the desired end date on the calendar, which automatically fills the
bottom box of the From range.
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Figure 130: Adding a date or a date span

4. Click the Audit Type dropdown to select the type of audit you are
searching.

Figure 131: Audit Trail Viewer > Audit Type dropdown

5. From the User ID dropdown, click the type of user to track.
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Figure 132: Audit Trail Viewer > User ID dropdown

6. Click the View button to see the result of audits that met your criteria.

Figure 133: Audit results

7. Perform one of the following:
o Click the Clear button to remove the audit results.
o Click the Export button to export the audit result that you selected
to the audit backup file on the system.
o Click the Export All button to export the audit results to the audit
backup file on the system.
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8. Click the Close button to exit.

Setting image orientation

Neurologica describes patient orientation as if the viewer were looking
towards the front of the gantry. In other words, if the patient is lying face
up with their head in the gantry, the image orientation displays the patient’s
Right side on the Left side of the Viewer. If the patient’s feet are going into
the gantry, the image orientation displays the patient’s Left side on the Left
side of the Viewer.

Note You must have administrative privileges and be logged in
as an administrator to modify image orientation settings.

Changes to image orientation settings will modify the
displayed orientation markers on the images.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Image Orientation tab.

Figure 134: Image Orientation tab
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The top half of the Image Orientation screen shows the available
patient orientations. The black image orientation square represents the
viewing area and shows four different orientation markers: A = anterior,
L = left, P = posterior and R = right. If you do not see letters in the image
orientation box, select an image orientation from the list.

3. Select the appropriate orientation from the list.
For example, select, Head First Supine. In the figure below, the
highlighted selection shows the current orientation in the Current Flip
Orientation field, which is not changeable; however, the New Flip
Orientation lets you change the orientation.

4. Click the New Flip Orientation dropdown to select one of the following
new-flip orientations:
« NONE
e LEFT_AND_RIGHT
« TOP_AND_BOTTOM
« BOTH

Figure 135: Image Orientation > New Flip Orientation dropdown

5. Click the Save button to save changes.

6. The Settings Saved popup appears.
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Figure 136: Settings Saved popup message — Image orientation settings saved
7. Click the Ok button.

8. Click the Close button to exit.
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Setting Filter Kernels

Filter kernels allow you to activate custom kernel options for both Axial and
Helical scans to control the sharpness and smoothness of the images.

1. Click Customize > System from the main menu.
The System Configuration dialog box appears.

2. Click the Filter Kernels tab.

Figure 137: Filter Kernels tab

3. Perform one of the following:
« To add new Axial kernels, select the Axial radio button, then double-
click the Value cell next to the desired Axial kernel.
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Figure 138: Selected Axial kernel

To add new Helical kernels, select the Helical radio button, then double-
click the Value cell next to the desired Helical kernel.

Figure 139: Selected Helical kernel

4. Click the Save button.
The Success popup appears.

5. Click the Ok button.

6. Click the Close button to exit.
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User configuration
User configuration allows users with either Administrator or Limited
Operator access to change the password for their own account.
Updating your user account

1. Click Customize > User from the main menu.
The User Configuration dialog box appears.

Note You must have administrative or limited operator
privileges to access and modify user accounts.

Incorrect changes to user accounts may cause users to be
unable to access the system.

The Update Accounts tab is the default selection.

2. Modify the following fields associated with your user account by
entering relevant information:
e Last Name
e First Name
e Password
+ Verify Password

Figure 140: Last Name, First Name, Password, and Verify Password fields
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3. Click the Update button.

4. The Update Succeeded popup appears.

Figure 141: Update Succeeded popup message — Account updated

5. Click the Ok button.

6. Click the Close button to exit.

Applying column settings to HIS/RIS Query

Allows you to customize the columns of information that appear when
viewing the Hospital Information System (HIS) and/or Radiology
Information Systems (RIS) information that is queried.

All users can access user configuration and make changes to the column
settings; however limited and restricted operators cannot make their
changes to the column headings the default. Only users with administrative
access can make column settings a default, using the Make Default option.

1. Click Customize > User from the main menu.
The User Configuration dialog box appears.

2. Click the Column Settings tab.

3. There may be no entries that appear, initially.

Note When an option is selected (for example HIS/RIS Query
or Patient Browser), a table is created that lists the
columns, along with a check box to indicate whether it
will be displayed within the table. Required columns
cannot be unchecked and are colored orange instead of
the default green.

4. Click the HIS/RIS Query option.
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Figure 142: Column Settings dialog box with HIS/RIS Query option

5. Double click the Checkmark under Displayed column for the row you
want to display or remove if it is already selected.

Figure 143: Column Settings with a selected query in HIS/RIS

6. Notice that the Up and Dwn buttons are active when a row is selected.

7. Click the Up or Dwn buttons to move the active selection up or down
the list.

Chapter 5 System and User Configuration and Setup Page 178 of 412



BodyTom 64 User Manual Revision 04

Figure 144: Column Settings with HIS/RIS Query option using Up and Dwn
buttons

8. If you have administrative privileges, click the Make Default option to
make the selected column display the default for all users.

Figure 145: Make Default option

9. Click the Save button to keep changes.

10. Click the Close button to exit.
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Applying column settings to Patient Browser

Allows you to configure the columns of information seen in the Patient
Browser.

1. Click Customize > User from the main menu.
The User Configuration dialog box appears.

2. Click the Column Settings tab.

3. Click the Patient Browser option.

Figure 146: Column Settings with Patient Browser option

4. Click one of the following options:

Information that appears on the top portion of the
Patient/Study | Patient Browser that defines patient specific
information.

Information that appears on the lower portion of the

Series . . . e .
Patient Browser that defines series specific information.

5. Double click the Checkmark under Displayed column for the row you
want to display or remove if it is already selected.

6. Notice that the Up and Dwn buttons are active when a row is selected.

7. Click the Up or DWN buttons to move the active selection up or down
the list.
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Figure 147: Column Settings with Patient Browser Series option — using Up and
Dwn buttons

8. If you have administrative privileges, click the Make Default option to
make the selected column display the default for all users.

Figure 148: Make Default option

9. Click the Save button to keep changes.

10. Click the Close button to exit.
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Viewing Scan Dosage Report

1. Click Customize > User from the main menu.
The User Configuration dialog box appears.

2. Click the Scan Dosage Report tab.

Figure 149: Scan Dosage Report tab

3. Toview Dosage Reports, click the date or date range on the calendar.

Note If the date is left blank — all doses for all dates are
retrieved.

4. Click the Protocol dropdown to select a protocol.

Note If the protocol is left blank — all doses for all protocols
are retrieved.

5. Click the mA Range dropdown to select the mA range.
The mA Range default is 20-30; it can be changed after data is retrieved.
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Figure 150: Date, Protocol, and mA Range filled

6. Click the View button to display a graph showing dosages performed by
the scanner using the selected filters.

Figure 151: Scan Dosage Report results

Note If you adjust the mA range, the graph displays those
ranges within the retrieved data.
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7. To clear the filters selected, click the Clear button.

Selecting a room for the BodyTom 64

Selecting a room ensures that the correct calibration is loaded or used when
the scanner has been calibrated in more than one location.

1. Click Customize > Select Room.

2. Alist of the rooms available appear in the cascading menu.

Figure 152: Available rooms before moving the scanner

3. Click the room in which the scanner will be used.

4. Move scanner to the selected room.
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Chapter 6 Protocol Manager

Note You must have administrative privileges and be logged
in as an administrator, to access the Protocol
Manager.

Protocol Manager allows a user with administrative privileges to create
new protocols, modify existing protocols and delete protocols from the
system. Protocol Manager provides three patient options: Adult,
Pediatric, or Trauma patient.

Table 28: Protocol Manager command buttons

Button Action

Allows you to create a new protocol.

Allows you to create a new protocol from an
existing protocol.

Allows you to modify protocols.

Deletes a saved protocol.

Imports previously exported protocols into the
workstation.

Exports protocols to a media device.

Closes the Protocol Manager dialog box.

Moves a protocol up or down the ordered list.

Saves the order of the protocol list.
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Note: Protocol parameters are customized to your
requirements in conjunction with local and nationally
recognized published guidelines. These protocols
must be approved by your facility physicist before the
system’s acceptance.

WARNING Any modification to an existing protocol, or any new protocol created,
should be reviewed, and approved by a radiologist and/or residing
medical physicist. Failing to do so could cause a patient to receive an
excessive and/or unnecessary dose of ionizing radiation.

Resources for radiation protection of pediatric patients appear below
and are for referring physicians with a focus on radiation exposure:

American Academy of Pediatrics (AAP), https://www.aap.org:
Search for radiation risk to children from Computed
Tomography

Federal Drug Administration (FDA),
https://www.fda.gov/search

Search for guidelines for pediatricians regarding medical
radiation safety

American College of Radiology (ACR):
https://www.acr.org/Clinical-Resources/Clinical-Tools-and-
Reference/Appropriateness-Criteria

Image Gently® and CT scans

https://www.imagegently.org/Procedures/Computed-
Tomography

Image Gently/FDA Digital Radiography Safety Checklist:
https://www.imagegently.org/Portals/6/Procedures/Attachme
nt%20D.CR.DR%20%20checklist.pdf

Creating a new protocol

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog appears.
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Figure 153: Protocol Manager for adult and pediatric

2. Click one of the following:
To create and/or scan with adult scan protocols,

Adult ) . .
which are stored by anatomical location.
N To create and/or scan with pediatric scan protocols,
Pediatric . . .
which are stored by anatomical location.
The Trauma orb can be used to store protocols
Trauma

commonly used for emergency scans.

By selecting either an Adult or Pediatric patient, the
corresponding list of saved protocols becomes
available.

3. Click the colored orb corresponding to the appropriate body part.

Figure 154: Adult and pediatric anatomical orbs, with Chest orb selected

Existing protocols in the selected Orb will appear in the Protocol list
box as seen below. The New button will become active.
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Figure 155: Adult and pediatric protocol lists

4. Click the New button to create a new protocol.
The New Protocol dialog box appears.

Figure 156: New Protocol dialog box

Enter Protocol Information in the text boxes:

The name of the protocol as it will be
displayed in protocol manager. Reference
Protocols begin with the letters NL and
cannot be deleted from the system.
References the anatomy that will be
scanned.

The DICOM image tag; if entered, this
Default Study Description |description will also appear in PACS as a
Study Description DICOM tag (0008,1010).

Protocol Description

Anatomical Reference
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5. Under Patient Position, select one of the following scanning positions
from the dropdown:

HFS Head First-Supine

HFP Head First-Prone

HFDL Head First-Decubitus Left
HFDR Head First-Decubitus Right
FFS Feet First-Supine

FFP Feet First-Prone

FFDL Feet First-Decubitus Left
FFDR Feet First-Decubitus Right

You can also move the rotating positional handles by hovering the

mouse pointer over the handle and clicking to select a position.

« The arrows at the feet rotate the patient orientation from Head
First to Feet First.

« The arrow above the patient rotates the patient orientation from
Supine to Prone to Decubitus.

Figure 157: Patient position handles

6. Under Protocol’s Series, click the New button.
The New Series dialog box appears.
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Figure 158: New Series dialog box

7. For Scan Type, select one of the following:

e Axial

e Helical

e Dynamic
o Reference
e Scout

Note For Helical scanning, the exposed area is extended by
at least % rotation to 1 full rotation at the start and
end of the planned scan, based on the sharpness
selected.

8. For Scout Type, select one of the following:
e AP
e PA
e Lateral
Scout Type is not available for Axial, Helical, Dynamic, and Reference
scan modes.

9. For kV (scan voltage), select one of the following:

« 80 To set the scan kV to 80.

« 100 To set the scan kV to 100.

e 120 To set the scan kV to 120.

« 140 To set the scan kV to 140.

kV is not selectable when using the Dynamic and Reference scan
modes.

See “Identifying load factors” on page 228.

Chapter 6 Protocol Manager Page 190 of 412



BodyTom 64 User Manual Revision 04

10. For mA (scan current), select the desired value from the dropdown.
The available mA range is 30 to 300 with an increment of 5mA.
mA is not selectable when using the Reference scan mode.

11. For Slice Thickness/Spacing, select the desired value from the
dropdown.
Slice Thickness/Spacing is not available for Scout and Reference scan
modes.

12. For Sharpness, select the image reconstruction kernel from the
following list of kernels:
e Low Noise QA — Not for Clinical Use
o Soft Tissue — Available for Axial Scan Type only
o Soft Tissue — Head — Available for Helical Scan Type only
o Soft Tissue — Abdomen — Available for Helical Scan Type only
o Pos. Fossa/Vessel — Available for Axial Scan Type only
e Sharp — Available for Axial Scan Type only
o Bone (No AEC) — Available for Axial Scan Type only
o Bone —Head (No AEC) — Available for Helical Scan Type only
o Bone—Abdomen (No AEC) — Available for Helical Scan Type only
o Sharp Lung (No AEC) — Available for Axial Scan Type only
o High-Res QA (No AEC) — Not for Clinical Use
Sharpness is not selectable when using the Reference and Scout scan
modes.

Note The Low Noise QA and High-Res QA (No AEC) options
should not be used for clinical scanning.

13. For Resolution, which also refers to scan time, select one of the
following options:
o 1 Second(s)
e 2 Second(s)
Resolution in only available for Axial Scan Types.

14. For Pitch, which describes how fast the scanner is moving during one
rotation of the x-ray tube, select one of the following options:
e 0.4 where the scanner will move 15.36mm per second.
e 0.8 where the scanner will move 30.72mm per second.
Pitch is only available for Helical Scan Types.

15. For Body Part Examined, select the appropriate Body Part from the
drop-down menu.

16. For Window Width, enter the range of CT numbers that are
distributed over the viewable gray scale of the display device or film.
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17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

For Window Center, enter the CT number in the center of the
viewable gray scale.

For Description, enter the desired study description.
For Start Position, enter the start scan position.
For End Position, enter the end scan position.

Coverage is a calculated value that automatically fills based on the
Start and End position values.

For Contrast, enter the type of contrast given for example.

For Contrast Volume, enter the amount of the contrast given.
Contrast is not available for Reference and Scout scan modes.

For Delay, enter the delay time that will occur after clicking the
START button on the scanner control panel.

Number of images is a calculated value based on the Slice
Thickness/Spacing and length of the scan.

Scan Time is a calculated value based on the protocol parameters
selected. Scan time is affected by Resolution, Pitch and Scan Length.

For CTDlvol (mGy), if applicable, the calculated number appears here,
depending on other selections.

CT Dose Index Volume (CTDIyo) represents the dose for a specific
scan protocol, which considers gaps and overlaps between the
radiation-dose profiles from consecutive rotations of the x-ray
source. The CTDlyo is calculated differently for both the Axial and the
Helical scan modes:

o For Axial scan mode: CTDlvol = [(N x T)/I] x CTDIw

o For Helical scan mode: CTDlyo = 1/pitch x CTDIy,

Dose Length Product (DLP (mGy.com)), is the measure of ionizing
radiation exposure during the entire acquisition of images.
Therefore, DLP (mGy.cm) = CTDlvol (mGy) x irradiated length (cm).

Select the following options, if applicable. See Scanning with special
features for more details.

Allows you to manually start the Axial scan
acquisition from the workstation when
scanning a patient who is unable to remain
still.

Step & Shoot
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Bolus Tracking

A CT angiography technique that allows you
to monitor the administration of contrast
to initiate the scan at peak contrast
enhancement.

Enable AEC

Allows you to automatically adapt the tube
current according to the patient’s body
habitus to achieve the specified image
quality at the lowest possible dose.

30. To add a secondary reconstruction for the protocol, click the New
button in the Recons section.

The New Reconstruction popup appears.

Figure 159: New Reconstruction popup

31. Complete the following in the New Reconstruction popup:

Enter a description in the Description text box to identify the new
reconstruction.

Click the Slice Thickness/Spacing to select a slice thickness and
spacing.

Click the Sharpness dropdown to select a sharpness from the list.
Enter the window width in the Window Width text box.

Enter the window center in the Window Center text box.

If needed, enter the FOV width in the FOV Width text box.

If needed, enter the FOV top left x location in the FOV Top Left X
text box.

If needed, enter the FOV top left y location in the FOV Top Left Y
text box.
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32. Perform one of the following:

e Click the Save button to save the reconstruction protocol to the
list.
o The dialog box closes, and your changes are added to the

Recons area.

e Click the Reset button to reset the fields to their original data.

e Click the Cancel button to remove your changes and return to the
previous dialog box.

33. Click the Save button on the New Series dialog box.

Figure 160: Edit Series dialog box

34. Repeat the steps 6 thru 33 to add additional scans to the protocol.

35. When all required series have been created click the Save button on
the New Protocol dialog box.

Figure 161: Save New Protocol
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36. Click the Close button to exit.

Figure 162: Close Button

Using Build From to create a new protocol

The Build From button is used in Protocol Manager when you want to
create a new protocol from an existing protocol.

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog appears.

2. Click one of the following:

Adult To create and/or scan with adult scan protocols,
which are stored by anatomical location.

To create and/or scan with pediatric scan protocols,
which are stored by anatomical location.

The Trauma orb can be used to store protocols
commonly used for emergency scans.

By selecting either an Adult or Pediatric patient, the
corresponding list of saved protocols becomes
available.

Pediatric

Trauma

Note Protocol parameters are customized to your
requirements in conjunction with local and nationally
recognized published guidelines. These protocols
must be approved by your facility physicist before the
system’s acceptance.
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WARNING Any modification to an existing protocol, or any new protocol created,
should be reviewed, and approved by a radiologist and/or residing
medical physicist. Failing to do so could cause a patient to receive an
excessive and/or unnecessary dose of ionizing radiation.

Resources for radiation protection of pediatric patients appear below
and are for referring physicians with a focus on radiation exposure:

American Academy of Pediatrics (AAP), https://www.aap.org:
Search for radiation risk to children from Computed
Tomography

Federal Drug Administration (FDA),
https://www.fda.gov/search

Search for guidelines for pediatricians regarding medical
radiation safety

American College of Radiology (ACR):
https://www.acr.org/Clinical-Resources/Clinical-Tools-and-
Reference/Appropriateness-Criteria

Image Gently® and CT scans

https://www.imagegently.org/Procedures/Computed-
Tomography

Image Gently/FDA Digital Radiography Safety Checklist:
https://www.imagegently.org/Portals/6/Procedures/Attachme
nt%20D.CR.DR%20%20checklist.pdf

3. Click the colored orb corresponding to the appropriate body part.

Figure 163: Anatomical orbs

4. Click the protocol you will Build From in the Protocol list. The Build
From button will become active.
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Figure 164: Build from protocol selected

5. Click the Build From button.

Figure 165: Build From button

6. The New Protocol dialog box appears.
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Figure 166: New Protocol dialog box

7. Modify the protocol parameters to meet your needs. Click the
Update button on the Edit Series dialog box to save your changes.

See “Creating a new protocol” on page 186 to learn how the fields
and options perform to make informed choices on what to change.

Note Be sure to assign the Build From protocol a new
Protocol Description before you make your additional
changes.

8. When all required series have been modified click the Save button on
the New Protocol dialog box.

Figure 167: Build from save

9. Click the Close button to exit.
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Figure 168: Build from close

Editing an Existing Protocol

The Edit button is used in Protocol Manager when you want to modify
the parameters of an existing protocol.

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog appears.

2. Click one of the following:

Adult To edit adult scan protocols, which are stored by
anatomical location.

To edit pediatric scan protocols, which are stored by
anatomical location.

Pediatric

Trauma To edit protocols store in the Trauma orb.

3. Click the colored orb corresponding to the appropriate body part.
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Figure 169: Edit protocol orbs

4. Click the protocol you wish to Edit in the Protocol list. The Edit button
will become active.

Figure 170: Edit protocol selected

5. Click the Edit button.

Figure 171: Edit button
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6. The Edit Protocol dialog box appears.

Figure 172: Edit Protocol dialog box

7. Modify the protocol parameters to meet your needs. Click the
Update button on the Edit Series dialog box to save your changes.

Figure 173: Edit series update button

II’

See “Creating a new protocol” on page 186 to learn how the fields
and options perform to make informed choices on what to change.

Note Be sure to assign the Build From protocol a new
Protocol Description before you make your additional
changes.
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8. When all required series have been modified click the Update button
on the Edit Protocol dialog box.

Figure 174: Edit protocol update button

9. Click the Close button to exit.

Figure 175: Edit protocol close button

Copying and pasting protocols

To copy and paste protocols from one body part orb to another, including
the Trauma orb.

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog appears.

Chapter 6 Protocol Manager Page 202 of 412



BodyTom 64 User Manual

Revision 04

2. Click one of the following:

Adult

To copy and paste adult scan protocols, which are stored
by anatomical location.

Pediatric

To copy and paste pediatric scan protocols, which are
stored by anatomical location.

Trauma

To copy and paste protocols stored in the Trauma orb.

Figure 176: Protocol Manager for Adult and Pediatric

3. Click the colored orb corresponding to the appropriate body part.

Figure 177: Anatomical orbs, in this case the chest orb

4. Review the protocol you would like to copy.

5. Highlight the protocol, right-click to see the floating menu, and click

Copy.
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Figure 178: Copy right-click floating menu

6. Go to body part orb you want to paste the protocol to, which can
include the Trauma orb.
7. Right-click to see the floating menu and click Paste.

Figure 179: Paste right click floating menu

8. Click Close button to exit.
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Deleting a protocol

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog box appears.

2. Click one of the following:

Adult To delete adult scan protocols, which are stored by
anatomical location.
I To delete pediatric scan protocols, which are stored
Pediatric ] )
by anatomical location.
To delete protocols that are stored in the Trauma
Trauma orb

3. Click the colored orb corresponding to the appropriate body part.
Select the protocol from list to be deleted.

Figure 180: Protocol Manager with a protocol selected

4. Click the Delete button.
The Delete Confirmation popup appears.

Figure 181: Delete Confirmation popup message — Yes or No to delete
selection
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5. Perform one of the following in the Delete Confirmation popup:
e Click the Yes button to delete the selected protocol.
e Click the No button to return to the Protocol Manager dialog box.
The Delete Confirmation dialog box disappears, and the Protocol
Manager dialog box appears.

6. Click the Close button to exit.

Adding breathing instructions to your protocol

Default audio files are installed on the workstation. Audio files can be
attached to protocols and sent to the scanner. Each audio file has an
indicator whether it was sent to the scanner.

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog box appears.

2. Click one of the following:

Adult

To add breathing instructions to adult scan protocols, which
are stored by anatomical location.

Pediatric

To add breathing instructions to pediatric scan protocols,
which are stored by anatomical location.

Trauma

To add breathing instructions to protocols stored in the
Trauma orb.

3. Click the colored orb corresponding to the appropriate body part.

4. Click the protocol you would like to add Breathing Instructions to.

5. Click the Edit button.
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Figure 182: Edit button

The Edit Protocol dialog box appears.

Figure 183: Edit Protocol dialog box

6. Select the Protocol’s Series you want to add breathing instructions
to.
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The Edit button is enabled.

Figure 184: Add breathing edit button

7. Click the Edit button.

The Edit Series dialog box appears.

Figure 185: Edit Series dialog box

8. Click the Use Breathe Indicator Audio option and click the Choose

button.

Chapter 6 Protocol Manager

Page 208 of 412



BodyTom 64 User Manual Revision 04

Figure 186: Use Breathe Indicator Audio option

The Breathe Indicator Audio Files popup appears.

Figure 187: Breathe Indicator Audio Files popup

9. Select an audio file to use for the Breathe instruction.
The Breathe and Hold buttons are activated.

10. Click the Breathe button to place the file with Breathe files.
11. Select an audio file to use for the Hold instruction.
12. Click the Hold button to place the file with Hold files.

13. Click the Apply button to keep the files you selected to use with
protocols.

14. Click the Close button to exit.
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Importing protocols from a storage device

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog box appears.

2. Click the Import button

Figure 188: Import button

3. The Select File popup appears.

Figure 189: Select File popup

4. Double click the Drive Letter that contains the protocols you want to
import.
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Figure 190: Select file

5. Click the file in the Select File popup.

Figure 191: Import button active in Select File when file(s) selected

6. Click the Import button.
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Figure 192: Protocols Imported popup message — Protocols imported
7. The Protocols Imported popup appears.
8. Click the OK button.
9. Check that the required files have been imported.

10. Click the Close button to exit.

Exporting protocols to a storage device

1. Click Tools >Protocol Manager from the main menu.
The Protocol Manager dialog box appears.

2. Click the Export button.

Figure 193: Export button
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3. The Select Directory dialog box appears.

Figure 194: Select Directory popup
4. If more than one Media Device is available, select the device to use.
5. Click the Select button.

6. The Protocols Exported popup appears.

Figure 195: Protocols Exported popup message — Protocols exported
7. Click the Ok button.
8. Check that the exported files are exported.

9. Click the Close button to exit.

Changing the order of protocols in the list

1. Click Tools >Protocol Manager from the main menu.

Chapter 6 Protocol Manager Page 213 of 412



BodyTom 64 User Manual

Revision 04

The Protocol Manager dialog box appears.

2. Click one of the following:

Adult

To change the order of adult scan protocols, which are
stored by anatomical location.

Pediatric

To change the order of pediatric scan protocols, which
are stored by anatomical location.

Trauma

To change the order of protocols stored in the Trauma
orb.

3. Click the colored orb corresponding to the appropriate body part.

4. Click the protocol to move up or down the list.

5. Click the Up arrow to move the protocol up the list; click the Down
arrow to move the protocol down the list.

Figure 196: Changing protocol order with Up and Down (arrow) buttons

6. When you are finished ordering your protocols, click the Save button
to save the new ordered list.
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Figure 197: Protocol Save button

7. Click the Close button to exit.
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Chapter 7 Daily Calibration and Quality
Assurance

In this chapter, you will learn how to perform a daily air calibration and
use the Quality Assurance (QA) tool that verifies the system is working as
specified.

Keep in mind that before using the BodyTom 64 system, you must
conduct a Quality Assurance (QA) test to verify the system is working as
specified. Performing a daily (air) calibration

Note

NeurolLogica recommends that an air calibration is
performed every 6-8 hours. If the air freshness falls
below 50%, or the scanner is moved to an area with a
dramatic change in humidity or temperature, perform
another air calibration to ensure optimum image
quality during patient scanning.

If room-temperature fluctuations have occurred, you
may need to perform more than one air calibration. In
addition, scanners can drift out of alignment; make
sure you perform a QA Test with the test phantom
before scanning a patient.

Note

It is recommended that the scanner is on for at least
60-90 minutes prior to performing the air calibration.

It is recommended practice that the scanner is plugged
in and turned on even when it is not in use.

1. Make sure that nothing is in the bore before starting the daily air
calibration.

2. Click Tools > Perform Daily Cal from the main menu.
The Perform Daily Cal popup appears.
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Figure 198: Perform Daily Cal popup

Colors identify previous air calibrations outcomes:

Indicates the calibration was
Green

successful

Indicates the calibration is soon
Yellow .

to expire

Indicates the calibration has
Orange .

expired
Red Indicates the calibration failed.

3. Select one of the following options:

o Click Select All to perform all calibration steps.

e Click Clear All and individually select the calibration step(s) to

perform.

4. Click the Start button.
The Perform Daily Cal popup appears, and the timer counts down.
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Figure 199: Perform Daily Cal popup with count down

A warmup period begins, and the countdown begins; when
completed the daily calibration will perform the calibration(s) you
selected.

Note To stop the calibration, click the Cancel button to
end the daily (air) calibration(s).

When the calibrations are completed the Daily Calibration Summary
will display showing the status of the steps performed.

Figure 200: Perform Daily Cal summary popup
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The following are the status indicators:

G Identifies the calibration completed
reen

successfully.
Yellow Identifies the calibration is in progress.
Red Identifies the air calibration failed.

5. Click the Close button to exit the Perform Daily Cal popup.
The Daily Cal icon will change to green when it reaches a 100% air
freshness.

Figure 201: Air freshness icon changes as the air quality drops from green to
yellow to red

The QA phantom overview

The QA phantom is a device that measures parameters that characterize
image quality; these parameters are as follows:

o Uniformity

¢ Noise

e High-contrast resolution
e Slice width

o Low-contrast resolution
« Sensitometry (contrast scale)

Figure 202: QA phantom

The QA phantom is a 20cm diameter disk consisting of a substrate made
of poly methyl methacrylate (PMMA) containing specific inserts. The
uniform area of the disk is used to measure uniformity and noise. Four
other parameters are measured by the inserts in the substrate.

The QA phantom goes onto the phantom holder when performing a QA.
See “Storing the QA phantom” on page 349.
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Figure 203: Phantom holder

The Axial resolution wire, also called the Modulation Transfer Function
(MTF) wire, is intended for measuring resolution in the Axial plane.
Resolution is defined as the ability to distinguish small objects. It is
expressed in line pairs per millimeter.

The slice width wires are the two inclined wires. They are intended to
determine scanner resolution along the Z axis, that is, in the direction
that is perpendicular to the Axial plane. Resolution along the Z axis is
expressed in terms of slice width in millimeters. Although one wire is
sufficient to measure the Z axis resolution if its position is accurately
known, a second wire is included to confirm the alignment. If the
alignment was incorrect, the results of the slice width test would not be
accurate.

The low-contrast insert is a compound insert. It is made of two half
cylinders of different materials with a known contrast difference
between them. The low-contrast insert is intended to measure the
contrast resolution of the scanner. The contrast resolution is the ability
to measure slight differences in x-ray attenuation.

The sensitometry inserts are an air bore and cylinder made of different
materials. They are intended to measure the contrast scaling of the
scanner.

The QA scan protocols appear in the following table.

Table 29: Scan protocols used by the QA

Scan voltage 120 kv
Scan current 200 mA
mAs 400 mAs
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Scan time 2 second
Kernel Pos. Fossa/Vessel
Slice thickness 9.6mm

Starting Quality Assurance

To ensure the system is at its optimum, factory-specification level, the
workstation provides QA tools to verify the system’s state and to
perform image-quality verification. To maintain consistent image quality
over the system's lifetime, you should establish and maintain a regular
Quality Assurance (QA) program. QA results are stored in the Patient
Browser. Contact your local service representative to delete QA results.

The QA protocol is shipped with the system and appears when you click
Quality Assurance from the main menu. You cannot customize or modify
the QA protocol.

Note The QA test should be conducted per hospital
requirements.

Before you begin this section, be sure to run a fresh Daily Calibration on
the system. See “Performing a daily (air) calibration” on page 216.

Also, before you start the QA protocol, make sure the QA phantom is
available and ready to install on the phantom holder. The phantom serial
number label should be facing the front of the scanner and be positioned
at the top — as shown in the figure below. The red insert should be on
the bottom right when facing the scanner. The position of the phantom
will greatly affect the QA results.

Figure 204: Phantom on the phantom holder
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1. Move the QA stand to the front of the gantry, so the prongs point
into the bore as shown.

Figure 205: Place QA phantom

2. Ensure the QA stand is centered in the bore using the sagittal laser as
shown. If needed, adjust the prongs side to side.

Figure 206: Proper QA stand positioning
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3. Place the QA phantom on the prongs as shown.

1. The serial number label should be
facing the front of the gantry and at
the top.

2. Thered insert should be on the
bottom right.

3. The phantom should be in the middle
of the carbon fiber post/prongs.

4. The two wires in the phantom should
be vertically straight.

Figure 207: QA phantom positioning

4. On the pendant, press the Laser button and align the internal laser to
the etched line in the center of the phantom.

Figure 208: Laser button
See the laser precautions in “Laser safety” on page 56.

5. Click Tools > Quality Assurance from the workstation main menu.

6. The following Quality Assurance popup appears.
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Figure 209: Quality Assurance popup

7. Click the Prepare button to begin the QA procedure.

8. The System Ready to Scan popup appears.

Figure 210: System Ready to Scan popup message — System is ready to
begin

9. Go to the scanner and press the START button.
The system will scan the phantom and display the QA Results image.

Figure 211: QA results of QA image
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Note Items in green are passed results. Items in red are
failed results. Often positional issues cause the failure;
reposition your phantom and perform another scan. If you
try multiple times and failures persist, call your service
representative or Technical Support.

10. Click the Close button on the QA Results popup when finished
reviewing. The image of the phantom appears.

Figure 212: Phantom image

11. Click the Finalize button on the workstation to exit the protocol.

12. The QA appears in the Patient Browser; however, it is locked.

Figure 213: Locked QA results shown in Patient Browser

Note See your service representative to remove locked QA
results.

Ensuring good image quality

To produce consistent image quality over the system's lifetime, you
should establish and maintain a regular Quality Assurance (QA) program.
QA results are stored in the Patient Browser. Contact your local service
representative to delete QA results.

1. Compare the results to previous or optimum values and repeat these
tests on a regular basis to detect changes in image quality values
before any problem becomes visible.
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Note If you notice degradation in image quality or a change
in QA values, schedule a site visit and let your service
representative or imaging physicist run more detailed
tests.

Early intervention could prevent a major breakdown.

QA begins with baseline performance data that is acquired during system
installation or after the repair or replacement of an x-ray generator-
assembly, collimator, detector, Data Acquisition System (DAS) or main
power circuitry.

2. Compare subsequent QA results against the baseline.
Baseline images can be saved for a visual comparison with QA checks,
but measurement values provide a more objective way to monitor
quality.

Figure 214: Results of QA image after the QA test

Identifying filtration accuracy

Values of attenuation equivalent, half-value layer, and quality-equivalent
filtration are expressed as a thickness of aluminum at the minimum of
99.9% purity. Attenuation of items in the x-ray beam should not be
higher than 2mm of equivalent Aluminum (Al).

CAUTION Do not put anything in the x-ray beam that exceeds 2mm of
equivalent AL as it may produce adverse effects to the image.
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Using Axial plane to determine image resolution

The method to determine resolution in the Axial plane is to measure the
modulation-transfer function of the scanner. A planar section of the MTF
wire provides a point, called an impulse. The impulse is blurred by the
imaging system, and the measurement of the blur quantifies the
resolution. The blur is quantified by the MTF amplitude, which provides
a measure of gain for a given object size in line pairs per centimeter

(Ip/cm).

The MTF is measured in two directions, called radial and tangential
directions. The radial direction is along the line that joins the wire to the
scanner isocenter. The tangential direction is perpendicular to the radial
direction. The MTF along each direction produces a curve. The points at
which each curve’s amplitude is 50% and 10% of its amplitude at zero
Ip/cm are reported.

The expected results are given below.

Table 30: Modulation Transfer Function (MTF) direction

Direction ‘ 50% 10%
Radial (Ip/cm) 4.7 7.2
Tangential (Ip/cm) 4.7 7.2

Table 31: QA results

‘ Low limit High limit
Slice width (mm) 9 11
Noise (HU) 2.5 3.5
Low-contrast resolution (mm) | 4 6
Uniformity (HU) 0 5
CT of air (HU) -1030 -950
CT of Teflon (HU) 924 1004
CT of acrylic (HU) 75 155

Measuring slice width

The method for determining the slice width for the Axial mode QA is to
take an image of the inclined wire. The scanned section of the inclined
wire is a line segment. The scanner blurs a scanned object in the Axial
plane as well as in the direction perpendicular to it. The image of the
inclined wire includes both the Axial plane blurring (MTF) of the scanner
as well as the blurring in the z-direction. The slice width is determined by
removing the component of in-plane blurring, by measuring the length of
the wire segment and by using the known angle of wire inclination. The
range is noted in QA results; see Table 31 on page 227.
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Measuring noise

Noise is measured as the standard deviation of pixel values in a 1cm
Region of Interest (ROI) at the center of the phantom. The ROI selection
is automatic. The CTDl1go center dose in a standard CTDI head phantom
is 145 mGy for this scanning technique. The BodyTom 64 noise
measurement is performed on a 10mm slice.

Measuring low contrast

Low-contrast resolution is measured as the difference between the
mean CT values in each half of the low-contrast insert. An ROl is
automatically selected around the low-contrast phantom and is
automatically segmented into halves. Within each ROI, the mean pixel
value is computed. The two mean values are subtracted.

The expected difference in the mean values is given in the electronic
report. The low contrast should be: 5.0 £1.0 HU.

Finding uniformity

A ROl is automatically selected in each of five locations in the phantom.
One ROl is at the center. Four outer ROIs are 60 to 70mm from the
center of the phantom and spaced 90 degrees apart. A mean value is
calculated in each ROIl. The maximum difference between the means is
calculated. The maximum allowable difference between the means is 3
HU.

Identifying CT contrast scale

Contrast scale represents the attenuation scaling of the scanner. The
mean CT numbers of each of the sensitometry objects is calculated and
reported.

Identifying load factors

Table 32: Load factors

Protocol Time
description (seconds)
Axial 80-140 30-300 1
Helical 80-140 30-300 1 per rotation

CAUTION When conducting multiple or repeat scans, ensure that the
total exposure does not exceed 1Gy CTDI.
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Note The highest x-ray tube current is 300mA and the
highest x-ray tube voltage selection at this current is
140kV.

The nominal x-ray output power is 42kW when
operating at an x-ray tube voltage of 140kV and x-ray
current of 300mA for 4 seconds.

The x-ray tube voltage/current tolerance is +10%.

The BodyTom 64 dose information (21 CFR 1020.33 ¢)

Dose is measured using standard CTDI head and body phantoms. Surface
and center CTDIs were both measured. Weighted CTDI is computed
using surface and center CTDlIs:

2 1
CTDL, = (3 CTDlgypy + 5 CTDlgn)

Measured values are normalized to scan current, for example, CTDI
values are in mGy/100 mAs. For any given scan protocol CTDIy, can be
estimated using following equation and data from Table 33 and Table 34
on page 230:

m
CTDI,,(kV,m,S) = (m : s) CTDI,, (kV,100mAs)mGy

CTDlw can also be computed using data from Table 35 and Table 36 on
page 230, and the following equation:

m

CTDL, (kV,m,S) = (W (kV) - 005

§) CTDI,, (1204, )mGy
Where W is the KV relative dose ratio with respect to 120 kV. m is the
x-ray tube current in mA and S is the scanning time in seconds. If scan kV

matches measured scan voltage, then W is equal to 1.0. For Helical
scans, CTDI,,, is calculated as follows:

_crDI,

CTDI =__ W
vol ~ Pitch

For Axial scans, CTDI,,, is calculated as follows:

CTDI,

CTDI,.; =
vel = Sean Increment
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Body CTDIw phantom

CTDIw using CTDI body phantom is listed in the following table. Data was
measured using the 64 rows collimation with the phantom placed on the
phantom holder. Dose measurements were taken using raw data

acquisition in Service mode.

Note Performing scans in different Acquisition modes can
cause slight variations in measured dose.

Table 33: Body CTDIy (mGy/100mAs)

140 kv 120 kV 100 kV 80 kV

CTDl100 Center (C) 8.23 5.51 3.25 1.53
CTDl100 Surface (S) 16.29 11.58 7.48 4.10
CTDlw 13.77 9.56 6.02 3.25

Head CTDIw phantom

Weighted average Computed Tomography Dose Index (CTDIw) using the
CTDI head phantom is listed in the following table. Data was measured

using the 16 rows collimation. Dose measurements were taken using raw
data acquisition in Service mode using phantom holder.

Table 34: Head CTDI,, (mGy/100mAs)

. 140kv  120kv 100 kV = 80 kV

CTDl100 Center (C) 36.83 25.55 15.76 8.03
CTDl100 Surface (S) 41.26 28.81 18.19 9.90
CTDly, 39.68 27.50 17.38 9.28

Normalized CTDI tables are listed below. CTDI is normalized with respect
to a typical 120kV scan protocol:

Table 35: Normalized CTDI of body phantom

‘ 140 kv 120 kV 100 kV 80 kV

CTDl100 Center (C) 1.494 1.000 0.589 0.277
CTDl100 Surface (S) 1.406 1.000 0.645 0.354
CTDlw 1.440 1.000 0.630 0.340
Table 36: Normalized head CTDI

| 140kv  120kV 100 kV 80 kV

CTDl100 Center (C) 1.442 1.000 0.617 0.314
CTDl10o Surface (S) 1.432 1.000 0.631 0.344
CTDlw 1.443 1.000 0.632 0.337
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The BodyTom 64 dose in air

Dose measurements were taken using raw data acquisition in Service

mode.
Table 37: CTDI air (mGy/100mAs)
. 140kv | 120kv 100 kv 80 kV

64 rows 35.4 25.8 17.3 10.2
16 rows 54.2 38.6 25.7 15

Dose is measured using a typical head protocol and a typical abdomen
protocol. Dose in air was also measured for repeatability over 10 scans.
Average value and standard deviation are noted below:

Table 38: Mean and standard deviation of CTDI air at 120kV

16 rows 64 rows
Mean mGy 38.6 25.7
Standard deviation mGy 0.0232 0.00396

Additional QA measurements

The QA phantom is typically used to monitor the scanner on site;
however, the ACR or AAPM phantoms can be used for measuring the
imaging performance of the scanner.

Note Actual results on installed units can vary 20% due to
machine and test tolerances.

ACR testing procedure

Most sites use the ACR phantom for evaluating the QA parameters of the
scanner. Furthermore, each scanner is evaluated using the ACR phantom
prior to shipping. Due to the special tube filtration some of the limits for
CT values may be different from those set by the ACR committee. Table
39 lists the NL limits for the CT number and linearity of each insert in the
ACR phantom. It also lists the limits set by ACR. The difference in CT
number is mainly due to the difference of the x-ray beam quality due to
the tube filtration and the ACR committee acknowledge this in published

papers?.

2 The ACR committee will often change their limits, as such, the limits listed in Table 39 may have been

changed.
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Table 39: The CT number and linearity of the different inserts in the ACR

phantoms
Insert Material NL Limits ACR Limits
Air -1005 to -970 -1005 to -970
Polyethylene -110to -85 -110to -85
Water -7to7 -7to7
Acrylic 110to 135 110to 130
Bone 1010to 1110 850t0 970

The scan protocols are typically selected by the site physicist or the CT
manager. However, ACR recommends the use of standard head and
abdomen protocols. Neurologica uses the protocols listed in Table 40.

Table 40: The NeurolLogica head and abdomen ACR scan protocols

Protocol Head/Abdomen Abdomen
kVp 120 120
mA 200 250
Time per rotation (seconds) 1 1
Dose (Weighted) 45 to 50 mGy 22 to 25 mGy
Scan FOV 59.5cm 59.5cm
Display FOV (minimum) 25.0cm 25.0cm
Reconstruction sharpness Soft tissue Soft Abdomen
Scan type Axial Helical
Z-axis collimation 9.6 mm 38.7 mm
Table increment (mm) or Table 9.6 mm 30.7 mm/rot
speed (mm/rot)
Slice thickness 4.8 mm 4.8 mm
Scan time (seconds) 1 1
Slice separation 4.8 mm 4.8 x4.8 mm
Number of images per scan 2 N/A

Measuring high-contrast resolution

The high-contrast resolution phantom is a wire placed at the center of a
uniform disk. The wire provides an impulse function in the Axial plane
when it is placed parallel to the scanner-gantry axis-of-rotation. The
high-contrast resolution is measured from the Modulation Transfer
Function (MTF). Typical MTF curves are shown in the following figures.
Variations of 10% may occur in measurements due to phantom
placement error and measurement inaccuracies.
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Figure 215: MTF

Table 41 lists the 50%, 20% and 10% cutoffs of the most commonly used
kernels on the scanner. The cutoffs were measured using the MTF curve
for each kernel like the one displayed in Figure 215.

Table 41: The cutoffs of some of the common reconstruction kernels

Scan Type Kernel MTF50% MTF20% MTF10%
Axial Soft Tissue 3.4038 4,9538 5.7187
Axial Pos. Fossa/Vessel 3.9930 5.7816 6.7455
Axial Sharp 6.6819 8.2549 9.2587
Axial Bone 7.7757 9.6942 10.9681
Axial Sharp Lung 6.1620 8.9318 11.8802
Axial High-Res QA 7.9286 10.5069 12.4050

Helical Bone Head 5.2370 6.5734 7.1577
Helical Soft Tissue-Abd 6.2422 7.2252 7.7846
Helical Soft Tissue-Head 3.0327 4.4322 5.1328
Helical Bone-Abdomen 5.5166 6.8081 7.4292

Noise, uniformity, and mean CT number of water

One of two phantoms may be used in these tests. These are Catphan®
412 or a cylindrical 20cm diameter water cylinder.

The variation in standard deviation may be +10% due to variations
between systems.

Noise is measured as the standard deviation at isocenter. The value is
around 3.5 +4 HU when the imaging protocol is 120 kV, 400 mAs and
standard Post-Fossa kernel. This protocol gives a CTDl1go center dose of
92 mGy.

Noise is measured as the standard deviation of pixel values in a large ROI
at the center of the phantom. Using a slice thickness of 4.8mm the noise
values are listed below.
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Table 42: Uniformity and Mean CT Number using Water Phantom

Description Noise (HU)

(cp300 mm Water phantom)

Body 9.2285HU

Head (cp200mm Water Phantom)

3.42HU

Uniformity and mean CT number

The mean CT number of air is -1000 HU and that of water is 0 HU. The
tolerance of the mean CT number will be £3 HU. For mean CT numbers
measured at different points of the water phantom, the maximum
difference in the means will be less than 4 HUs. An ROl is automatically
selected in each of five locations in the phantom. One ROl is at center.
Four outer ROIs are 60 to 70mm from phantom center and spaced 90
degrees apart. A mean value is calculated in each ROIl. The maximum

difference between means is calculated.

Maximum difference between peripheral ROIls and the center ROl mean
CT values in an image is less or equal to 4 HU. The maximum error in CT

number of water is +3 HU.

Table 43: Uniformity and Mean CT Numbers using Water Phantom

Description Uniformity (HU) Mean CT Number (HU)
Body 1.91 0.32
(cp300 mm Water phantom)
Head (cp200mm Water 1.45 -1.0
Phantom)

Low-contrast resolution

The phantom used for low-contrast resolution measurement is CTP 515

section of the Catphan 600.

The low-contrast resolution is 4mm rod at 0.3% contrast when the
center CTDIy dose is 71 mGy. The imaging protocol is 120 kV, 300 mAs
with 1 rotation, 4.8mm slice thickness, and using the soft tissue filter.

3 For States that required the sites to perform water phantom testing, please contact customer service for

assistance.
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Figure 216: Catphan 515 using 120kV, 300mA, 1 rotation, and 5mm slice

Tube accuracy

Table 44: Tube accuracy

kV Tolerance \
140 5%
120 +5%
100 *5%
80 *5%

Half-value layer

Table 45: Half-value layer

Scan voltage (kV) 100 120 140
Half value \ 6mm 7mm 8mm

Allowable variations

The following are allowable variations:

A 5% variation in dose may occur due to

Dose variations between systems and measurement
differences. The maximum variation is £10%.
The variation in values on the MTF curve may be
High Contrast | +10%. These will occur mainly due to phantom
Resolution placement errors, measurement inaccuracies and
system variations.

The variation in standard deviation may be +10%
due to variations between systems.

Noise
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The maximum difference between ROl means in
Uniformity an image is 4 HU. The maximum error in the CT
number of water is £3 HU.

Dose: Maximum variation is £10%.

Variation in values on the MTF curve may be +10%. These occur mainly
due to phantom placement errors, measurement inaccuracies and
system variations.

Scatter radiation

Reference the following radiation scatter plots identifying proper
distances to protect from radiation exposure. The scatter plots provide
scattered radiation dose in air-kerma, per current-time product in both
standard and Sl units for nominal technique of 120kV (uRad/100mAs and
UGy/100mAs respectively). This information is given so the facility
physicist and/or Radiation Safety Officer (RSO) can use these charts to
calculate exposure with the following formula:

23
scan cw‘r‘e‘nt) (scan voitage)

100 120

Stray radiation (scan current, scan voltage) = stray radiation (100,120) X (

In addition, per IEC 60601-2-44, 3" Edition, “Particular requirements for
the basic safety and essential performance of x-ray equipment for
computed tomography”, scatter plots are provided as shown in Figure
219 on page 238 and Figure 220 on page 239 for the maximum
techniques settings of 140kV and 300mA (standard and Sl units
respectively).

This information is specifically intended for the facility Physicist and/or an
RSO to perform a safety and shielding analysis such as described in NCRP
147, “Structural Shielding Design for Medical X-Ray Imaging Facilities.”

WARNING Exposure to secondary radiation can be harmful, and scanner
usage should only be done under the direct supervision of the
facility’s qualified Radiation Safety Officer (RSO) in
compliance with site, local, mode, provincial, and national
regulations. Only this RSO can perform the calculations
necessary to determine what additional safety precautions
are necessary, such as shielding, personal protections, and so
on.

Note The BodyTom 64 scanners are compatible with IRR1999
and EU Directive 96/29/EURATOM.
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Typical application environment and radiation safety

The BodyTom 64 is an advanced radiation protection mobile CT. There is
an effective x-ray shielding that is equivalent of 0.75mm of lead within
the gantry. The scanner can be used in a mobile environment and/or
within an enclosed environment.

The scatter plot below shows the dose map during a normal scan:

Figure 217: Scatter plot (120kV, 100mA in pRad)

Note In compliance with IEC 60601-2-44:2009, section
203.11, the above figure shows the scatter
radiation measured at the edge of the gantry in the
tomographic plane is =20% of the scatter radiation
measure at the same distance along the axis of
rotation in the horizontal plane.

The black box (located at 0 on the X axis and -2 on
the Y axis) represents an approximate (24 x 24 x
79in. or 60 x 60 x 200cm) zone of occupancy. The
system in Scan mode stands at 78.5in., which meets
the 79in. (200cm) requirement.
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Figure 218: Scatter plot (120kV, 100mA in uGy)

Figure 219: Scatter plot (140kV, 300mA in pRad)
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Figure 220: Scatter plot (140kV, 300mA in uGy)

Note The anatomical body phantom was placed on a scan
table inside the gantry to consider scatter through
patient. Measurements were made using the following
scan protocol: 140kV, 200 mA, and 5 sec. The
following figures show measurement points in vertical
X—Y and perpendicular Y—Z planes, followed by
corresponding tables detailing resulting data.

Figure 221: Scatter measurements (X—Y plane)
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Table 46: Scatter measurements (X—Y plane) (uRad/100 mAs)

Figure 222: Scatter measurements (Y—Z plane)

Table 47: Scatter measurements (Y—Z plane) (uRad/100 mAs)
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Dose profile/Geometric Efficiency

A graphical presentation of the dose profile along a line—Z
perpendicular to the tomographic plane and centered at the isocenter,
determined in free air for one Axial scan, in the center location of the
head-dosimetry phantom, and the center location of the body-dosimetry
phantom —is given in the accompanying documents for each selectable
value of N x T. When more than three different values of N x T are
available, the information is provided for at least the minimum,
maximum and one mid-range value. The dose profile is presented on the
same graph and to the same scale as the corresponding sensitivity
profile required by 203.111.

Dose profile was measured for 64 rows by taking a stationary scan with
the radio-chromic film, centered on top of the detector array. The scan
protocol was as follows: 120 kV, 200 mA, 5 sec. After the scan was taken,
the radio-chromic film was scanned, and the profile extracted. The
following figure shows the dose profile and detector array.

Geometric efficiency was calculated as the ratio of the detector array to
FWHM of dose profile using the following formula:

Nrows * Wy * Mf
Geomgsriciency = FWHM

where N, is the number of detector rows; w,is the width of the
detector in the z-direction; M is the magnification factor; FWHM is the
full width at half maximum of the profile. Table 48 on page 242 lists the
measured geometric efficiencies for the two existing collimations of the
BodyTom 64.

Figure 223: Dose profile for 16 rows
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Figure 224: Dose profile for 64 rows

Table 48: The geometric efficiency of the two different collimations of the

BodyTom 64
Collimation Geometric Efficiency
64 rows collimation 83+5%
16 rows collimation 60 £ 5%
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Chapter 8 Patient Registration

Patient Registration is the first step in the patient scan process.

You can register a patient in the following ways:

o Manually register a patient from the Patient Registration tab.

o Perform a query to acquire already-entered patient data from the
Hospital Information System (HIS) or Radiology Information System
(RIS).

It is assumed that the workstation is connected to the site’s HIS/RIS
system. If you are not connected, you can always manually register a
patient.

Figure 225: Activated Patient Registration tab

Navigating the Patient Registration screen

Make sure the Patient Registration tab is selected.

Notice the buttons at the bottom of the Patient Registration dialog box.
Many of these buttons are active only if you are already connected to the
site’s HIS/RIS or if you clicked the Query button, and the list of patients
populated in the Query Results list. When a patient is selected, the
buttons are active.

Table 49: Patient Registration buttons

Patient

Registration Action
button

Searches the HIS/RIS server for scheduled patients.
The population of patient information could take
several minutes to appear, depending on the
number of patient entries the query retrieves after
clicking the Query button.

Cancels the current query. Entries retrieved prior to
cancellation appear in the Query Results list and
Stored Results if they are moved there.

Registers the selected patient and takes you to the
Acquisition tab to select a protocol to be used for
scanning.
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Patient

Registration Action
button

Shows selected patient details.

Searches queried patient entries for specific
information.

Selects patient(s) from query results and moves
them into the Stored Results list.

Removes patient(s) from the Stored Results list.

Manually enters a new patient and, when
completed, takes you to the Acquisition tab to
select a protocol to be used for scanning.

Registering the patient

The following procedures show you how to register or enter patient
information into the system before scanning a patient. Patients are
registered manually or queried from the Hospital Information
System/Radiology Information System (HIS/RIS). The system can be
configured to add or create specific patient information when the patient
is registered.

Querying patient information

1. If necessary, click the Patient Registration tab on the main screen.

Figure 226: Patient Registration tab
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2. Click the Query button at the bottom of the screen.
The Query Information dialog box appears.

Figure 227: Query Information dialog box

3. Click the HIS/RIS Server dropdown and select the worksite to pull
data from.
The default worksite appears at the top. If there is no list, see your
site administrator to set it up.

4. Double-click any of the named Query Fields you would like to use to
query for patients by entering the value in the Value column.
A popup associated with the Query Field you selected appears. For
example, if you double-click the Scheduled Start Date row, the Edit
Value popup appears. Enter the desired start date. Another
example would be to click the Patient Name value row. Again, the
Edit Value popup appears; however, this time Patient Name text
boxes are provided so you can type the patient’s name to query. You
can click any of the Value rows to fill in data to help query for the
patient you are looking for. You can enter as much or as little
information as needed. If no information is available, leave the value
blank.
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Figure 228: Edit Value popup for name

5. When you are finished filling in query selections, perform one of the

following:

e Click the Update button to query based on the newly entered
data to help narrow down your search.

e Click the Close button to remove any changes and return to the
previous Query Information popup.

6. A list of patients matching your selected criteria variables populates
in the Query Results list on the Patient Registration tab.

Figure 229: Patient Registration Query Results table

7. Select a patient and click the Register button to register the patient

for the exam.
The system enables and opens the Acquisition tab. To perform the
acquisition steps, see “Performing a scan” on page 255.

Storing patients in the Stored Results list

This list is helpful when multiple patients need to be scanned and a
connection to a worksite like HIS/RIS is unavailable at the exam location.
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1. If necessary, go to the Patient Registration tab to query the
patients(s).

2. Perform steps 2 through 5 in “Querying patient information” on page
244,

3. Click the Query button.
Let the criteria you selected populate into the Query Results list area.

4. Select one or more patient entries from the Query Results list.

Select patients in the following ways:

» To select one patient, click anywhere in the patient’s row.

« To select more than one patient at a time, press and hold the Ctrl
key and click patient entries until finished and release the Ctrl
key.

o To select all the patients, press and hold the Shift key, click the
first patient in the list, then click the last patient to highlight all
patients between the first patient selected and the last.

5. Click the Store button.
The patient information you selected appear in the Stored Results list
at the bottom of Patient Registration.

Figure 230: Patient Registration Stored Results table
6. Click the patient you want to select from the Stored Results table.

7. Click the Register button to register the patient for the exam.
The system enables and opens the Acquisition tab. To perform the
acquisition steps, see “Performing a scan” on page 255.

Manually registering a patient

You manually register a patient for examination when the HIS/RIS server
is unavailable, the patient cannot be found, and/or was never entered
into the system.
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1. If necessary, go to the Patient Registration tab.

Figure 231: Patient Registration tab

2. Click the Manual button at the bottom of Patient Registration.
The Exam Information dialog box appears with the Patient tab open.

Figure 232: Exam Information dialog box

3. For Patient Name, double-click the Patient Name value.
The Edit Value dialog box appears with patient name fields.

4. Enter patient name information in the fields provided and click one of
the following buttons:
e Click the Update button to save your entries and close the Edit
Value dialog box.
e Click the Close button to close the Edit Value dialog box without
saving your work.

Notice that the value appears with the last name first, separated by #,
the first name next, separated by #, the middle name (if you supplied
that information), and any other information you entered.

Note The Patient ID is automatically generated by the
system; you can replace this automated identifier with
your patient’s hospital ID number.
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Figure 233: Patient ID field

5. For the Patient Date of Birth, perform the following:

o Double-click the Patient Date of Birth field.

o Enter the patient’s birth date in the Patient Date of Birth field.
Be sure to move the cursor to the far left to ensure two digits are
included for the month and the day; four digits are required for
the year.

o Perform one of the following:

o Click the Update button to save your work and close the Edit
Value dialog box.

o Click the Close button to close the Edit Value dialog box
without saving your work.

6. For the Patient’s Sex, perform the following:
o Double-click the Patient’s Sex field.
o Enter the patient sex in the field by entering the appropriate

letter:
o Ffor Female
o M for Male

o O for Other

e Perform one of the following:
o Click the Update button to save your work and close the Edit
Value dialog box.
o Click the Close button to close the Edit Value dialog box
without saving your work.

7. Perform one of the following:
o Click the Register button to register your patient data.
e Click the Cancel button to exit without entering your data.

When you click the Register button, the system enables and opens
the Acquisition tab.

Chapter 8 Patient Registration Page 249 of 412



BodyTom 64 User Manual Revision 04

Figure 234: Patient data filled in

After your patient is registered, you can view the Patient Exam
Details to ensure your data is correct.
If it is not correct, go to the next step to make the necessary changes.

8. Click the Expand link.
The Exam Information popup appears.

Figure 235: Expand link in context and close up

9. Make your changes in the Exam Information popup.

Figure 236: Exam Information popup
10. Click the Update button to save changes.
Viewing patient information
This procedure lets you view, but not change, the patient information.

1. If necessary, click the Patient Registration tab on the main screen.
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5.

Figure 237: Patient Registration tab
Select a patient from the Query Results list or the Stored Results list.
Click the View button.

Review the patient’s information.
This popup presents static information that you cannot change.

Click the Close button to exit the View Entry Information popup.

Deleting patients from the Stored Result list

Patient information can be manually deleted from the Stored Results list,
you cannot delete patients from the Query Results list.

1.

If necessary, go to the Patient Registration tab.

Figure 238: Patient Registration tab

2. Select one or more patients from the Stored Results list to delete.

Select patients in the following ways:
o To select one patient, click anywhere in the patient’s row.
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« To select more than one patient at a time, press and hold the Ctrl
key and click patient entries until finished and release the Ctrl
key.

« To select all the patients, press and hold the Shift key, click the
first patient in the list, then click the last patient to highlight all
patients between the first patient selected and the last.

3. Click the Delete button.
The patients you selected are removed from Stored Results list.
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Chapter 9 Patient Scanning

After you register the patient, the Acquisition tab automatically opens.
The Acquisition tab lets you check that the selected patient information
is accurate before you perform the scan. The Acquisition tab is also
where you select protocols for the scan before you scan the patient. A
protocol determines the parameters used to acquire patient images.

Figure 239: Active Acquisition tab

After the protocol is selected, you can scan the patient. See
“Performing a scan” on page 255.

The following table provides information on the buttons on the
Acquisition tab and what they are used for. Later you will learn how to
set protocols for the scan.

CAUTION When conducting multiple or repeat scans, make sure the total
exposure does not exceed maximum limit of 1Gy.

Table 50: Acquisition buttons

Acquisition

Action
button

Allows you to modify the protocol selected or
choose a new protocol.

Authorizes the scanner to move to the next step if
applicable.

Begins any post-reconstructions that were defined
during the protocol setup.

Allows you to repeat a portion or all the scan.

Allows you to pause the scan acquisition.

Allows you to pause the entire multi-step protocol
acquisition.

Cancels the current scan within a protocol.

Cancels the entire exam.
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Acquisition

button

Completes the examination.

The following shows what appears in Acquisition:

Figure 240: What appears on Acquisition

Identifying Scan Types

Scan types identify how images are acquired during a scan. The following
Scan types are available.

Axial

The Axial scan type lets you scan in the Transverse plane. Data is
acquired as the x-ray tube rotates around the patient.

Helical

The Helical scan type acquires data continuously as the x-ray tube rotates
around the patient and the scanner translates over the patient in the Z
axis.

Dynamic

The Dynamic scan type acquires data at multiple time points over the
same anatomic location while the scanner remains stationary; x-ray
exposure can be continuous or intermittent.
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Reference

The Reference scan type acquires a single 10mm slice to review
anatomical position or place the Region of Interest (ROI) for Bolus
Tracking scans. Reference scanning can only be used in conjunction with
Helical and Dynamic scanning during a CT Angiography (CTA) or
Perfusion protocol.

Scout

The Scout scan type acquires data continuously as the x-ray tube remains
stationary at a designated angle and the scanner translates over the
patient in the Z axis. The resulting 2D projection is used during scan
planning.

Performing a scan

You cannot complete this procedure without a registered patient.

Note If the scan needs to be stopped, perform the
following:

For an immediate or hard stop, press the E-STOP
button. This stops x-ray, centipede movement, and
gantry rotation immediately.

For a controlled stop, press the Cancel Scan button.

Note Be sure the scanner is calibrated for the room you will
scan in. See “Selecting a room for the BodyTom 64 ”
on page 184 and "Performing a daily (air) calibration”
on page 216.

1. From the workstation, go to the Patient Registration tab to assign the
patient to the scan in one of the following ways:
o Query an already existing patient from the HIS/RIS.
« Manually register the patient.
See “Chapter 8 Patient Registration” on page 243.
The Acquisition tab will be activated when the patient is registered.

2. From the Acquisition tab, click the Protocol button to open the Exam
Planner dialog box.

3. Move scanner and align patient as needed.
See “Positioning the scanner before a scan” on page 93.
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4. On the pendant, press the Laser button to turn on the laser and use it
to align the patient to the scanner.
See “Positioning the patient using the laser lights” on page 94.

5. On the workstation screen, click the appropriate option:

Adult To scan with adult scan protocols, which are stored by
anatomical location.
L To scan with pediatric scan protocols, which are stored
Pediatric . .
by anatomical location.
Trauma To scan with protocols stored in the Trauma orb.

Note Protocol parameters are customized to meet your
requirements in conjunction with local and nationally
recognized published guidelines. These protocols
must be approved by your facility physicist before the
system’s acceptance.

Figure 241: Exam Planner for Adult and Pediatric

6. Click the colored orb corresponding to the appropriate body part you
will scan.

Figure 242: Anatomical orbs, with the Chest orb selected

7. Click the appropriate protocol from the list.
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8. Click the Edit button to review the selected protocol.

Figure 243: Protocol selected and Edit button active

The Edit Protocol dialog box appears.

Figure 244: Edit Protocol dialog box

The Protocol Information tab displayed on the left and the Protocol’s
Series boxes displayed on the right show the series that are already
created. The Patient Position appears identical whether it is for an
adult, pediatric, or trauma patient.
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Note You can modify a protocol; however, changes you

make from Acquisition will not be saved permanently.
Permanent changes to protocols can only be made by
in Protocol Manager.

Assuming you have the proper user privileges, you

can modify protocol parameters such as, kV, mA, and
coverage at the time of the scan, but the modifications
will not be saved for future use.

9. To edit an existing protocol, perform the following:

In the Edit Protocol dialog box, go to the Protocol’s Series list and
select the series to modify.

Click the Edit button.

The Edit Series dialog box appears.

Figure 245: Edit Series dialog box

Make desired changes. Select the Update button in the Edit
Series dialog box.

Alternatively, click the Reset button to remove any changes and
return to the previous settings or click the Cancel button to return
to the previous dialog box.

10. Click the Update button on the Edit Protocol dialog box.
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Figure 246: Update button
11. Click the Begin button from the Exam Planner dialog box.

12. When the Is Scanner Properly Positioned? popup appears, click the
Continue button.

Figure 247: Is Scanner Properly Positioned? popup

Note If zero reference is not selected when starting your
scan, the scanner considers the last known zero
reference point to be the origin and start-point for the
next scan. Always make sure to zero reference the
scanner, when you set up a scan.

The system state orb will change color from yellow to green. The
System Ready to Scan popup appears.
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Figure 248: System Ready to Scan

WARNING Do not stand in either the forward or reverse paths of the
scanner during the scan.

Note The scanner’s side panels permit a low radiation
exposure rate of <0.01mR/sec/100mAs — when x-ray is
emitted.

The START button on the scanner control panel turns green when it is
enabled.

Figure 249: Scanner control panel — START button

13. Press the START button on the scanner control panel to acquire your
scan.
The pre-set scan delay countdown begins. The green light turns off
when the START button is pressed.

Figure 250: Countdown popup
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You can press CANCEL on the scanner to end the current scan
operation. If pressed when lit, the system cancels the current
scanning operation. If pressed during scanning, 1 current scan
rotation, or 1 second, completes and then the scan is terminated.
Alternatively, you can press the Cancel Scan button on the screen to
cancel the entire scan or Cancel Exam button to cancel the entire
exam.

Figure 251: Scanner control panel — CANCEL button

Note During the scan, observe the following:

Yellow lights on top of the scanner, and an audible
beep identify that radiation is being emitted.

The patient’s scan results appear; approximately one
image per second.

When scanning begins, the Continue, Repeat, Extend,
Pause Scan, Pause Exam, and Cancel buttons are
enabled.

When you click the CANCEL button, the message “Scan
is terminated” appears on both scanner and
workstation.

14. If applicable, set your parameters and Field Of View (FOV) on your
scouts.

Note FOV can only be adjusted when two scouts are
acquired.
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Figure 252: Scouts and FOV button

Scan coverage can be modified by selecting the drag boxes and
adjusting the lines and can be centered by clicking on the small green
circle and dragging the plan box.

15. Click Continue to proceed with your planned scan.

Figure 253: Continue button

The Pending Scanning Movement popup appears.

Figure 254: Pending Scanner Movement popup message

16. Click the Continue button to scan.
Click the Cancel button to cancel the scan.
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17. The System Ready to Scan popup appears.

Figure 255: System Ready to Scan popup message — System is ready to
begin scan

18. The START button on the scanner control panel turns green when it is

19.

20.

21.

enabled.

Figure 256: Scanner control panel — START button

Press the START button on the scanner control panel to acquire your
scan.

The pre-set scan delay countdown begins. The green light turns off
when the START button is pressed.

If the Perform Reconstructions popup appears, do one of the

following:

e Click the Yes button to perform post reconstructions now.

e Click the No button to pause the reconstructions until a later
time. When ready, click the Start Recons button.

Figure 257: Perform Reconstructions popup message — To perform post
reconstructions

Use the Viewing tools to review the scan.
See “Examining the scanned image with tools” on page 291.
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22. Click the Finalize button when finished.
The dose report if Show Dose Report in System Configuration is
enabled appears. In addition, the examination details are saved.

Note You must press the Finalize button before you can
send the patient’s data to PACS.

Figure 258: Dose report

Repeating an image

The Repeat function can be used to repeat a scan if necessary. The
entire scan be repeated, or after reviewing the images, a new start

position and coverage can be selected if only a portion of the scan needs
to be repeated.

1. While the Acquisition tab remains active, click the Repeat button.
The Protocol Viewer dialog box appears.
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Figure 259: Protocol Viewer dialog box
2. Review the protocol parameters.

3. Click the Repeat button from the Protocol Viewer dialog box.

4. The Repeat Protocol popup appears.

Figure 260: Repeat Protocol popup

Note You can change the start and end position or use what
appears.

5. Click the Repeat button on the Repeat Protocol popup.
Scout lines appear in blue, which indicates the second scan and
modifications of the start and end points — if made.
The scanner will move to the start position.
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6. Press the START button on the scanner’s control panel to begin the
repeat scan.

Scanning with special features

The following features are available for use in protocols.
Using the step-and-shoot option

The Step & Shoot option in the protocol lets the user control the start of
the scan acquisition. This is helpful in the case of an uncooperative or ill
patient where motion is an issue.

1. If necessary, change the Scan Type to Axial.

2. Click the Step & Shoot option in the Edit Series dialog box.

Figure 261: Step & Shoot option in the Edit Series dialog box
3. Click the Update button in the Edit Series dialog box.
4. Click the Update button in the Edit Protocol dialog box.

5. Click the Begin button in the Exam Planner dialog box to begin the
scan.
The system state orb will change color from yellow to green. The
System Ready to Scan popup appears.
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Figure 262: System Ready to Scan popup

6. To continue the scan, go to the scanner and press the Scan button on
the screen.
The first set of images are acquired at this position.
The Step & Shoot popup appears for you to control the next
acquisition.

Figure 263: Step & Shoot popup

7. Click the Shoot button to start the scan.
To cancel the scan, click the Cancel button.

8. Continue for the length of the scan.
9. Click the Finalize button when finished.

Performing a scan with Automatic Exposure Control

Note Depending on system’s configuration, not all functions
may be available to perform this procedure.

Computed Tomography (CT) is responsible for the largest contribution to
the collective effective dose to patients in radiology. The challenge to
radiologists and medical physicists is to establish adequate image quality
with the lowest radiation exposure to the patient.
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Tube current (mA) is one of the key technical scanning parameters for
adjusting radiation dose in CT. To optimize radiation dose in CT, users
can adjust mA either with manually selected values or with the
application of Automatic Exposure Control (AEC). AEC refers to the
automatic adaption of mA based on user specified image quality and
attenuation characteristics of the scanned body region.

Scout scans provide a graph of mA values based on object density and
desired noise level. Axial or Helical scans in the protocol can utilize AEC,
limiting the mA value of each slice to the minimum necessary to achieve
the desired image quality. This ability to modulate the mA throughout
the scan to achieve the desired noise level can reduce patient dose.

When using AEC, it is vitally important that the patient is well-centered in
the gantry. AEC aims to deliver the specified image quality across a range
of patient sizes. The use of AEC may change the planned CTDlyo and DLP
values. It tends to increase CTDlyo for large patients and decrease it for
small patients relative to a reference patient size.

Note: Ensure patient is accurately centered in the gantry.

Do not use AEC when any type of metal is going to be
scanned.

Do not use AEC with a small FOV, that is, tiny neonatal
patients.

An automatic adjustment of the tube’s current cannot
occur when the tube potential is changed.

AEC can only be used with the following Sharpness
options:

Helical Soft Tissue — Head

Helical Soft Tissue — Abdomen

Axial Soft Tissue

Axial Pos. Fossa/Vessel

Axial Sharp

1. Under AEC, click the Enable AEC option.
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Figure 264: Edit Series dialog box with AEC options selected

2. Select the Minimum mA dropdown to set the minimum allowed mA
value to be used for scanning.

3. Select the Maximum mA dropdown to set the maximum allowed mA
value to be used for scanning. The available range is 30 to 300.

4. Select the Noise Level to set the standard deviation of noise value for
the acquired images. The noise range is 1-200.

Note Consult with the site’s physicist for guidance specific
to the department.

5. Click the Update button in the Edit Series dialog box.

6. Click the Update button in the Edit Protocol dialog box.

7. Make sure your patient and scanner are properly positioned.
8. Click the Begin button to begin the scan.

9. Press the START button on the scanner control panel.

10. After the scouts are acquired and the scan region is set, click the AEC
tab.

11. Click the Toggle Graph button to view the graph on the scout.
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Figure 265: Toggle Graph button

The graphs will now appear on the scout(s). Review the mA
modulation to ensure it meets your clinical needs.

Figure 266: Graphs on the scout(s)

Figure 267: AEC modulation graph

12. To return to the scout parameter view, click the Toggle Graph button,
again.

13. If changes to the mA or Noise levels are required, you can modify the
Minimum, and Maximum mA and noise as needed on the image.

Figure 268: Minimum mA and maximum mA; noise level

14. When the desired level is achieved according to your department
policy, click the Continue button to start the scan.
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15. Press the START button from the scanner.

Note While reviewing the scan you will see mA modulation
as per your graphs.

16. Click the Finalize button.

Performing a CT angiography scan with Bolus Tracking

CT angiography is a technique that uses contrast to visualize arterial and
venous vessels throughout the body. This ranges from arteries serving
the brain to those bringing blood to the lungs, kidneys, arms, and legs.

Table 51: Bolus tracking parameters and tools

Option ‘ Description

The amount of time allowed to monitor the bolus.

Begins the scan after the specified bolus scan time
if no bolus is detected.

Stops the scan after the specified bolus scan time
if no contrast is detected.

A small amount of contrast is injected, and a
timing graph is displayed after specified bolus
scan time.

Hounsfield Unit detection at the area being
monitored — ROL.

When performing the test bolus, click the Use
Calculated option to use the bolus timing
calculated from the test bolus scan.

Allows you to select a manual timing of bolus
after the test bolus has calculated a timing.

1. Perform steps 1 through 8 in “Performing a scan” on page 255.

2. Click the Bolus Tracking option and set parameters, such as Auto-
Start, Auto-Stop, Bolus Scan Time, and Threshold.
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Figure 269: Bolus Tracking option
3. Click the Update button in the Edit Series dialog box.
4. Click the Update button in the Edit Protocol dialog box.
5. Click the Begin button to acquire the scout(s).
6. Acquire the scout(s).

7. To move the scout or reference line go to the Viewing tools and
select Active Scan Region.

Figure 270: Active Scan Region — Bolus Reference or Helical CTA
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Note If the protocol contains one or more scouts, the
system places the scan region for each series on the
scout based on start and end positions that were
entered for each series in the protocol. The Active
Scan Region dropdown populates the data with the ID
that corresponds to each region. You can adjust the
scan region prior to continuing the exam, as described
below.

8. On the scout, use the Blue lines to plan the helical scan.

Figure 271: Scout line (blue) and Reference line (green)

Note The distance between the Reference and Bolus
Tracking scans cannot exceed 100mm.
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10.

11.

12.

13.

14.

15.

16.

Position the green Reference line at the desired anatomical location.

Click the Continue button.
The scanner will move to the reference line noted on the scout.

Go to the scanner and press the START button on the scanner control
panel.

Click the ROI tool and draw the ROl on the Reference image.

Figure 272: Bolus ROI tool

Figure 273: ROl on the Reference scan
Click Continue.

Load the injector and set your desired flow and rate and arm the
injector.

When the scanner is ready, press START on the scanner and manually
start the injector at the same time.

The Helical scan will trigger when the threshold value set for the ROI
is exceeded.
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Figure 274: Scan triggers when bolus enters reference point/ROI

17. Review the completed scan.

Figure 275: Scan at peak enhancement

18. Press the Finalize button when complete.
Performing Test Bolus

Test Bolus evaluates the timing of the injected contrast.

A small amount of contrast is injected, and a timing graph is displayed
after the specified bolus scan time. When the contrast is detected, the
system stops scanning and a report on the recommended delay-time for
CTA protocols appear.

1. Perform steps 1 through 8 in “Performing a scan” on page 255.

2. Click the Bolus Tracking option, click the Test Bolus option and set
parameters.
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Figure 276: Test Bolus option
3. Click the Update button in the Edit Series dialog box.
4. Click the Update button in the Edit Protocol dialog box.
5. Click the Begin button to acquire the scout(s).
6. Acquire the scouts(s).

7. To move the scout or reference line go to the Viewing tools and
select Active Scan Region.

Figure 277: Active scan region

8. On the scout, use the blue lines to plan the helical scan.
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Figure 278: Scan planning lines
9. Position the green Reference line at the desired anatomical location.

10. Click the Continue button.
The scanner will move to the reference line noted on the scout.

11. Go to the scanner and press the START button on the scanner control
panel.
The reference image will be scanned and displayed.

12. Click the ROI tool and draw the ROI on the Reference image.

Figure 279: Bolus ROI

Figure 280: ROI on the Reference scan

13. Click Continue button.
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14. Load the injector and set your desired flow and rate and arm the
injector.

15. When the scanner is ready, press START on the scanner and manually
start the injector simultaneously.

16. The Bolus Timing graph appears and shows the calculated, bolus-
tracking time.

Figure 281: Bolus timing graph

17. Select from one of the following:

Use Uses the bolus timing calculated from the Test
Calculated Bolus scan.

Allows you to manually set the delay time prior to
Use Manual Y . y y P

the start of the helical scan.

Begins the scan after the specified bolus scan time
Auto Start . .

if no bolus is detected.

Stops the scan after the specified bolus scan time
Auto Stop

if no contrast is detected.

18. Click the Continue button.
Review completed scan.

19. Press the Finalize button when complete.

Performing a CT Perfusion Scan

CT perfusion (CTP) is a technique used to evaluate cerebral perfusion of
the level of blood flow in the brain, by monitoring the initial phase of
iodinated contrast media through the vasculature of the brain.

1. Perform steps 1 through 8 in “Performing a scan” on page 255.
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2. After selecting CTP protocol, review the Dynamic CTP options
including Scan Time and make your selections.

Figure 282: Edit Series CTP Scan Time
3. Click the Update button in the Edit Series dialog box.
4. Click the Update button in the Edit Protocol dialog box.
5. Click the Begin button to acquire the scout(s).
6. Perform scout and set Dynamic CTP scan location.

7. To move the Dynamic CTP location use the green circle inside the
reference line.

8. Click the Continue button.
The scanner will move to the reference line noted on the scout.

9. Load the injector and set your desired flow rate. When the scanner is
ready, press Start on the scanner and manually start the injector at
the same time.

10. Review completed scan.
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Figure 283: Brain Perfusion Image

11. Select Finalize.

Calculating and creating perfusion maps

1. Select a perfusion patient from Patient Browser and select the series
to view.

2. To open the image, click the View Images button or double-click the
series.
The Viewing tab is enabled, and the CTP tab automatically opens.

Figure 284: CTP tools
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Table 52: CTP Tools

CTP Viewer tools

Perfusion Map

Perfusi
ertusion . Select to place the arterial and

Artery/Vein .

. venous ROIs on the images.
Selection
Calculate CBF, Select to calculate the CT
CBV, MTT Map | Perfusion maps.
Clear Cancels the calculations and

returns to Calculation mode.

Displays the Arterial Venous Flow
graph.

Show
Artery/Vein
Flow Graph
Displays the image that has the
Peak Image highest HU value based on the

arterial ROI placement.

Click the Perfusion Artery/Vein Selection tool.

Place an Arterial ROI.

Place a Venous ROI.

Click the Calculate CBF, CBV, MTT Map tool.

. The Perfusion Maps are calculated and displayed:

Figure 285: Perfusion maps

The calculations produce three maps and the perfusion image:

Perfusion Images

Top, left corner

Cerebral Blood Flow (CBF)

Top, right corner

Cerebral Blood Volume (CBV)

Bottom, left corner

Mean Transit Time (MTT)

Bottom, right corner
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8. Clicking the Artery/Vein Flow Graph displays the following:

Figure 286: Arterial Venous Flow

This graph displays arterial and venous flow rates with respect to
time.

9. Click the Peak Image tool to display the peak image.
The peak image displays the image that has the highest HU value
based on the arterial ROI placement.

10. Click the Clear Perfusion Maps tool to cancel calculations and return
to Calculation mode.

11. Click the Reset button to reset images back to the original setting(s).
You cannot undo this action.

Using the Interventional Package

The Interventional Package is designed to make Interventional
procedures quick and easy for the technologist and physician. When
activated the gantry will spin continuously to make the transition to a
scan as fast as possible.

When enabled, the Interventional Tab will be displayed as seen below.

Figure 287: Interventional Tab

When activated, the Interventional Tab provides a streamlined workflow
specifically for interventional cases.
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Figure 288: Interventional Tab - Patient exam details

The Interventional Tab includes the following options:
Table 53: Interventional Tab options
Option \ Description
Allows a typed in value, when Move is
clicked the scanner goes to that location

Moves the scanner to the Laser location

Toggles the laser lights on or off

Allows protocol parameters for the
Interventional procedure to be modified

Initiates X-Ray when the user is ready

Repeats the last scanned protocol

Allows a selected raw data set to be Post
Reconstructed without leaving the
Interventional workflow

Stops the gantry rotation

Cancels the currently planned scan

Ends the current examination

Allows you to archive the series selected in
the Scan Tree to any archive device
Performs a 38.4mm axial scan at the current
scanner location

Moves the scanner to the last scanned
position and performs a 38.4mm axial scan
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Exits the system from the Instant Repeat
Feature

The tab also includes a Scan Tree, Current Scan, and an updated Dose
Gauge.

Figure 289: Scan Tree, Current Scan, and Updated Dose Gauge

The Scan Tree allows access to acquired scans for quick image loading or

repeat scanning using those parameters.

e When a series in the Scan Tree is selected, the images associated
with it will be displayed, allowing them to be reviewed to ensure the
proper start and end locations as well as the thickness and spacing
are selected for repeat scans.

e Clicking any of the scans in the Scan Tree, then clicking ‘Repeat’,
moves the scanner to the Start location from the selected series and
automatically initiates scanning.

The Current Scan box shows the protocol parameters used for the most
recent active scan.

The Dose Gauge displays the accumulated CTDI and DLP in mGy for the
current procedure and is updated each time a new scan is initiated.

Viewing Tools, Windowing, and Zoom options are available by clicking
the appropriate line below the Dose Gauge.

Figure 290: Viewing Tools, Windowing, and Zoom options

A right click menu on the active image, also allows access to a full array of
viewing and measuring tools.
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Figure 291: Interventional Workflow

Interventional Workflow

Any protocol can be used as an Interventional protocol.
1. Register a patient

2. Click ‘Protocol’

3. Select the desired protocol

4. Ensure the ‘Interventional Scan’ box is selected.

Figure 292: Interventional Workflow - Protocol Information dialogue box

5. Click ‘Begin’ to accept the protocol and perform the scout scan(s).

6. Plan your scan over the region of the procedure and acquire that
scan.

Note Neurologica suggests the use of a Grid positioned on
the patient in the area of the procedure to be
performed.
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7. Once the scan has been acquired the system will automatically move
to the Interventional tab and show the following:

Figure 293: Interventional Workflow - Scan acquired

8. Review the acquired images from the previous scan to determine the
location of the procedure to be performed.

Note To make viewing of the axial images easier, you can
select the ‘Toggle Scouts’ button, which will display only the
axial image on screen.

Figure 294: Toggle Scouts Button

9. Enter the procedure location in the ‘Go To Position’ box, and click

‘Move’.

e This will move the scanner to the selected location and allow the
physician to mark the patient. Make a note of this location as you
will use it to center the scanner over this area for future scans.

e You can use the ‘Laser On/Off” toggle button to enable the laser
light if it is not already on to allow the physician to mark the
patient.
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Figure 295: Go To Position

10. After the physician has marked the procedure location on the patient,
enter a value in the ‘Go To Position’ box and click ‘Move’ to move the
scanner out of the procedure field and allow the physician to prep
the skin and administer local anesthetic. In the example below we
are using a scanner location of 500.

Figure 296: Go To Position for Patient Prep
11. When the physician has completed prepping the patient and is ready

to image the procedure area, enter the location noted in Step 9
above into the ‘Go To Position’ box and click ‘Move’.

Figure 297: Move to procedure location
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12. Wait for scanner to stop at the correct location, then Click ‘Protocol’

Figure 298: Interventional Protocol Parameters

13. Place a check in the ‘Stay in Instant Repeat Mode’
e This will automatically modify the protocol to an Axial scan with a
set 38.4mm coverage.
e You can modify any of the available parameters, like kV, mA,
Sharpness etc., on screen to meet your needs.

Figure 299: Stay in Instant Repeat Mode

14. Once parameters are selected click ‘Begin’
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15. Click the ‘Instant Repeat’ button to initiate the scan set in the
protocol.

Figure 300: Initiate Scans - Interventional protocol

16. When satisfied the anatomy of interest is included in the images, you
can enter a location in the ‘Go To Position’ box and click ‘Move’.
« This moves the scanner out of the way to allow the physician
access to the patient.

Figure 301: Move the Scanner

17. When ready to perform another scan in the original position, click
‘Move/Repeat’
e The scanner will move back to the previously defined start
location and perform additional scans as defined in the protocol.

Figure 302: Repeat Scans - Interventional protocol

18. You can now use the ‘Move” and ‘Move/Repeat’ options to move the
scanner back and forth to allow the physician access to the patient
and perform repeat imaging to confirm needle position in the patient.
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Note If the physician needs to modify the needle location,
you can move the scanner to that new location and click the
‘Instant Repeat’ button. This will acquire one axial rotation
of 38.4mm using the parameters previously set in the
protocol at this new location. This will also be saved as the
new ‘Move/Repeat’ location.

19. If changes to the protocol are necessary, click ‘Exit Instant Repeat’.
20. Click ‘Protocol’

21. Modify the parameters to the desired values, ensure the ‘Stay in
Instant Repeat Mode’ is selected and click ‘Begin’.

22. You must then click ‘Instant Repeat’ to initiate the new scan.

'

23. When the procedure is completed, click the ‘Exit Instant Repeat

Figure 303: Exit Instant Repeat

24. Click ‘Finalize’

Figure 304: Finalize

Note If the scanner has been idle in the ‘Instant Repeat’
mode for five minutes a message will be presented on
the screen stating that ‘Instant Repeat’ will be
disabled in two minutes. Clicking the ‘OK’ button will
prevent the system from disabling ‘Instant Repeat’ for
an additional five minutes, at which time the message
would be presented again.
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Figure 305: Instant Repeat will be disabled

Examining the scanned image with tools

The image tools can only be used when the Acquisition tab is enabled
and an image is displayed, or when images are loaded to the viewer from
the Patient Browser tab.

From the Acquisition tab, you can zoom, pan, modify window width, and
center, and change layout; see the table below to understand the basics
of what each tool looks like and how it performs.

Using tools on the Acquisition tab

The following table describes some of the tools available to you when the
Acquisition tab is active. For a comprehensive list, see Table 57: 2D,
MPR, 3D, and CTP image tools.

Table 54: Image tools

Image tool \ Tool name \ Action \
Resets the tool to the default
Clear Tool .
pointer.
Window Adjusts window width and center

Width/Center | of image.

Zoom Magnifies the image.

Pan Adjusts image on X or Y axis

Chapter 9 Patient Scanning Page 291 of 412



BodyTom 64 User Manual

Revision 04

Image tool \ Tool name \

Toggle Scouts

Action \

Display’s or removes scouts from
Acquisition.

Toggle Layout

Changes the layout to 2x2. Repeat
process to return to 1x1.

Scan Region
Re-Draw

If scout lines and the scan region is
deactivated, allows you to
reactivate.
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Chapter 10  Patient Browser

The Patient Browser lets you view patient information and images
associated with the patient information after the patient’s scan.

Figure 306: Active Patient Browser tab

The following table identifies the buttons found on the Patient Browser.

Table 55: Command buttons

Button Action

Selects the archive destination for selected
information.

Imports exam information from PACS or Media.

Deletes the selected exam information from the
Patient Browser tab.

Reregisters a patient who is already in the system.

Generates a Dose Report and Dose SR for the
selected patient.

Shows patient, study, series, and image
information.

Displays selected patient images in Viewing.

Allows you to compare two series.

Navigating the Patient Browser

The Patient Browser lets you perform tasks on existing series, for
example archiving and previewing the series. This section will introduce
you to Patient Browser and identify the symbols, areas, and buttons you
can use.

The Patient Browser can be broken down into the following sections:
e Exam table
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o Series table

« Selected protocol table

« Patient Browser’s active buttons
e Preview window

Figure 307: Patient Browser sections

Identifying symbols on Patient Browser

Symbols may appear next to series in the exam and/or series tables.
These symbols are more vivid when active; they are identified below as
active symbols.

Locked

Indicates the series is locked and cannot be deleted.

Read/Mark |Indicates the series is marked to be read or read by the

b physician.
PACS

v Indicates the series has been sent to PACS.
Stored Indicates the series has been sent to PACS; the

A archived series appear below the initial table
Media

Indicates the series has been sent to a media device,
for example USB.
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Figure 308: Patient Browser locked, read, PACS and Stored (archived), and
media symbols

Using the vertical and horizontal scroll bars on Patient
Browser

Navigation scroll bars let you move the lists in the Patient Browser
sections up, down, and horizontally to view all available exam
information.

Figure 309: Patient Browser horizontal and vertical scroll bars

Locking a study
1. Click the Patient Browser tab.

2. Select the study to lock.
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3. Right-click the mouse button.

4. Click Lock on the floating menu.

Figure 310: Floating menu - Lock

The Lock symbol appears for any selected series.

Figure 311: A locked series

A series cannot be deleted while in the Lock mode.

5. To unlock right-click and click Unlock.

Note All QA series are locked to prevent deletion. The QA
series can only be unlocked by your field service
representative.

Marking a series to read
1. Click the Patient Browser tab.
2. Select the study to mark.

3. Right-click the mouse button.
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4. Click Mark on the floating menu.

Figure 312: Floating menu - Mark

The Mark symbol appears for any selected series.

5. To unmark any series, right-click Unmark.

Using the preview window

1.

2.

Click a patient in the exam table.
Click a series in the series table.

Click the Preview button to the right of the Series Protocol Table.

Figure 313: Preview Button

The selected series will appear in the Preview window.

Figure 314: The series appears in the preview window
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Archiving patient series

You can archive patients and studies (or series) to PACS, media (USB or
CD), or surgical navigation devices.

Archiving to PACS
1. Click the Patient Browser tab.

2. Select the patient study for PACS in the following way:
« To select one patient and all associated series, click the patient,
and click the Archive button.
« To select specific series for a patient, press and hold the Ctrl key,
then click each individual series from the Series table, and click
the Archive button.

The Archive Destination popup appears.

Figure 315: Archive Destination popup

3. Click the PACS button.
The Archive to Server popup appears.

4. Click the Select Archive Location dropdown and select a site.

Figure 316: Archive To Server popup
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5. Review the Image Range items to make sure all those items you
selected in step 2 are captured.

6. Click the Archive button to begin the archive process.

If enabled the Store/Print Queue dialog box will appear to show the
status of your image transfer. You can also activate the Store/Print
Queue dialog box by clicking Tools > Store/Print Queue from the
main menu.

Figure 317: Store/Print Queue dialog box

7. Watch the status of each series:

e Pending informs you that the series is paused because you clicked
the Pause button.

e Connecting informs you that the series is in process of archiving
to its targeted location.

e Each series will move from the top portion of the popup to the
bottom portion of the Store/Print Queue popup when it has been
processed.

8. While the archiving is in process, you can perform one of the
following from the buttons in the Store Print Queue dialog box.

Table 56: Store and Print Queue buttons

Store and Print

Queue button

When you select one or more series,
temporarily stops the series from being
stored. This is a toggle button with the
Resume button.

When you select one or more series,
deletes either a series to be stored, or a
series that failed to store.
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Store and Print .
Action

Queue button

Stops the archive to USB or a drive.

When you select one of more series, tries
to archive the selections.

When you select one of more series,
displays an explanation of why a series
failed to store.

Closes the Store/Print Queue popup.

9. If the series is not successfully stored to its targeted destination, the
“Store Failed” message appears in the Failure column. This means
the series was not successfully archived.

10. If there are failed archived series; click the Retry button to attempt to
archive the series you selected.

Note Any Storing Failure status appears in the bottom of
the popup to inform you why the failure occurred. If
an archive job fails, it will be sent to the Failed
Store/Print Jobs list.

11. When the archiving is complete, click the Close button to exit the
Store/Print Queue.

You can also click the Close button, and the archiving process will
continue as you do other tasks.

Archiving to Media
1. Click the Patient Browser tab.

2. Select the patient study to archive following way:
e To select one patient and all associated series, click the patient
and click the Archive button.
» To select specific series for a patient, press and hold the Ctrl key,
then click each individual series from the Series table, and click
the Archive button.

The Archive Destination popup appears.
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Figure 318: Archive Destination popup

3. If you are archiving a USB device, insert the USB drive into the USB
port.

4. Click the Media button.
The Archive to Media popup appears.

Figure 319: Archive to Media popup
5. Click the targeted drive and path destination.

6. The Archive button is active.
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Figure 320: Archive Button active

7. Click the appropriate check boxes for your archive process:
Makes the patient’s information
anonymous for HIPAA standards.
Makes institutional information
anonymous for HIPAA standards.

Anonymous Patient

Anonymous Institution

Include CD Viewer
(requires CD viewer
software installed)

Includes a CD viewer application to
view images from the media.

Export as JPEGS Exports image files in .JPG format.
Includes the demographic
Show Demographics information in archive if you clicked

the Export as JPEGS check box.

8. Click the Archive button to begin the archive process.
e The Cancel button is active after clicking the Archive button; click
the Cancel button to stop the archive.

9. The Archive to Media dialog will update the status when archiving is
complete.
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Figure 321: Archiving complete

e Click the Refresh button to remove any messages that appear
in the Message box.

e Click the Minimize button to continue working in other areas
while the archiving process runs.
o Adisk appears at the bottom; click it to maximize the

Archive to Media popup.

e Click the Close button to exit the Archive to Media popup

after the archive process is complete.

Archiving to Navigation

1.

2.

Click the Patient Browser tab.
Select the patient study or series.
Click the Archive button.

Click the Navigation button.

Click the Select Archive Location dropdown and select the location.
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Figure 322: Archive to Server popup

6. Under Image Range, select the image(s) you want to send to
navigation.
To return to the default selections, click the Reset button.

7. Perform one of the following:
e Click the Archive button to send the image to Navigation.
e Click the Cancel button to return to Patient Browser.

Import

Import allows you to add patient images to the Patient Browser.
Importing from PACS

1. Click the Patient Browser tab.

2. Click the Import button to import data.
The Import Location popup appears.

Figure 323: Import Location popup

3. Click the PACS button.
The Import from PACS dialog box appears.
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Figure 324: Import from PACS dialog box

4. Click the Query button.
The Query Information dialog box appears.

Figure 325: PACS Query Information dialog box

5. Perform the following:
o Select a HIS/RIS server from the dropdown.
o Set the values to search in your query.
e Click one of the following buttons:
o Click Query to save the search results.
o Click Reset to clear the query information.
o Click Cancel to exit the Query Information popup.

6. From the Queried results, select a patient and click the Get Series
button.
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Figure 326: Import PACS dialog box with active Get Series button
7. Click the Import button.

8. Click the Close button to exit the Import from PACS dialog box.

Importing from media
1. Click the Patient Browser tab.

2. Click the Import button on Patient Browser.
The Import Location popup appears.

Figure 327: Import Location popup

3. Click the Media button.
The Import from Media popup appears.
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Figure 328: Import from Media popup

4. Click the drive and path where images were previously stored.
The Import button is active.

Figure 329: Active Import button

e If necessary, click Subfolders to see the entire path.

5. Click the Import button.
The imported images appear in Patient Browser.

Delete
1. Click the Patient Browser tab.

2. Select the study or the series to delete.
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3. Click the Delete button.
The Confirm Deletion popup appears.

Figure 330: Confirm Deletion popup

4. Click the Delete button on the Confirm Deletion popup.
The patient data will be deleted from the Patient Browser.

Registering a patient from Patient Browser

If additional scans must be performed on a patient that is listed in the
Patient Browser, you can register them by performing the following:

1. Click the Patient Browser tab.
2. Select the patient to register.

3. Click the Register button.

Figure 331: Patient browser register button

4. The Create New Study popup appears.

Figure 332: Create New Study popup

5. Perform one of the following:
o Click the Patient/Study button to use all exam information
selected, including the accession number.
« Click the Patient button to use only patient information.
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e Click the Cancel button to exit the Create New Study popup.

Building dose from Patient Browser

The Build Dose button in the Patient Browser, allows you to manually
create a Dose Report and Dose SR image which will appear in the Series
table when completed.

1. Click the Patient Browser tab.
2. Select the patient to use for the Build Dose.

3. Click the Build Dose button.

Figure 333: Build dose button

4. The Build Dose Please Wait popup appears.

Figure 334: Please Wait popup
5. The Dose Report and Dose SR image will be saved to the Series Table.

6. If the Dose Build Failed popup appears, click the OK button, make
the necessary changes, and try again.
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Figure 335: Dose Build Failed popup

Note Dose Structured Reports (Dose SR) cannot be viewed
in the BodyTom 64 system; Dose SR can be viewed in
PACS with the appropriate viewer.

Using Show Info to view, update, and move a series
1. Click the Patient Browser tab.
2. Select the patient.

3. Select the series.
The Show Info button becomes active.

4. Click the Show Info button.
The View/Update Information dialog box appears.

Figure 336: View/Update Information dialog box

The following tabs appear:

. Data about the patient, such as patient name,
Patient . .
date of birth, and sex of patient.
Stud Data about the study, such as date, time, and
¥ referring physician.
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Series reference indicator, model, pixel-padding

Data about the series, such as the position

value, and series date and time.

Images

Data about the image, such as the instance
number (sequential), exposure time.

5. Click the tab(s) to review and update the necessary information.

6. Double-click any editable field and make your change(s).

7. Click one of the following buttons

Click the Update button to save your changes.

Note

If information is invalid, you are prompted to correct
the information and click Update again.

If the field cannot be edited, a prompt appears tell you
the selected field is not editable.

Click the Move button to show the Move Series popup.

Note

The Move Series function is used when a scan has
been acquired under the wrong patient file or to move
a patient that was registered manually to the Patient
Registration tab. Moving the patient to the Patient
Registration tab will capture all the patient's
information.

Click the Registration button to move the patient into an existing
patient or by manually creating a new patient using the Patient
Registration process.

Click the Cancel button to exit the Move Series popup.

Click Browser to go to the Patient Browser tab and move the
series.

Click the Move button to confirm moving the series.

Click the Cancel button to exit the Patient Browser tab and return
to the View/Update Information popup.

8. Click the Close button to exit the View/Update Information popup.

Note

An audit log of both old and new patient series,
including the date and time of change and who
performed it, is generated.
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Modifying a series scanned under the wrong patient

If a patient has been scanned under the wrong identification, the series

can be corrected.

1. Click the Patient Browser tab.

2. Select the series that was scanned with incorrect patient
identification to modify the data.

3. Click the Show Info button.
The View/Update Information dialog box appears.

Figure 337: View/Update Information dialog box

4. Click the Move button.
The Move Series popup appears, denoting where to retrieve patient

information from.

Figure 338: Move Series popup

The following defines what each button performs:

Registration

If patient information is stored within hospital’s
HIS/RIS server, click the Registration button,
which will open the Register Patient tab to let you
choose patient/study information.

Browser

If patient information is stored within system’s
browser, click Browser button, which show the
Patient Browser tab information to let you select a
series with correct patient information.

Cancel

Returns you to the previous dialog box.
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5. Perform one of the following:
« Ifyou clicked the Registration button in the previous step, go to
the next step.
« Ifyou clicked the Browser button in the previous step, go to step
11.

6. Click the Manual button.
The Exam Information dialog box appears.

7. Enter the corrected data in any of the fields.
See “Registering the patient” on page 244.

8. Click the Update button to save the change(s).

9. Click the Move button.
A prompt appears to review changes made to the patient and/or
series information for changes to take effect.

10. Click the Ok button and then the Update button.
The corrected patient and moved data will appear in the Patient
Browser.

11. If you selected the Browser button, the Patient Browser tab is
showing; select the correct patient and series.

12. Click the Move button.
A prompt appears to review changes made to the patient and/or
series information for changes to take effect.

13. Click the Ok button.
14. Review the patient to ensure it is the proper one.
15. Click the Update button.

16. Click the Cancel button to return to the Patient Browser.

Loading a series into view
1. Click the Patient Browser tab.
2. Select the patient.
3. Select the series.

4. Click the View Images button or double-click the selected series.
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The Viewing tab opens, and the series appears for viewing and
manipulating.

Appending a series

Note Regardless of how many series are appended, the
series are listed chronologically. This tool can be used
to put all images from a patient together on a CD or to
PACS.

1. Click the Patient Browser tab.
2. Select the study to append.
3. Select the first series.

4. Right-click the mouse to select the second series.
The Append Images appears on the floating menu.

Figure 339: Floating menu - Append Images

5. Click Append Images.
The Please Wait popup appears.

Figure 340: Please Wait popup
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A new series is created with (Appended) at the end of the
description.

Figure 341: (Appended) series created
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Chapter 11 Viewing Images

Viewing lets you see already-scanned images from previous
examinations. To view images, select the patient in Patient Browser and
then select the series to view. To open the image, click the View Images
button or double-click the series.

Figure 342: Active Viewing tab

The following tables identify the tools in the Viewing tabs that let you
manipulate images. Some image tools appear on specific viewing tabs,
only. The view tabs are 2D, MPR, 3D, and CTP (if enabled).

Table 57: 2D, MPR, 3D, and CTP image tools
Image tools Tool name Action

Common tools

Resets the tool to the default

Clear Tool . .
pointer device.

Window Adjusts window width and center
Width/Center | of image.

Zoom Magnifies the image.
Pan Adjusts image on X or Y axis.

Inverts black to white and white
Invert

to black.

Saves a screen capture of a
Capture .

selected viewport.

Saves screen captures of all
Capture All . . P

visible viewports.

Reverts all images back to their
Reset

original mode.
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Image tools

Tool name

2D and CTP tools

Region of
Interest (ROI)

Action

Defines a circular ROl and
displays the ROl information.

2D, CTP, and

Arrow

MPR tools

Line

Draws an arrow on the image.

Draws a line on the image and is
used for measurement.

2D only tools

Angle

Draws an angle on the image and
displays the angle information.

Add .

. Create text box for annotation.
Annotation
Rotate Rotates images.

Reverse Image
Stack

Reverses the order in which
images display.

Flip Vertically

Flips images up or down.

Flip
Horizontally

Flips images right or left.

Cine Reverse

Cines backward through the
images.

Cine Forward

Cines forward through the
images.

MPR only too

Stop

Is

Tilt

Stops the cine loop.

When selected a White ‘steering’
wheel allows you to correct a
rotated image.
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Image tools  Tool name

3D only tool

Color Preset

Action

Dropdown menu allows you to
select from multiple color
options.

Render Mode

Dropdown menu allows you to
display images in Color, MIP, or
Grayscale.

Dropdown menu that allows you

Orientation to select from multiple
orientation options.
Rotate Rotates the 3D image.
Reverses the most recent action
Undo
taken.
Restores the most recent Undo
Redo

CTP only tools

action taken.

Perfusion Map

Perfusion .
. Select to place the arterial and

Artery/Vein .

. venous ROIs on the images.
Selection
Calculate CBF, Select to calculate the CT
CBV, MTT Map | Perfusion maps.
Clear Cancels the calculations and

returns to Calculation mode.

Displays the Arterial Venous Flow
graph.

Show
Artery/Vein
Flow Graph
Displays the image that has the
Peak Image highest HU value based on the

arterial ROI placement.

Using keyboard shortcuts

Keys are a quick way to navigate around. The table below provides
keyboard shortcuts you can use to manipulate images in the Viewing tab.
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Table 58: Arrow key navigation
Arrow keys \ Action

To scroll through images.

To adjust the window center.

To quickly scroll through images.

Setting window width and center

Note Any modifications you make are not saved to the
image.

1. Select a patient from Patient Browser, select the series to view.

2. To open the image, click the View Images button or double-click the
series.
The Viewing tab is enabled and the 2D viewer opens.

3. The following options allow you to adjust the window width and
center of the image:

e Click the Window Width/Center icon in the Tools menu, then
while holding the left mouse button down drag up/down to
modify Window Center and right/left to modify Window Width.

e To adjust with a preset, click the Windowing dropdown and select
a preset.

Figure 343: Windowing preset dropdown list
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e Type values in the Width and Center text boxes and click the
Apply button.

Figure 344: Windowing Width and Center text boxes, and the Apply
button

* Right click over an image and use the Activate Window Tool
option then while holding the left mouse button down drag
up/down to modify Window Center and right/left to modify
Window Width.

Figure 345: Right click menu

Viewing images in 2D

2D lets you view scanned images in a 2-Dimensional space. Standard 2D
mode is used when only one dataset is loaded. The default layoutis a 2 x
2 grid.

The Viewing tab and 2D viewer opens when you select a dataset from
the Patient Browser.

1. Select a patient from Patient Browser and select the series to view.

2. To open the image, click the View Images button or double-click the
series.
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The Viewing tab is enabled and the 2D tab is opened.

Figure 346: 2D tools
3. Use any of the image tools to manipulate your images.

4. Click the Reset button to reset images back to the original setting(s).
You cannot undo this action.

Comparing images

You can compare images in two different ways:

Note You can compare two series from the same patient or
two series from different patients.

Using the floating menu to compare images
1. Select the patient in Patient Browser.
2. Select the first series from the series window.

3. Right-click and click Mark for Compare from the menu.

Figure 347: Floating menu - Mark For Compare
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4. Select the second series or a series from a different patient.

5. Right-click and then click Compare With Selected Series from the
floating menu.

Figure 348: Floating menu - Compare with Selected Series

Both series are loaded into Viewing to compare.

Figure 349: Compared series

6. Click the Link button to link both images together to view.

Figure 350: Link button
The Unlink button replaces the Link button.

7. Click the Reset button to reset images back to the original settings.

Using the Compare button to compare two images

1. Select the patient in Patient Browser.
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2. Select the first series.
3. Press and hold the Ctrl key.

4. Select the second series.
Both series are highlighted.

5. Click the Compare button.

Figure 351: Using the Compare button
Comparing a scout and a scan
1. Select a patient from Patient Browser.
2. Select a scout from the series window.

3. Press and hold the Ctrl key on the keyboard.

Figure 352: Scout and scan selected to compare

4. Select the scan from the series window.
Both images are highlighted.

5. Click the Compare button.
The scout and the scan will appear on screen at the same time. A
green localizer line appears on the scout.
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6. Compare the scout to the scan.

Figure 353: Comparing a scout (1) and a scan (2)

7. To remove the scout, right-click on the scout and click Hide Scout
Viewpoint.
To return the scout to view, right-click in the viewing window and
click Show Scout Viewport.

Using the ROI
1. Select a patient from Patient Browser and select the series to view.

2. To open the image, click the View Images button or double-click the
series.
The Viewing tab is enabled and the 2D tab is opened.

3. Click the ROI tool.

4. Move the mouse pointer to the image where you want the ROI
located.

5. Click the left-mouse button and drag the ROI diameter to the
required size. To lock the ROI in place, click the left-mouse a second
time.

« To change the location of the ROI or the details of the ROI, click
the ROI or measurements you wish to move. The ROI and its
measurements will turn yellow, and the pointer becomes a hand.
Click and hold the mouse button on either the ROl or it’s
measurements and drag to a new location. Click anywhere
outside the ROI to freeze it in the new location.

o When you move the ROI to a different location the
measurements of the ROl are automatically updated based on
the new location.
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6. To remove the ROI, left click anywhere on the ROI, right click to see
the floating menu, and click Delete Annotation, or click on the ROI
and when it turns yellow, press Delete on the keyboard.

Figure 354: ROI

Using Layout and Rotate in 2D view

Layout lets you alter the number of images presented on the Viewing
tab. Rotate lets you turn the images. Select a patient from Patient
Browser, select the series to view.

1. Select a patient from Patient Browser and select the series to view.

2. To open the image, click the View Images button or double-click the
series.
The Viewing tab is enabled and the 2D tab is opened.

3. To adjust the layout of the viewing area, click the Rows and/or
Columns dropdowns to select the number of rows or columns you
want to show.

Figure 355: Layout (viewing tools)

4. To rotate the image, click the Rotate dropdown and select the
number of degrees to rotate the images.
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Figure 356: Rotate dropdown

5. Click the Rotate button to see the images turn to the new angle.

Figure 357: Rotate (viewing tools)

Applying a grid to your images in 2D
1. Select a patient from Patient Browser and select the series to view.

2. To open the images, click the View Images button or double-click the

series.
The Viewing tab is enabled and the 2D tab is opened.

3. Change the size of the grid in the Grid (mm) text box.

Figure 358: Grid (mm)
4. Click the Apply button to apply a grid over the image.

5. Perform one of the following to remove the grid:
o Click the Reset button.
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o Enter 0in the Grid (mm) text box and click the Apply button.

Viewing images in MPR

Multi-Planar Reformation (MPR) allows images to be created from the
original Axial plane into Coronal, Sagittal or Transverse (Axial) planes.
MPR is fast, uses all the attenuation values in the dataset, and can be
easily performed on the workstation. MPR however, provides on a two-
dimensional (2D) display of the image data.

Viewer layout is 2 x 2 as seen below.
1. Select a patient from Patient Browser and select the series to view.

2. To open the images, click the View Images button or double-click on
the series.
The Viewing tab is enabled and the 2D tab is opened.

3. Click the MPR tab.
The MPR screen appears.

Figure 359: MPR tools

4. Select the image reformat at the bottom of the screen.

Figure 360: Image reformat selections

5. Use any of the image tools to manipulate the images.
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6. The tilt tool can be used to modify the rotation of the images.

7.

Adjust the image angle by moving the circle.

Figure 361: Tilt tool

Click the reset button to reset the images back to the original
settings.
You cannot undo this action.

Understanding and using slab

Through the reformation process, axial images are stacked creating a
volume, or slab, which can be assessed in different planes. The thickness
and spacing of each slab can be varied to meet the needs of the viewer.
The reformations can be displayed in an average, maximum or minimum
projection.

MPR’s should be created using 1.2mm slices with a spacing of 0.6mm
whenever possible.

Creating the slab

1.

2.

Select a patient from Patient Browser and select the series to view.

To open the images, click the View Images button or double-click the
series.
The Viewing tab is enabled and the 2D tab is opened.

Click the MPR tab.
The MPR screen appears.

Click the Sagittal, Coronal, or Transverse plane to create your slab.
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Figure 362: Image formats

5. The Secondary Series option is enabled.

6. Select Enable Slab.

Figure 363: Enable Slab option

The Enable Slab option is inactive if no MPR view is selected.

Figure 364: Enable Slab option under Secondary Series

7. Set the Cyan lines to determine the beginning and end of the slab.

Figure 365: Cyan Line and cyan circle to drag for FOV
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8. Use the Cyan circle to drag the planned slab if required.

9. Define the Slab Thickness and Slab Spacing in the text boxes.

Figure 366: Slab Thickness and Slab Spacing text boxes

You can also use the yellow squares found on the slab thickness
display to modify the Slab Thickness.

Figure 367: Small yellow boxes to manually drag for desired slab thickness

10. Click the Slab Rendering Options dropdown to select the appropriate

option.

Figure 368: Slab Rendering Options dropdown

The following options are available in MPR Slab mode:

Slab Thickness

The thickness of the MPR slab.

Slab Spacing

The space between the start of one slab and
the next.

Slab Rendering

Where you define the pixel values that will be
displayed in each slab: options include,

Options Average, Maximum Intensity and Minimum
Intensity.

Maximum The highest pixel values for all slices within

Intensity the slab is displayed.

Minimum Intensity

The lowest pixel values for all slices within the
slab is displayed.
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Average

The pixel values of all slices within the slab
are combined and the average value for each
pixel is displayed.

Series Description

Text field for naming the series of images
created when clicking the Generate button.

Define the slab thickness. The boxes on the

Yellow lines lines allow you to adjust the thickness using
the mouse.
Define the slab FOV and dictate the range of
the new series to be generated. The cyan
Cyan lines lines are adjustable by clicking and dragging

on the lines themselves; both lines are moved
by clicking and dragging the central circle
marker.

Red, blue, and

Define the cross sections of the anatomy

green lines being viewed.
Generates a new series with the name given
Generate in the Series Description field, based on the

selected MPR view pane.

11. Select the Tilt Tool to correct any rotation on the image.

Figure 369: Tilt tool

12. Use the mouse pointer to move the white Tilt circle.

Note The circle does not represent the Field of View
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Figure 370: Tilt white circle
13. Enter the slab name in the Series Description text box.

14. The slab can be previewed in the bottom right viewport.

Note Make sure Zoom is at 100% or below.

Ensure all expected anatomy is included when
previewing the created MPR.

15. When you are ready to save, click the Generate button.
A Saving Series popup appears.

When the series is complete, the Capture Complete pop-up appears.

Figure 371: Capture Complete popup message — Series saved
16. Click OK to close the Capture Complete popup message.

17. The new MPR images appear in the Patient Browser with the
description in the Series Description text box.

Figure 372: MPR images in Patient Browser
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18. To create additional MPR’s. select the Reset button in MPR mode,

select the MPR view you want to create and perform the steps above
to create the new view.

Viewing images in 3D

In 3D viewing, a 3-Dimensional image is created by stacking all the
images of a scan on top of one another to create a 3D-volume. The initial
display shows the 3D volume and a box appears around it. MPR planes
also appear.

1.

2.

Select a patient from Patient Browser and select the series to view.

To open the images, click the View Images button or double-click the
series.
The Viewing tab is enabled and the 2D tab is opened.

Click the 3D tab.

Figure 373: 3D tools

To rotate the image up to 360°, click Rotate and move the image with
the mouse pointer to the rotation of choice.

You can change the Color Presets from the dropdown menu:

Figure 374: 3D Color Presets

You can change the Render Mode from the dropdown menu:
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Figure 375: 3D Render modes

7. Click the Orientation drop-down box to assign an orientation:

Figure 376: 3D Orientation options

8. Click the Reset button to reset images back to the original settings.
You cannot undo this action.
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Chapter 12  Post Reconstruction

The system stores multiple patient series of raw data to allow post
reconstruction of images. Post Reconstruction allows reconstructing of
the acquired data using different algorithms, slice thicknesses, or use of
image enhancement algorithms, such as Metal Artifact Reduction, Noise
Reduction and Windmill Correction.

Reconstruction Overview

Metal artifact reduction

Streak artifacts are often seen around metal leads, prostheses,
applicators, bone, or metal screws. Numerous factors can contribute to
these streaks including under-sampling, photon starvation, patient
motion, beam hardening, and scatter. You can use Metal Artifact
Reduction (MAR) to reduce these streaks. MAR removes the metal from
the image to reconstruct the soft tissue only; then it adds it back, to
reduce the artifacts. This is currently used only on Axial scans.

Noise reduction

Noise appears as grain on the image and is caused by a low signal to
noise ratio. This occurs more commonly when a thin-slice thickness is
used. It can also occur when the radiation dose is insufficient to
penetrate the anatomy being scanned.

Note Noise reduction applies to post-processing filters that
reduce the amount of noise in the images. In clinical
practice, using noise reduction may allow for a
reduction in CT patient-dose depending on the clinical
task, patient size, anatomical location, and clinical
practice. Consult with the site’s radiologist and
physicist to determine the appropriate dose to obtain
diagnostic image quality for a particular clinical task.

Windmill Correction

The Windmill Correction reduces artifacts that are common in Helical
scans due to the nature of the cone-beam reconstruction.
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Figure 377: Active Post Reconstruction tab

The tools available to Post Reconstruction are identified in the table

below.

Table 59: Reconstruction tools

Image tools

Tool name

Load Images

Action

Loads images from selected series into
viewing.

Cancels the current, post-
reconstruction request. All images are

St
°op generated until you click the Stop

button.

FOV Adjusts the.FOV prior to
reconstruction.

Clear Tool Resets tool to default pointer device.

Window Adjusts the width and center of

Width/Center | selected image.

Zoom Magnifies the image.

Pan Adjusts the image on X or Y axis.
Resets the display to default viewer

Reset -
settings.

Start Begins your Post Reconstruction.
Sends the last acquired scan from the

Resend recon workstation to the Patient

Browser.
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Performing Post Reconstruction

The following figure identifies parts of Post Reconstruction:

Figure 378: Post Reconstruction areas

1. Click the Post Reconstruction tab.

2. Select a study in the Exam Table.
When you select a study, all the scanned series for that study appear
in the Series Table.

3. Select the series to reconstruct.

Figure 379: Post Reconstruction study and series tables

4. Click the Load button.
The scan or series will load into the viewer. The series protocol table
and the Reconstruction Parameters and Options tabs are active. The
scan will appear in the Image Viewing Area.

5. View the study in the Image Viewing Area.
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Figure 380: Post Reconstruction viewing image area

6. To modify the FOV, perform the following:
e Click the FOV tool, click and drag the mouse to form a square on
the image in the Image Viewing Area.
o The size of the square appears in the Width box in the
Reconstruction Parameters and Options tab.
e Click the circle in the middle of the FOV square and drag to move
the FOV.
e Click one of the two drag boxes on the corners to adjust the size
of box.
o The Width dimension, and X/Y coordinates are adjusted as
the size changes.
o The FOV size cannot exceed the range of 50 - 600mm square.

Figure 381: FOV resizing boxes
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Note You can also enter a number in the Width or X and Y
box to define a specific FOV.
Alternatively, click the Use FOV Max option to use the
maximum FOV.

7. Click the Sharpness dropdown to select a reconstruction algorithm
from the Reconstruction Parameters tab.

Figure 382: Sharpness on the Reconstruction Parameters tab

Figure 383: Reconstruction Parameters Sharpness dropdown

8. Click the Slice Thickness/Spacing dropdown to select.

Figure 384: Reconstruction Parameters Slice Thickness/Spacing dropdown
The slice thickness and spacing options available are determined by
the type of scan that was acquired (Axial vs. Helical).

9. The # of Expected Images text box shows the calculated number of
images that will be reconstructed based on the parameters used for
the reconstruction.

Figure 385: # of Expected Images
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10. Click the Options tab. The following are only available during Post
Reconstruction.

11. Perform the appropriate action:
« If desired, select Noise Reduction for an Axial or Helical scan.

Figure 386: Noise Reduction on the Options tab for a Helical scan

o If desired, select Perform Windmill Correction for a Helical scan.

Figure 387: Perform Windmill Correction and/or Noise Reduction on the
Options tab for a Helical scan

e |[f desired, select Metal Artifact Removal for an Axial scan.

Figure 388: Metal artifact removal

12. Click the Start button to generate a new dataset.
When you click the Start button, the reconstructed images appear in
the viewing pane.

Figure 389: Please wait while the system performs data reconstruction
message

13. When the reconstruction is complete, the images appear in Patient
Browser.

Chapter 12 Post Reconstruction Page 340 of 412



BodyTom 64 User Manual Revision 04

Resending images from the scanner to the workstation

Pressing the Resend button lets you send the last acquired scan from the
recon computer to the Patient Browser. This may be necessary when
you have wireless interruptions and/or workstation shuts down
unexpectedly.

Figure 390: Resend button
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Chapter 13  Accessories and Options

In this chapter you will learn how to convert a bed, stretcher, or any type
of adjustable surface into a scanning platform using the Universal
Transfer Board.

To request the catalog(s) to reference product descriptions/details and
part numbers for the available accessories/options that are used with the
BodyTom 64, see “Contact information” on page 24:

When using a fixed scanner, the table moves from one portion of
anatomy to another while the gantry remains stationary. With the
BodyTom 64, an in-place scanning platform remains stationary while the
gantry or scanner translates from one point to the other to cover the
anatomy.

The universal transfer board can be used for most beds or stretchers. It
is placed under the patient and secured to the bed or stretcher with
straps.

WARNING Neurologica Corp. recommends that the weight of the
patient being positioned on the scan board does not exceed
the bed manufacturer’s safe, recommended, operating
patient load. Realizing patient safety is of the utmost
importance, it is recommended that safe judgment be
exercised at all times when it comes to the clinical care of
patients. There are a number of varying factors, such as the
condition of the bed being used, unique patient anatomy, as
well as the proper scan board and positioning of the patient,
per Neurologica Corp.’s clinical training guidelines and
product labeling. If any excessive wear or damage is noticed
to any scan board, do not use it for a patient scan; contact a
qualified service technician to assess, repair, and/or replace
the device.

Using the Universal Transfer Board
The universal transfer board is a carbon-fiber, radiolucent board that is
designed to work with any ICU bed or stretcher. The carbon-fiber board
comes with a 0.5-inch-thick headboard and 2-inch x 5-foot straps to strap
the board to the ICU bed or stretcher.
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You can use the universal transfer board on any bed, table, or stretcher.
Because you can attach the universal transfer board to almost any type
of surface, it is used anywhere throughout the hospital including the ICU,
OR, and ER. The universal transfer board is placed on the mattress and
secured with a strap or placed directly on a surgical table under the
cushions. The patient lies on the board with the patient’s head in the
head holder. The BodyTom 64 is moved into position and the scan is
performed.

The universal transfer board is always used with mattress stiffeners.

The mattress stiffeners provide a solid surface at the head of the bed to
prevent the mattress from sagging when a scan is performed. There are
usually four mattress stiffeners stored with the BodyTom 64 for easy
transport.

The universal transfer board is used for adults.

Note The universal transfer board is an optional accessory
that does not come with the system.

Table 60: Universal Transfer Board weight-bearing restrictions

The weight limit of the Universal Transfer board is equal to the
weight limit of the patient bed. The weight limit on the portion
of the Universal Transfer board that supports the patients head
is 7.5 kg / 17Ibs. The universal transfer board is used to support
and scan the patients head, only.

See also “Parts that potentially come into contact with the patient” on
page 86.

WARNING The weight limit for the superior portion of the Universal
Transfer Board is 7.5kg or 17lbs.

Figure 391: Universal transfer board and stiffeners
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Figure 392: Four types of mattress stiffeners

Note: Tipping of the board is a major concern. The universal
transfer board MUST be securely fastened to the
surface prior to placing the patient on the board.

1. Obey all warning labels when using the scan board.

2. Select the appropriate mattress stiffener for the mattress size and
insert.

Figure 393: Mattress stiffener in place

3. The universal transfer board requires mattress stiffeners that provide
a solid surface at the head of the bed to prevent the mattress from
sagging with the weight of the patient when a scan is performed.

4. With the proper mattress stiffener properly inserted, apply the
universal transfer board on top.

5. Position the board in accordance with the yellow, safety-warning
stickers to avoid a tipping hazard. Do not extend the board beyond
the mattress for proper placement.
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Figure 394: Universal transfer board properly positioned on the bed on a
mattress stiffener

6. When the board is properly positioned on the bed, secure it by using
the safety strap.

7. The safety strap must be attached to the board, passed completely
under the bed, and secured on the other side.

Figure 395: Universal transfer board with safety strap installed

8. When the universal transfer board is securely fastened to the bed,
transfer the patient to the board and secure the upper strap to the
patient and the scan board.

9. When the patient is positioned and securely strapped in, position the
scanner over the patient.

10. Initiate the scan.
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Chapter 14 Cleaning and Storing the System and
Workstation Specifications

Be familiar with this section before using the cleaning or storing the

system.

Cleaning the scanner and workstation

When the system is between uses, NeurolLogica recommends keeping it
clean as described below. This will help remove body fluids to prevent a
health risk and damage to internal parts.

Note NeurolLogica recommends a solution of 299% pure
Isopropyl Alcohol (IPA) to sufficiently clean the
equipment.

WARNING

WARNING

WARNING

CAUTION

WARNING

CAUTION

Do not use flammable or potentially explosive disinfecting
sprays, since resultant vapor could ignite, causing personal
injury and/or damage to the equipment.

To prevent short-circuiting or possible electrical shock, do not
spray cleaning agents or spill liquid cleaning agents directly
onto the machine.

Always electrically isolate this equipment from the main
electrical supply before cleaning and disinfecting it to prevent
short-circuiting or possible electrical shock.

The unit surfaces may be cleaned with a soft cloth and the
recommended solution or a similar mild non-abrasive
cleaning solution. General purpose liquid disinfectant may
also be used as necessary. Apply the cleaning solution to the
cloth, not directly to the unit.

Before cleaning the workstation (drive system), be sure to
disconnect the workstation from the wall outlet (power
source). Failure to do so could result in electrical shock and
cause severe injury to you and/or damage to electrical
components.

Do not allow electrical components to become wet. For eye
and hand protection, it is important to wear safety glasses
and rubber gloves, respectively.
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CAUTION Do not spray cleaning agents directly on the system. Spray a

clean cloth with the solution and then wipe down the
scanner and workstation.

Cleaning the outside of the scanner and workstation

1. Prepare detergent/disinfectant (regulated by EPA as hospital
disinfectant) solution according to instructions on label for correct
usage.

Use a basin or spray bottle (with product label).

Use a pump (usually on detergent/disinfectant containers) to
dispense the concentrate in the basin or spray bottle, then fill
with correct amount of tap water.

If using a spray bottle, empty and rinse out after use.

Note

The stability of the solution is unknown after 24 hours;
therefore, a fresh preparation of cleaning solution
must be prepared for each day of cleaning.

2. Use general purpose germicidal cleaner on the external covers and
rails. Do not use cleaners on the screens.

3. Use swabs moistened with cleaning solution, clean and remove any
dust, soil, dried contrast media, or foreign matter; allow all
components to air dry.

4. Wipe down and clean the frame of device and allow to air dry; return
to its storage area.

Note Wash (at 25°C) with neutral detergents, only;

softening agents are not allowed.

The following recommended products are registered by the EPA as
hospital disinfectant; these solutions are quaternary ammonium
compounds and are used in environmental sanitation of non-critical
surfaces:

TB Quat™ is a cleaning solution manufactured by ABC
Compounding Co.

Wex-cide™ is a disinfectant manufactured by Wexford Labs, Inc.,
product number Wexcide128.
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Maintenance of the workstation

WARNING Maintenance checks and all service must be performed by
service personnel trained by NeurolLogica Corp. See
“Contact information” on page 24.

Storing the system

Storing the scanner and workstation

Store the scanner in a dry, well ventilated, climate-controlled area. You
can use the key to lock the scanner when not in use. See “Identifying
operator control panel buttons” on page 78 to locate the lock.

CAUTION When the scanner is not in use and stored, it must be plugged
in a 120V or 250V outlet to charge the batteries.

CAUTION When the workstation is not in use and stored, it must be

plugged in a 120V (or other compatible) outlet to charge the
batteries.

Store the scanner on its centipedes or castor wheels (feet).

Note If the floor surface is soft (spongy) store the system on
its centipedes to disperse the weight of the system
evenly.

1. After transporting the scanner to an acceptable storage location, you
can either store the system in Transport mode (on its caster wheels)
or Scan mode (on its centipedes).

Figure 396: BodyTom 64 castor wheels

2. Turn off the scanner and workstation.
The system is now ready to be stored.
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See “Powering the workstation” on page 101.

Note It is recommended practice that the scanner is plugged
in and turned on even when it is not in use.

Storing the QA phantom

Store the phantom in a secure location with easy access for the daily QA

procedure.

Workstation specifications

Table 61: Workstation specifications

Phase \ Single
Voltage Range \ 100-240VAC + 10%
Feisony I &1 NEMA5-20R | NEMA 6-30R
Recommendations
Frequency \ 50 or 60Hz
. Fully Charged/

Batt C t

attery Lapacity 12 hrs. (Typical)
Tvpical Usage 110-120 VAC60 | 230-240VAC

U 5 Hz 50 Hz

- 125V, 2 Pole,3 | 20V 2Pole,3
Wiring Wire Groundin Wire

§ Grounding
Battery Operating Voltage \ 51.8vDC
Overall width \ 41in. (104cm)
Overall height \ 79in. (199cm)
Overall length \ 101in. (256.5cm)
Weight EST | 3510 Ibs. (1592kg)
Bétt'ery power (2) 12 VDC 800W
(lithium polymer)
Max programmed speed fwd. \ 1.6 MPH
Max recharge time \ ~ 8hrs.
Max continuous operation \ 8hrs.
Locking and unlocking cycles \ 20
Hrs transport over floors \ 2hrs.
Hrs system locked no Shrs.
external power
Max slope holding angle with 79 C (44.62 F)
scanner
Max doorway threshold \ lin. (2.54cm)
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Max elevator threshold %in. (1.905cm)

Height to locking adapter 8.59in. - 8.69in.

Min/Max storage
temperature

-252 Cto 702 C (-132 F to 1582 F)

Min/Max operating relative

20% to 80% (non-condensing)

Min/Max storage relative
humidity

20% to 85% (non-condensing)

Min/Max ambient operating
temperature

humidity

152 Cto 352 C (592 F/952 F)

Understanding the symbols and product-marking plate

Table 62: Symbols

Alternating current.

N/
@ Protective earth (ground).

Functional Earth

Caution: consult accompanying documents.

Caution: risk of electrical shock.

Electrostatic sensitive devices.

ﬂ Type B equipment

X-ray warning

X-ray source assembly emitting

Non-ionizing radiation

Warning: laser in use

Beam Class 2 Laser Product

Warning: Laser Radiation Do Not Stare into

Laser Output and Standards Information Label
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Warning: FDA Laser Information

Warning: high temperature

@ Emergency switch

Crush warning

Foot/toe crush warning when lowering machine

System up
System down

«|»>

Indicates temperature limits.

Indicates mechanical deactivation device.

((-:-J)) Indicates a radiation precaution; may be

A affected by radiation from other sources; may
produce interference that affects other
equipment.

@ Indicates a coil power cord.

Indicates a chain hazard could cause severe
personal injury.

Keep away from rain for packaging.

Humidity limit for packaging.

Warning: battery charging.
—— Fuse usage.

Refer to instruction in user manual/booklet

M D Medical Device Symbol

“ Legal Manufacturer Symbol
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ETL CLASSIFIED
o 6“’ s Intertek ETL (Edison Testing Laboratories) Mark
Intertek
EC |REP European Authorized Representative Symbol
c € CE Mark or Conformité Européenne ; number
2862 below CE represent Notified Body number

Note Disregarding information on safety is considered
abnormal use.
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Locating the product-marking plate on the workstation

Figure 397: Product-marking plate on side of the workstation

Listing of replacement parts for workstation

To ensure proper compliance requirements of replacement parts, (for
example, cables and accessories), parts must be purchased through
NeurolLogica Corp.

WARNING Using other manufacturer cables and accessories may affect
EMC performance. Unauthorized use of these items will
void warranty and may cause harm to patient, others and/or
equipment.
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Product Safety and Electromagnetic Comparability

Tested by: Intertek Testing Services NA, Inc., 70 Codman Hill Road,
Boxborough, MA 01719
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Appendix A Glossary
A

Algorithm Mathematical filter applied to raw data
during CT image reconstruction to remove
blurring artifact inherent to back-projection.
Also referred to as a kernel.

Annotation User comments or text added to an image.

Anterior Front of the patient’s body

Application Entity (AE)

An end point of a DICOM information
exchange, including the DICOM network or
media interface software; that is, the
software that sends or receives DICOM
information objects or messages. A single
device can have multiple AEs.

Attenuation

The reduction in intensity of a radiation
beam as it passes through a substance.

Automatic Exposure Control
(AEC)

Software used to adjust or modulate the
mA throughout an acquisition to reduce
patient radiation dose to a minimum.

Axial scan mode

Data acquisition while the scanner remains
stationary. The scanner position may be
incremented between exposures to collect
data over a longer Z axis range. Also
referred to as step and shoot.

Bolus Tracking

Monitors flow of contrast media in vessel
and triggers scan at optimal timing. Thisis a
scanner feature to automatically initiate a
prescribed Axial, Helical or Dynamic scan
when a threshold level of contrast
enhancement is reached at a specified
region of interest.

Collimation

Restricts x-ray to only the selected
anatomy, minimizing dose to patient and
reducing scatter.
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Computed Tomography A test that uses x-rays to provide detailed

Angiography (CTA) pictures of the heart and the blood vessels
that go to the heart, lung, brain, kidneys,
head, neck, legs, and arms. A CT angiogram
can show narrowed or blocked areas of a
blood vessel.

Computed Tomography An approximate measure of the radiation

Dose Index (CTDI) dose received in a single CT section or slice.

Computed Tomography Represents the dose for a specific scan

Dose Index Volume (CTDlyol)

protocol, which considers gaps and overlaps
between the radiation-dose profiles from
consecutive rotations of the x-ray source. It
is not patient dose. The CT dose index
volume is noted as CTDlyol. Itisreportedin
units of mGy. The CTDlyo is based on
measurements made by the manufacturer
in a factory setting. The CTDlyql is calculated
differently for both the Axial and the Helical
mode:

For Axial scan mode: CTDlyol = [(N x T)/I] x
CTDlw.

For Helical scan mode: CTDlyo = 1/pitch x
CTDlw.

See also dose and patient dose.

Computed Tomography
Dose Index (CTDlw)
weighted average

The measure of ionizing radiation exposure
per slice of data acquisition. CTDI
represents the integrated dose along the Z
axis from one axial CT scan (one rotation of
the x-ray tube). The CT Dose Index is noted
as CTDlw.

Computed Tomography (CT)
number

Relative value assigned to each pixel to
guantify the attenuation occurring in each
voxel in comparison with the attenuation of
water. The calculated CT number for a
given pixel is given in Hounsfield units (HU).

Computed Tomography
Perfusion (CTP)

Evaluates cerebral perfusion or level of
blood flow in the brain by monitoring the
initial passing of iodinated contrast media
through the vasculature of the brain.

Contrast media

Used to improve sensitivity and specificity
of clinical diagnoses.
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Contrast resolution

The ability of a CT system to detect an
object with a small difference in linear
attenuation coefficient from the
surrounding tissue. Also referred to as low-
contrast detectability or sensitivity.

Digital Imaging
Communication in Medicine
(DICOM)

Digital Imaging and Communications in
Medicine, or DICOM, is a standard that
helps people doing work in the field of
radiology. The DICOM standard is designed
to promote communication and integration
between a variety of radiology imaging
systems and equipment used in filmless
radiology.

Digital tilt The ability to correct the image post-
acquisition and correct positional
inaccuracies prior to sending to PACS.

Dose The generic term that refers to the CTDlyol,

the standardized parameter to measure
scanner radiation output — or the amount
of amount of ionizing radiation absorbed
by patient per unit mass.

Dose Length Product (DLP)

The measurement of dose for an entire
series of CT images. DLP is equal to the
calculated dose per section multiplied by
the length of a CT acquisition along the Z
axis.

Dynamic Host Control Protocol
(DHCP)

A standardized network protocol used on
Internet Protocol (IP) networks. The DHCP
is controlled by a DHCP server that
dynamically distributes network
configuration parameters, such as IP
addresses, for interfaces and services.

Dynamic scan mode (multiple
detector widths)

Data acquisition at multiple time points
over the same anatomic location(s).
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E

Electromagnetic
Compatibility (EMC)

The branch of electrical sciences that studies
the unintentional generation, propagation,
and reception of electromagnetic energy with
reference to the unwanted effects
(Electromagnetic interference (EMI)) that
such energy may induce.

Electromagnetic
Interference (EMI)

A disturbance generated by an external
source that affects an electrical circuit by
electromagnetic induction, electrostatic
coupling, or conduction. The disturbance may
degrade the performance of the circuit or
even stop it from functioning.

Field of View (FOV)

The diameter of the acquired attenuation
data displayed across the image matrix.

Helical scan mode

A CT acquisition whereby an x-ray
acquisition whereby the x-ray tube and
scanner move continuously during
scanning, yielding a data set in the form of
a helix. Also referred to as spiral.

Hospital Information
System/Radiology
Information Systems
(HIS/RIS)

A Radiology Information System (RIS) is the
core system for the electronic
management of imaging departments. The
major functions of the RIS can include
patient scheduling, resource management,
examination performance tracking,
examination interpretation, results
distribution, and procedure billing. RIS
complements Hospital information systems
(HIS) and Picture Archiving and
Communication System (PACS) and is
critical to efficient workflow to radiology
practices.

Hounsfield Unit (HU)

The unit of the CT number scale assigned
to each pixel to quantify relative
attenuation.
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Interscan delay time

Minimum amount of time that must
transpire between end of one scan and
initiation of next scan. Interscan delay
times include idle time between scans to
allow tube cooling.

Iterative Bone Correction
(1BC)

A feature build into the reconstruction
software, which performs a correction on
every single Axial image the scanner
produces, including both primary series
from a scan as well as secondary
reconstruction images. Current IBC
settings were chosen to provide optimal
correction for standard medical imaging;
however, the setting can be customized as
needed.

Kernel

A mathematical filter applied to raw data
during CT image reconstruction to remove
blurring artifact inherent to back-
projection. Also referred to as an
algorithm.

mAs

Tube current-time product: The product of
tube current and exposure time per
rotation, expressed in units of milliampere
seconds (mAs).

Matrix

Two-dimensional (2D) grid numbers
arranged in rows and columns.

Maximum Intensity
Projection (MIP)

The multiplanar reformation technique
that displays only the maximum pixel value
along a ray traced through the object to
the viewers assumed perspective in front
of the scanner display screen.

Mean Transit Time (MTT)

A common measurement during CTP
studies of the brain. Refers to the average
transit time, in seconds, needed for blood
to pass through a given region of brain
tissue.
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milli amperage (mA) Tube current: the number of electrons
accelerated across an x-ray tube per unit
time, expressed in units of milliampere

(mA).

Modality Performed A mechanism for modalities to pass

Procedure Step (MPPS) information about the imaging performed
back to the HIS/RIS or PACS.

Modality worklist manager Scheduled (but not yet scanned) patient
list.

motion artifact Voluntary and involuntary patient motion

during CT scan, appearing as a streak
artifact on image; ghosting or blurring of

image.
Multi-Planar Reformation The process of displaying CT images in a
(MPR) different orientation from the one used in

the original reconstruction. Allows for
reformation of images in planes that would
otherwise be difficult or impossible to
acquire with CT. Requires only image data.
Raw data is not utilized.

Noise Random statistical variations in the signal.
Can be quantum noise, electronic noise
due to lost signal, or artifact noise.
Manifests itself as overall graininess of the
reconstructed image.

Partial volume artifact Occurs when an object is only partly
positioned within a voxel or is much smaller
than the overall voxel volume. The object’s
attenuation is not accurately represented
by the pixel value. Overlapping
reconstructions further reduce partial
volume artifacts.

Patient Browser, local Where the already-scanned patient list is
database stored.
Patient coordinates References are as follows:

« X lefttoright.
« Y anterior to posterior.
« Z headtofeet.
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Patient dose

The absorbed dose to a patient.
See also CTDlyo.

Peak kiloVoltage (kV)

The penetrating power of the photons
coming from the x-ray tube.

Picture Archive and
Communications Systems

Stores medical information, including 2D
images, and 3D medical images. All modern

(PACS) PACS setups will work with DICOM.

Pitch In Helical mode, refers to the speed of the
scanner movement over the table as the
scanner rotates.

Pixel A single, picture element of image matrix.

Post reconstruction

Prescribing the reconstruction parameters
after scan acquisition.

Projection View of anatomical cross-section from a
particular vantage point.

Prone Patient lying on stomach.

Protocol Prescribes the acquisition and

reconstruction parameters to be used for a
scan.

Quality Assurance (QA)

Procedure of performing periodic specified
tests or measurements to assure that a set
quality level, as specified by system

manufacturer, has not been compromised.

Radiation Safety Officer
(RSO)

The person within an organization
responsible for the safe use of radiation and
radioactive materials as well as regulatory
compliance.

Radio Frequency
Interference (RFI)

Also called Electromagnetic Interference
(EMLI), is an unwanted disturbance that
affects an electrical circuit due to
electromagnetic radiation emitted from an
external source.

Raw data

A transmission measurement obtained by
the detectors used to mathematically
reconstruct the CT image.

Reconstruction filter

Used to ensure accurate anatomical
reconstruction. Also allows for either
spatial resolution or low-contrast-resolution
enhancement.
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Region Of Interest (ROI)

Provides a quantitative analysis of the
Hounsfield values of a specific anatomic
area. A graphic outline in the shape of a
circle is placed over an area on the image.
Software calculates the average CT number
in HU within the ROI.

Resolution

A scan time, per slice, in Axial mode, only.

Retrospective reconstruction

Reconstruction performed after the initial
prospective reconstruction. Multiple
retrospective reconstructions of raw data
are possible, with changes to display FOV,
kernel, slice thickness etc.

Scan delay

The time between the initiation of contrast
agent administration and CT data
acquisition. The chosen scan delay
determines the phase of contrast
enhancement for a given CT acquisition.

Scan protocol

A list of scanner-load parameters used to
perform an x-ray exposure.

Scan types

Axial, Helical, Dynamic, Reference, and
Scout.

Scout

Digital survey radiograph acquired by the CT
system for the purpose of prescribing the
cross-sectional acquisition. Like a
conventional radiograph, the scout is
produced by translating the scanner over
the patient without tube or detector
rotation. Also referred to as topogram or
scanogram.

Series

A set of images acquired in a scan.

Size Specific Dose Estimate
(SSDE)

Not dose to any specific organ but rather
the mean dose in the center of the scanned
volume. That is, SSDE is not the exact
patient dose, as factors such as scan length
and patient composition can differ from the
assumptions used to calculate SSDE, for
example conversion factors based on
patient size provided to estimated patient
dose for a patient of a particular size.

Slice spacing (Spacing)

The distance between the center of one CT
slice and the center of the next slice.

Appendix A Glossary

Page 362 of 412



BodyTom 64 User Manual

Revision 04

Slice thickness

The dimension of a constructed CT slice
along the longitudinal direction of
acquisition (Z axis).

Spatial resolution

The ability of a CT imaging system to display
fine details, separately. Given in units of
line pairs per centimeter (Ip/cm).

Supine

Lying on back.

Temporal resolution

The ability of a CT system to freeze motion
and provide an image — free of blurring.

Test Bolus Scan mode used to measure the contrast
transit time using a small injection of
contrast media.

Threshold The CT number (Hounsfield Unit (HU))

where Bolus Tracking tool will trigger the
system to begin the scan.

Time Attenuation Curve
(TAC)

A graph of the contrast enhancement
versus time. TAC is used to determine
blood flow rate in seconds for contrast
timing.

Time delay

Monitoring delay: Time from injection to
the start of monitoring scans.

Transverse plane

Perpendicular to direction of Z axis.

Volume Rendering (VR)
image or object

A 3D modeling technique that utilizes the
entire acquired dataset but adjusts the
opacity of the voxels included in the 3D
image according to their tissue
characteristics.

Voxel

Abbreviation of volume element. Refers to
the volume of tissue represented by a pixel
in the matrix used to display the CT image.

Window Center (WC)

The pixel value given in Hounsfield Units
(HU) at the center of the window width.
Window Center controls the brightness
(density) of the CT image.
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Window Width (WW) The range of pixel values assigned a shade
of gray in the displayed CT image. Window
width controls the contrast of the CT
image.
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Appendix B Listing of All Buttons, Tools, and Icons

Status bar icons

Table 63: Status bar icons
Status bar Status bar icon
icon name

Status description

Identifies x-ray as on or off.

The icon changes from a

X-ray status gray/black icon when x-ray is off
to a rotating yellow/black icon
when x-ray is on.

Identifies the system’s current
state.

The orb changes color
depending on the state the
system is in.

See Table 26 on page 114 for a
list of the different orb colors
and system states they identify.
Identifies the system’s current
Scanner position position relative to its zero
reference.

Identifies when E-STOP is
engaged. The icon will flash
when E-STOP is pressed.

System state

System E-STOP
status
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Status bar Status bar icon

Status description

icon name

System tube heat
status

Indicates the current X-Ray tube

heat status. The values are color
coded as follows:

Blue 0% - 19%

Yellow 20% - 50%

Orange 51% - 75%

Red 76% - 100%

NOTE: The scanners tube heat
must be below 20% before the
scanner powers down. If the
tube is too hot, a message will
display on the LCD scanner
control panel instructing you to
wait until the tube heat is low
enough to safely power off the
scanner.

Scanner battery
capacity status

Indicates the remaining scanner
battery percentage available. The
capacity values are color coded
as follows:

Green 100% - 51%

Yellow 50% - 25%

Red 24% - 0%

System air
freshness status

Indicates the air freshness status;
it is recommended that an air
calibration be performed:

e Every eight (8) hours.

e  When the air freshness
status falls below 50%.

e [f the scanner is moved to an
area with a dramatic change
in humidity and/or
temperature.

The calibration status values are
color coded as follows:

Green 100% - 51%

Yellow 50% - 25%

Orange 24% - 0%

After calibration it returns to

100%.
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Status bar Status bar icon
icon name

Status description

Indicates the remaining
workstation battery capacity
available. The capacity values are
color coded as follows:

Green 100% - 21%

Yellow 20% - 11%

Red 10% - 0%

You will be prompted to plug the
workstation into an outlet to
charge if the battery capacity is

Workstation low; a scan cannot complete
battery capacity when the battery capacity is 10%
status or lower.

When the workstation reaches
the red capacity range, the
system will shut down. A
message informs you that the
system will shut down due to low
battery.
The lightning bolt icon signifies
that the workstation is currently
charging and goes away when
unplugged.
Indicates the available disk space
for image storage. The available
space values are color coded as
follows:

Green 100% - 51%

Yellow 50% - 20%

Red 19% - 0%

Image storage
space status

System state orbs

Table 64: System state orbs

Dark gray The system is in an unknown state.
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Orb Color \ State
Light gray The system is powering up or down.
Dark purple | The system is busy.
Purple The system is completing air calibration.
Light purple | The system is archiving.
Blue The system is idle.
Green The system is ready to perform a scan.
Light yellow | The system is planning.
Dark yellow | The system is preparing.
Light orange | The system is reconstructing.
Dark orange | The system is scanning.
Pink The system is not ready.
Red The system is in fault.

Workstation buttons

Table 65: BodyTom 64 workstation buttons

Workstation Action
button

the list.

In Protocol Manager — adds a new protocol from

In Patient Browser — selects the archive destination
for selected information.
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Workstation Action

button

In Patient Browser — used to begin a protocol.

In Protocol Manager — used to create a new
protocol from a previously saved protocol.

selected patient.

In Patient Browser — generates the dose for the

imported.

In Patient Registration — cancels the current query.
In Patient Browser — cancels any series being

performed.

In Acquisition — cancels the entire exam being

protocol.

In Acquisition — cancels the current scan within a

fields.

In System Configuration — clears information in

Queue popup.

In Protocol Manager — closes popup.
In Store/Print Queue — closes the Store/Print

In System Configuration — closes System or User
Configuration dialog boxes.

In Patient Browser — allows you to select multiple
series of patient images to compare in Viewing.

the next step.

In Acquisition — authorizes the scanner to move to

In Patient Registration — deletes patient(s) from the
Stored Results list.

In Patient Browser — deletes selected exam
information from Patient Browser.

In Store/Print Queue — deletes a series to be stored
or a series that failed to store.

In Protocol Manager — deletes a saved protocol.

In System Configuration — clears a saved dose
setting to remove the restriction.

Appendix B Listing of All Buttons, Tools, and Icons

Page 369 of 412



BodyTom 64 User Manual

Revision 04

Workstation

button

Action

In System Configuration — deletes saved dose
settings to remove all restrictions.

In Store/Print Queue — when you select one or
more series, displays an explanation of why a series
failed to store.

Move selected item down the list.

In Patient Registration — used to modify protocols.

In System Configuration under DICOM Servers —
echoes the selected server to test the connection.

While in Interventional Mode, exist the system from
the Instant Repeat Feature.

In Protocol Manager — exports protocols to a media
device.

In Acquisition — completes the examination.
Completes all protocols, builds Dose SR and images,
and directs user to Patient Browser.

In Viewing - generates a new series with the Series
Description field information — based on the
selected MPR.

In Patient Browser — imports the exam information
from PACS or Media.

In Protocol Manager — imports previously exported
protocols to the workstation.

Performs a 38.4mm axial scan at the current
scanner location while in the Interventional Mode

In Patient Registration — manually enters a new
patient and, when completed, takes you to the
Acquisition tab to acquire the data for a scan.

In Patient Browser — used to select the destination
for patient data to media.
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Workstation

button

Action

In Patient Browser — minimizes the Import for
Media popup.

While in Interventional Mode, move the scanner to
the last scanned position and performs a 38.4mmm
axial scan.

In Protocol Manager — used to create a new
protocol.

To accept the selections you make.

In Patient Browser — used to select the destination
for patient data to PACS.

In Patient Browser — used to select only patient
information for a patient when using Register
feature.

In Patient Browser — used to select all exam
information for a patient when using Register
feature.

In Store/Print Queue — when you select one or
more series, temporarily stops the series from being
stored. This is a toggle button with the Resume
button.

In Acquisition — pauses entire protocol.

In Acquisition — pauses current scan within a
protocol.

In System Configuration under Audio Configuration
— used to play audio files.

For Quality Assurance — used to prepare
workstation to run a Quality Assurance test.

In Acquisition — selects an existing protocol for the
current study.
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Workstation

button

Action

In Patient Registration — searches the HIS/RIS
server for scheduled patients.

In Patient Registration —registers the selected
patient and then takes you to the Acquisition tab to
acquire the data for an examination (scan).

In Patient Browser — opens the Create New Study
dialog box and moves selected patient to
Acquisition.

In Patient Registration — used to take patient
information stored in HIS/RIS server to Patient
Registration to choose the patient and study.

In Acquisition — repeats the last scan that was
performed.

In Post Reconstruction, sends the last acquired scan
from the recon workstation to the Patient Browser.

In Viewing — reverts all images back to original
state.

In System Configuration — resets information back
to default or clears information in fields.

In Store/Print Queue — when you select one or
more series, continues to store previously paused
series. This is a toggle button with the Pause
button.

In Store/Print Queue — when you select one of
more series, tries to archive the selections.

In System Configuration — saves updated
information.

In Patient Registration — searches queried patient
entries for specific information.

In Patient Browser — shows patient, study, series,
and image information; used to modify series
scanned under a wrong patient.

For Daily Calibration — begins the daily (air)
calibration.
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Workstation
button

Action

In Acquisition — begins any post-reconstructions
that were defined during the protocol setup.
In Post Recons — begins a manual reconstruction

In System Configuration under Audio Configuration
— stops audio files from playing.

In Patient Registration — selects patient(s) from
guery results and moves them into the Stored
Results list.

In System Configuration under User Accounts —
used by administrators to unlock a user’s account.

Move selected item up the list.

In Protocol Manager — updates information on an
existing protocol.
In System Configuration — updates information.

In Acquisition — prompts the application to send the
selected protocol to the scanner and verify that the
scanner has tube and battery capacity to perform
the protocol.

In Patient Registration — shows selected patient
details.
In System Configuration — shows information.

In Viewing — to load and views images.

Viewing tools

Table 66: Viewing tools

Tool

\ Tool name Action

2D, CTP, and Viewing tool — draws
Angle an angle on the image and
displays the angle information.

2D, CTP, and Viewing tool — draws
Arrow an arrow on the image, which can
be repositioned.
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Tool  Tool name

Calculate CBF,

CTP only tool — calculates the

Action

Cerebral Blood Flow (CBF),

CBV, MTT Map | Cerebral Blood Volume (CBV) and
Mean Transit Time (MTT) maps.
CTP only tool — cancels the

Clear

Perfusion Map

calculations and returns to
Calculation mode.

Common tool - saves a screen

Capture .

P capture of selected viewport.
Capture all Common tool - saves screen
Viewports captures of all visible viewports.

Cine Reverse

2D only tool — cines backward
through the images.

Cine Forward

2D only tool — cines forward
through the images.

Common tool (Acquisition, Post
Reconstruction, Viewing) - resets

Clear Active the tool to the default pointer
device.
Post Reconstruction tool — adjusts
Field Of View the Field Of View (FOV) prior to

reconstruction.

Flip Horizontal

2D only and Viewing tool — flips
images right or left.

2D only and Viewing tool — flips

Flip Vertical .
images up or down.
Invert Common tool (Viewing) - inverts
black to white and white to black.
Load Viewing tool — loads images from

selected series into viewing.

Measure (Line)

2D, CTP, and Viewing tool — draws a
line on the image and displays
length information.
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Tool

 Tool name

Pan

Action

Common tool (Acquisition, Post
Reconstruction, Viewing) - click
and move pointer over image.
Left click and hold down the
mouse button and drag the image
in the chosen direction. Release
mouse button to position image in
new location.

Peak Image

CTP only tool — displays the image
that has the most visible contrast
(based on arterial ROI placement).

Perfusion
Artery/Vein
Selection

CTP only tool — selects the artery
and vein to be used for performing
perfusion calculations.

Redo

Axial and Helical Viewing tool —
restores the last text editing or
resizing and positioning of controls
— if no other action occurred since
last time the Undo button was
clicked.

Redo

Viewing tool — performs the most
recent action, again. The button is
disabled if the application cannot
redo the application.

Region of
Interest (ROI)

2D, CTP, and Viewing tool — defines
a circular ROI and displays the ROI
information (5mm diameter by
default).

Reset

Post Reconstruction and
Acquisition tool — resets the
display to default viewer settings.

Reverse Image
Stack

2D only and Viewing tool —
reverses the order in which
images display.

Rotate

MPR only and Viewing tool —
rotates the image.

Scan Region
Re-Draw

Acquisition tool — if scout lines
and the scan region is deactivated,
allows you to reactivate.
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Tool  Tool name Action

CTP only tool — displays the
Arterial Venous Flow graph.

Show

Artery/Vein

Flow Graph
Post Reconstruction tool — cancels

Sto the current, post-reconstruction

P request. All images are generated

until you click the Stop button.

Stop Cine 2D only tool — stops the cine loop.

Text 2D only and Viewing tool —

(Annotation)

creates text box for annotation.

Tilt

MPR only tool - corrects a rotated
image.

Toggle Layout

Acquisition tool — changes the
layout to 2x2. Repeat process to
return to 1x1.

Toggle Scouts

Acquisition tool — removes scouts
from Acquisition.

Undo

Axial and Helical Viewing tool —
reverses the most recent action
taken (a successful copy, cut,
delete, undo or paste action).

Undo

Viewing tool — removes the most
recent action performed on
image. The workstation
remembers the last five
adjustments made. The tool is
disabled if the workstation cannot
redo the adjustment.
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Tool \ Tool name

Window
Width/Center

Action

Common tool (Acquisition, Post
Reconstruction, Viewing) — click
and move pointer over image.
Left click and hold the mouse
button and drag in chosen
direction to adjust Window Width
and Window Center. Width and
center values appear in the
Width/Center status display.

A pre-defined width/center setting
can also be selected.

Select the preset from the
dropdown list below the
Windowing Preset button.

Width and center presets can also
be saved or deleted.

Zoom

Common tool (Acquisition, Post
Reconstruction, Viewing) - click
and move the pointer over the
image. Left-click the mouse and
hold down the left-mouse button
and move in upward direction to
zoom in (enlarge) and downward
to zoom out (shrink).
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Table 67: Pendant buttons

Description

Action
[lluminates when

POWER power is supplied to
pendant.
Turns on all three
positional lasers.
While the lasers are
LASER on, the scanner spins
for the internal laser
to be seen within the
scanner opening.
Moves the scanner
forward
GO TO SCAN | approximately 30cm.
PLANE This is the distance
between the internal
and external lasers.
mo | e
REFERENCE g
scout or a scan.
wove | T o
BACKWARD
backward 10mm per
(slow)
second.
MOVE oves tre scamer
FORWARD
forward 10mm per
(slow)
second.
MOVE oves tre scamer
BACKWARD
backward 60mm per
(fast)
second.
wove | e o
FORWARD
forward 60mm per
(fast)
second.
Allows the user to
SET program Scan and
MEMORY Rest positions for the

scanner.
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Moves the scanner to
SCAN the Scan Position
POSITION saved using the Set
Memory feature.
Moves the scanner to
REST the Rest Position
POSITION saved using the Set
Memory feature.
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Appendix C
Provided

Sample of Reference Protocols

Table 68: Sample of BodyTom 64 adult protocols and important estimates

Slice

Protecel Type kV mA Thickness Sharpness Resolution Coverage Srlgor
Name 4 (mGy)
/Spacing
:Si‘:lt Head Axial 120 | 200 48x4.8 Soft Tissue 1Sec. 250 47.32 1183
) ’ . Soft Tissue - .
C-Spine Helical Helical 120 250 1.2x1.2 Pitch = 0.8 400 24.16 966.4
Abdomen
’:‘::'Ctalche“ Helical | 120 | 150 12x12 Bone Pitch =0.8 450 14.49 652.05
Adult Soft Ti -
Abdomen Helical | 120 | 250 24x24 ot lissue Pitch = 0.8 500 24.16 1208
Helical Abdomen

Protocol
Name

Pediatric Head

Slice

Thickness

/Spacing

Sharpness

Table 69: Sample of BodyTom 64 pediatric protocols and important estimates

Resolution

Coverage

CTDlyo

(mGy)

. Axial 100 175 4.8x4.8 Soft Tissue 1 Sec. 200 32.02 640.4
Axial
4 DLP is based on length from coverage column
> DLP is based on length from coverage column
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Appendix D Automatic Exposure Control

1 Introduction:

Automatic Exposure Control (AEC) is a feature which allows the
exposure to automatically be modified based on the attenuation of the
scanned object. The main objective of AEC is to optimize the x-ray
current based on prior knowledge of the scanned objects profile. AEC is
used to optimize patient exposure while attempting to maintain
acceptable diagnostic quality of the reconstructed images.

AEC uses image noise to optimize the scan current. The image noise on
CT scanners can be traced to two sources: Electronic Noise and
Quantum Noise. Electronic Noise is generated by the electronic
components of the Data Acquisition System (DAS). Quantum Noise is
related to x-ray generation. Currently Quantum Noise is the major
component of noise on CT images, the contribution of Electronic Noise
has become less significant since the early days of CT scanners.

2 Image Noise:

2.1 Electronic Noise:

The DAS is composed of the crystals, the photodiodes, the Analog to
Digital Convertors (ADC) and other electronic components known as
“converter cards” since they convert x-rays into a quantifiable current.
Thermal Noise is the most common source of electronic noise in the CT
system. As the scanners internal temperature increases thermal noise
becomes the dominant component of the DAS'’s electronic noise.
Imperfections in the semiconductor chips used in the DAS also
contribute to the Electronic Noise. However, with the advance in
semiconductor crystals this has become less relevant. Currently
Electronic Noise has no significant impact on image quality when using
proper scan parameters, i.e., scan voltage, current and exposure.

2.2 Quantum Noise:

The generation of x-ray photons can be described by a Poisson random
process. Poisson random processes are used to describe event
generation over a fixed time interval. A Poisson random process is used
to describe Queues in general. In a queue the number of new arrivals to
the queue over a fixed time interval follow a Poisson distribution.
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The Quantum Noise is related to the standard deviation of the Poisson
distribution which inversely proportional to the square roots of the
number of events:

Where o is the image noise and N is the number of detected photons.
The above equation can help relate the image noise to the scan current,
I, the scan time, t, and the slice thickness, Sw, since the number of
photons is proportional to either one:

N <[t and N «<Sw

The image noise of a given scanner can be written as a function of the
scan parameters:

To reduce the image noise, we can either increase the scan current, the
scan time or the slice width, or any combination thereof. Kis constant
that is dependent on the image reconstruction process. It follows, for
two different scan currents I1and Iz over the scan times t;and t2and
using the same slice thickness, the image noises for the two scans can
be related using the following equation:

The same relation exists between the image noise and the slice thickness

As a result, doubling the slice thickness can reduce the image noise by
almost 40%. Figure 1 shows the Noise as a function of the scan current
(left) and the inverse of the scan current (right). The scan done for the
same slice thickness of 2.5 mm and same scan time of 1 second.
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3 AEC working instructions:

3.1 AEC input parameters:

AEC requires three different input parameters: Minimum maA,
Maximum mA, and the Noise Level.

Minimum mA: The Minimum mA is set to prevent an unacceptable
amount of noise in the reconstructed images.

Maximum mA: The Maximum mA value is used to prevent over-
exposure of the patient being scanned. This is typically set to reduce the
chances of over exposure which may lead to radiation sickness.
However, in the case of the BodyTom 64, the maximum scan current is
set to protect the x-ray tube.

The noise level: The first step of AEC is to build an equivalent stack of
cylindrical water phantoms or Water Equivalent Diameter (WED). The
WED is created based on the measured attenuation from the scout. The
noise level represents the noise in each section of the stack of water
equivalent phantoms. The selected noise level should be within an
acceptable range, and it should be dictated by the scan protocol.

One of the key features of the scanners AEC is the ability the user has to
re-adjust the noise level based on the estimated mA until the desired
mA profile is attained. The feature works as follows:

1. A protocol is created with the AEC feature enabled, and a
Minimum mA, Maximum mA, and Noise Level are defined.

2. The above-mentioned protocol is used to create a Scout
image.
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3. The user can toggle the AEC graph to view the scan current profile.
The profile will be overlayed on top of the scout.

4. If the scan current profile is acceptable, then the user will initiate
the diagnostic scan as desired.

5. If the scan profile is not acceptable, the user can adjust the noise
level and recalculate the scan current.

6. The process can be repeated as many times as needed until the user
is satisfied with the current profile. The AEC tool will allow the user
to view the scan current before initiating the actual scan.

3.2 The scan parameters:

The scan protocol parameters are not needed for AEC however
they do affect the current estimation:

1. kV:the scan kV is used to select the appropriate noise table used
for estimating the scan mA.

2. Slice Thickness: The noise is measured at a slice thickness of 5.0
mm; however, the scan protocol slice thickness can be any of the
allowable thickness values. The selected slice thickness is then used
to adjust the noise table using the equation in section 2.2. The
entire noise table will be multiplied by the square root of the slice
thickness ratio. The multiplication factor is:

3. The reconstruction kernel: The noise image depends on the
reconstruction kernel. AEC is limited to SoftTissue and PostFossa
Kernels. AEC will be disabled if the user selects a different
reconstruction kernel.

3.3 Notes

When AEC is selected the user should be aware of:

1. Patient Positioning: The patient should be properly positioned as
close as possible to the scanner iso-center. Failure to do so can
lead to an over-estimate of the scan current leading to an increase
in patient dose.

2. Presence of metal implants: AEC should not be used if the patient
has metal implants in the region to be scanned.
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3. The measured noise: the final noise in the image depends on the
size of the scanned patient. AEC assumes that the patient is
cylindrical, as such the measured noise level could be different
then the selected noise level.

4. Anatomical features: AEC should be used when the region to be
scanned includes significant differences in attenuation, such as
the chest and abdomen. Anatomical regions with slight
differences in attenuation like the head, will not benefit from AEC
use.

3.4 Sample protocols:

Below are some suggested protocols. The noise levels depend on the
size and weight of the patient. The noise levels in the table below are
for illustration purposes. The site physicist and CT manager should
dictate the final noise levels.

Revision 04

Noise Level Minimum mA Maximum MA Slice thickness
Chest scanning 15 50 250 1.2
Chest/Abdomen 13 50 280 2.4

4 AEC algorithm description:

AEC uses the measured attenuation of the scanned object and the
selected noise level to estimate the scan current at each planned scan
location during the scan. The mA is typically estimated using different
water phantom diameters.

The BodyTom 64 uses Z-modulated AEC where each planned scan
location is modeled using a cylindrical water phantom, or WED. The
WED is calculated using the scout profile. Once the WED is estimated
a specific mA value is assigned to each planned scan location. The
Flowchart (Figure 2) below describes the basic steps for using AEC:

1. Select the appropriate AEC parameters to be used, those
values are:
a. Minimum mA
b. Maximum mA
c. Noise Level

2. Acquire a Scout using the same kV that will be used for the
Axial or Helical acquisition.
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a. An AP or Lateral Scout can be used; however, AP scouts are
preferred.

3. For each planned slice, the system calculates the WED and
assigns a specific mA value to that location. Figure 3 shows
the WED of the equivalent water phantoms as calculated
based on the scout image (left). The estimated diameters
(right) shows that the water portion of the phantom match
the true diameter of the phantom.

4. Using the measured noise in different diameters water
phantoms at different mA levels, find the mA that
generates the selected noise level.

5. Adjust the mA based on the scan mode. Figure 4 shows
the estimated mA as well as the adjusted mA for the axial
scan mode.
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Get the Scout scan
(AP or Lateral)

o
>

L 4
For each line in the

MNoise table:
scout

R\l | 100 | 200 | 400 | 600
10 | 10.2 | 7.2 | 5.01 | 3.0
20
30

L J

Estimate the radius
of the equivalent

water phantom.

Use the Noise data
to estimate the ke

scan current.

v

Figure 2: The AEC flowchart

-

l vlJ._l_,li—l_lH

Figure 3: the AP scout of a 20 cm water phantom and the estimated radius based on the scout.
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5 The Noise measurements:

Table 70: The measured noise at 120 kV

The noise tables used for predicting the scan current is measured for
each scan voltage. For each scan voltage the noise is measured using a
set of predefined scan currents of 50, 100, 150, 200, 250 and 300 mA.
The noise is measured using different water phantoms. In our case we
have used 150, 200 and 300-mm water phantoms. Table 70 shows a
sample of the noise table at 120 kV.

Scan

Phantom Currents

Diameter (mA)

(mm)

50 100 150 200 250 300

100 7.5868 5.4078 4.4009 3.8519 3.4769 3.1679
150 10.76 7.6690 6.2493 5.4768 4.8741 4.4806
200 17.41 12.3721 10.1349 8.8315 7.8699 7.1964
250 28.400 20.2000 16.4000 14.3000 12.7000 11.6000
300 49.952 35.6299 28.7523 24.9660 22.3726 20.2553

For example, if we desired to determine scan current in a 175mm water
phantom that has 10 HU noise at 120 kV using the above table. The
Noise is modeled using a 2-dimensional function of the current and the
scan current. The scan current is then extracted from the 2D model. The
noise is measured using a nominal slice width, typically 5.0 mm. The
noise table will then be normalized based on the selected slice thickness

of the scan protocol.
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Appendix E Rotating Anode X-Ray Tube
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Appendix F

Table 71: Error code list

Error Error code

Error Code

code dlesafEiian Popup description Cause
Generic message whenever
Exam has been aborted. Please 2 sca_n/exam has been
try again. If problem persists terminated
0 ABORT_EXAM yasain. p P o) abnormally. User would
contact customer service with . .
not typically see this
code: -
because a more specific
error should be posted.
1 CAN_DEVICE_DISCON Ecc)):'::;cj:Lcsatt(;(r)’::rf:;rl:[/.iczl\f;:s Cannot communicate with
NECT_CENT1 centipede 1 device.
code:
) CAN_DEVICE_DISCON Ecc)):'::;cj:Lcsatt(;(r)’::rf:;rl:[/.iczl\f;:s Cannot communicate with
NECT_CENT2 centipede 2 device.
code:
3 CAN_DEVICE_DISCON Eg:'::;cj:Lcsitc;(r)r?:rf:;rl:[/.iczls\z:s Cannot communicate with
NECT ROTATE rotate device.
- code:
4 CAN_DEVICE_DISCON Eoo:'::;cj:Lcsiz(r)r:]:rf:;rl:c/.iczls\z:: Cannot communicate with
NECT _BIB BIB device.
- code:
Cannot communicate with
Communications fault. Please OIB1 device. Note that this
5 CAN_DEVICE_DISCON contact customer serv.ice with alone will not cause a Fault
NECT_OIB1 state but Start and Cancel
code: .
buttons on one side of
scanner will not operate.
Cannot communicate with
Communications fault. Please OIB2 device. Note that this
6 CAN_DEVICE_DISCON contact customer serv.ice with alone will not cause a Fault
NECT_OIB2 state but Start and Cancel
code: .
buttons on one side of
scanner will not operate.
, CAN_DEVICE_DISCON Es:t‘zlt‘:Liﬂ:‘:rfs::\tnczlsjiﬁ Cannot communicate with
NECT_POWER CCB device.
code:
o CAN_DEVICE_DISCON Egr:'t‘:;‘t‘:Lﬁﬂ:‘:;ﬁ:ﬁi;'ijiﬁ Cannot communicate with
NECT_TRANS Transport device.
code:
o CAN_DEVICE_DISCON Eg:t‘zlt‘:Lc;t;:':rfssr'\t”czlsjiﬁ Cannot communicate with
NECT_DCB code: DCB device.
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Error
code

Error code
description

Popup description

Communications fault. Please
contact customer service with
code:

Cannot communicate with
HVG device.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

There was a problem with
x-ray Enable signal.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

An interlock condition was
asserted.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

The 110% timer has
expired and forced x-rays
off.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

X-ray tube thermal switch
asserted.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

Heat exchanger flow switch
asserted.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

The watchdog timer has
timed out and forced x-rays
off (WD timer is controlled
by the DCB firmware), this
error would be unusual.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

Arcs occurred.

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

A generic HVG fault
condition occurred (look at
HVG_ERROR_ code).

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

Anode (starter) device
reported and error.

10 CAN_DEVICE_DISCON
NECT_HVG

1 HVG_LATCH_ERROR_
ENABLE

1 HVG_LATCH_ERROR_
INTERLOCK

13 HVG_LATCH_ERROR_
110_TIMER

14 HVG_LATCH_ERROR_
XRT_THERM_SW

15 HVG_LATCH_ERROR_
HE_FLOW_SW

16 HVG_LATCH_ERROR_
WDT

17 HVG_LATCH_ERROR_
ARC_FAULT

18 HVG_LATCH_ERROR_
HVG_FAULT

19 HVG_LATCH_ERROR_
STARTER

- HVG_LATCH_ERROR_
DAS_OVER_RANGE

High voltage fault. Please retry
task. If problem persists, please
contact customer service with
code:

DAS (detector) data values
are out of range.
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Error

code

Error code
description

Popup description

HVG_ERROR_MA_RE

High voltage fault. Please retry

task. If problem persists, please

There was a problem with

21 GULATION contact customer service with mA regulation.
code:
High voltage fault. Please retry
29 HVG_ERROR_KV_REG | task. If problem persists, please | There was a problem with
ULATION contact customer service with kV regulation.
code:
High voltage fault. Please retry
53 HVG_ERROR_ANODE | task. If problem persists, please | Anode (starter) device
_STARTER contact customer service with reported and error.
code:
High voltage fault. Please retry
24 HVG_ERROR_INV_OV | task. If problem persists, please | Inverter over temp
ER_TEMP contact customer service with condition.
code:
High voltage fault. Please retry
55 HVG_ERROR_UNCO task. If problem persists, please | An exposure happened
MMANDED_EXP contact customer service with without being commanded.
code:
High voltage fault. Please retry
%6 HVG_ERROR_ANODE | task. If problem persists, please | Anode over voltage
_OVER_VOLTAGE contact customer service with condition.
code:
High voltage fault. Please retry
57 HVG_ERROR_CATHO task. If problem persists, please | Cathode over voltage
DE_OVER_VOLTAGE contact customer service with condition.
code:
High voltage fault. Please retry
)8 HVG_ERROR_ANODE | task. If problem persists, please | Anode over current
_OVER_CURRENT contact customer service with condition.
code:
High voltage fault. Please retry
79 HVG_ERROR_CATHO task. If problem persists, please | Cathode over current
DE_OVER_CURRENT contact customer service with condition.
code:
High voltage fault. Please retry
30 HVG_ERROR_FILAME | task. If problem persists, please | Filament over current
NT_OVER_CURRENT contact customer service with condition.
code:
High voltage fault. Please retry
31 HVG_ERROR_ARC_DE | task. If problem persists, please Arcs occurred.

TECTED

contact customer service with
code:
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Error

code

Error code
description

Popup description

HVG_ERROR_CURRE

High voltage fault. Please retry

task. If problem persists, please

Current return wire

32 NT_RET_WIRE_DISCO . . .

N - - - contact customer service with disconnect.
code:
High voltage fault. Please retry

33 HVG_ERROR_MA OV | task. If problem persists, please | The actual mA was higher

ER_PROG contact customer service with than programmed.
code:
High voltage fault. Please retry

34 HVG_ERROR_KV_OVE | task. If problem persists, please | The actual kV was higher
R_PROG contact customer service with than programmed.

code:
High voltage failure, retry

35 HVG_ERROR_FILAME | protocol, if problem persists There was a problem with
NT_REGULATION contact customer service with filament regulation.

code

2 DCB_ERROR_BAD_DE Sj:\f;iit':t'g;”e':asuel:\'li:;e;is; DCB reported a bad
TECTORS detector condition.

code:
RECON_PROTOCOL_R Recon Protocol Rejected due to | Recon rejected protocol

40 EJECTED_INVALID_PR invalid Type or Usage because of invalid
OTOCOL_TYPE_OR_U
SAGE_PARAMETER parameter parameters.
RECON_PROTOCOL_R . Recon rejected protocol

41 EJECTED_INVALID_PR :T,E\,ZT& er%ttzcczll Rejected dueto | ause of invalid
OTOCOL parameters.
RECON_PROTOCOL_R Recon rejected protocol

42 EJECTED_INVALID_PR | Recon Protocol Rejected due to because of invalid
OTOCOL_IMAGE_CO invalid Image Coordinates
ODINATES parameters.
RECON_PROTOCOL_R Recon rejected protocol

43 EJECTED_INVALID_PR | Recon Protocol Rejected due to because of invalid
OTOCOL_ROI_COODI invalid ROl Coordinates
NATES parameters.
RECON_PROTOCOL_R . Recon rejected protocol

44 EJECTED_HELICAL_Q xﬁz;zzt?:mf:’eded dueto |\ ause of invalid
A_FAILED parameters.

45 Ef:cqrgapigggﬁoéDR Recon Protocol Rejected due to Recon is in an invalid state
Sy - - Recon Busy to perform a protocol.
RECON_PROTOCOL_R Recon rejected protocol
EJECTED_SERIAL_LIN Recon Protocol Rejected due to e

46 because the serial link is

K_DISCONNECT_OCC
URRED

Serial Link Disconnect

not connected.
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Error
code

Error code
description

Popup description

Recon rejected protocol
RECON_PROTOCOL_R Recon Protocol Reiected due to because of insufficient
47 EJECTED_INSUFFICIE Insufficient MemoJr memory necessary to
NT_MEMORY ¥ perform requested
protocol.
RECON_PROTOCOL_R Recon rejected protocol
48 EJECTED_INVALID_PR | Recon Protocol Rejected due to because Jof invaIFi)d
OTOCOL_SLICE_COO invalid Slice Coordinates arameters
DINATES P '
System has encountered an
The R
RECON_DATA_CORR | unexpected error. Please € Recon app reported
50 . . data corruption (view
UPTED contact customer service with
headers not correct).
code:
System failed to properly
perform protocol
51 RECON_OFFSET_CAL_ | calibration. Please try again. If The Recon app reported
FAILED problem persists, please Offset Cal failure.
contact customer service with
code:
System failed to properly
li i . Pl .
RECON_AIR_CAL_FAl | CAlibrationsystem. Pleasetry | oo o100 reported Air
52 calibration again. If problem .
LED . Cal failure.
persists, please contact
customer service with code:
System failed to properly
perform protocol Scanner control app timed
RECON_OFFSET_CAL_ | calibration. Please try again. If s PP
53 . out waiting for an offset cal
TIMEOUT problem persists, please
. . to complete.
contact customer service with
code:
System failed to properly
perform protocol Scanner control app timed
54 RECON_OFFSET_PRO calibration. Please try again. If out waiting for Recon app
TOCOL_TIMEOUT problem persists, please to acknowledge a protocol
contact customer service with request (offset or image).
code:
System is unable to perform
RECON PROTOCOL T protocol. PIe;'ase try again. If Scanne'r 'control app timed
55 = - problem persists, please out waiting for a scan to
IMEOUT . .
contact customer service with complete.
code:
System i ble t f
RECON_PROTOCOL_R ystem 15 Uhabie to per f)rm The Recon app rejected a
56 protocol. Please try again. If
EJECTED . scan protocol request.
problem persists, please
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Error Error code Pobub descrintion
code description pup P
contact customer service with
code:
The image data was not
System is unable to perform found for a Post Recon or
ion. Pl R |
RECON_POST NO_SC posF reconstruction .ease try esend . mages command
57 again. If problem persists, (where image data could
AN_INFO . . . .
- please contact customer service | be scan info file, .dcm files,
with code: .cor files, or entire
directory).
i I f
58 RECON_POST _RECON Z ain. If broblem érsists ¥ Images command could not
_FAILED gain. p P L be run due to scanner
please contact customer service
. state.
with code:
A generic Prepare error
The scanner encountered a . I .p
fault preparing for scan. Please occurred. This should be
60 PREPARE_FAILED preparing o accompanied by a more
contact customer service with .
specific error. See scanner
code: ;
log for detail.
C ications fault. Pl .
DISK_PREPARE_ERRO ommunications fau . eaTse Disk subsystem reported
61 contact customer service with .
R an error during prepare.
code:
The scanner failed to move to
the correct location. Please Scanner Control app timed
check for obstructions or debris | out waiting for scanner to
62 CENTIPEDE_MOVE_TI | on the floor that could impede reach requested position;
MEOUT the movement and try again. If | OR scanner did not reach
problem persists, please required velocity for a
contact customer service with scout or helical scan.
code:
X-rav Dower sequence Scanner Control app timed
ANODE_STARTUP_TI yP 9 out waiting for anode
63 fault. Please contact customer .
MEOUT . . device to report anode
service with code: L
rotation is at speed.
Scanner Control app timed
DISK NOT IN TICK Rotational speed fault: Plea.\se out‘waltmg for dl?k to get
64 MOD_E - - - contact customer service with to tick mode (during
code: prepare for scans that
specify disk rotation).
Failure to position Scanner Control app timed
COLLIMATOR_POSITI ) P out waiting for collimator
65 collimator. Please contact
ON_TIMEOUT . . to get to requested
customer service with code: .
position.
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Error
code

Error code
description

Popup description

DCB communication Scanner Control app timed
DCB_READY_TIME

66 TC - - ou fault. Please contact customer out waiting for DCB to
service with code: report "ready" state.
X- ling fault. PI

HEAT_EXCHANGER_E | Ty cooling fault. Please Heat exchanger did not
67 contact customer service with )
RROR come on during prepare.
code:
Scanner Control app timed
X-ray filament fault. Please out waiting for DCB to
68 FILAMENT_ERROR contact customer service with report "filament on"; OR
code: for filament monitor to
report > 10.
Communications fault. Please Scanner Control app timed
SERIAL_LINK_NOT_U i . out waiting for serial link to
69 contact customer service with s
P code: come up; OR serial link was
) lost before start Acg.
ROTATE COMMAND Rotation communication
70 = error. Please contact customer Unused error code.
FAILED . .
- service with code:
71 TRANSLATE_COMMA | Translate fault. Please contact Move command to
ND_FAILED customer service with code: centipede device failed.
SSP software (Scanner
Software initialization State and Position GUI, the
LD_NOT _START !
72 ESPU -NOT_S — | fault. Please contact customer GUIs that are on the
service with code: scanner displays) did not
start up.
I -
ROTATE_TO_ANGLE_ | Rotational fault. Please contact | SCcanner control app timed
73 . . out waiting for "Rotate to
FAILED customer service with code: " .
Angle" operation.
o COULD_NOT_CLEAR_ | Rotation fault. Please contact ::eorr‘z;ti f::l'fea:zsthe
ROTATE_FAULT customer service with code: P ’
fault cannot be cleared.
ENCODER CONSISTE Encoder consistency
75 =~ fault. Please contact customer Unused error code.
NCY_FAULT . .
- service with code:
The interlock circuit either
Interlock Test Failed. Please remained continuous after
ensure that e-stop is not a Software Interlock was
INTERLOCK_TEST_FAl . . .

76 LED - - engaged. If e-stop is not applied; OR the interlock
engaged, please contact circuit was broken when it
customer service with code: was expected to be

continuous.
DCB TRIPPED WDT D.CB has reported a Watchdog DCB is in a bad state and

77 - - — | Timeout event. Please restart needs to power cycle to

FAULT . .
the scanner and if the problem reset the watchdog timer.
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persists, contact customer
service with code:
MIB has reported a fault and
DCB_MIB_LINK_FAUL | can't acquire DAS data. Please | Mo software not loaded or
78 . . MIB not powered, or data
T contact customer service with L
cable connection issue.
code:
System disk space low, please
80 DISK_SPACE_LOW contact customer service with Unused error code.
code:
DISK_SPACE_QUERY System disk space Iow,' plea‘se
81 contact customer service with Unused error code.
FAILED
code:
Not all devices were found
NOT_ALL_BASE_DEVI on Base CAN bus (or a
CES_PRESENT device has become
disconnected). This should
Base communications be accompanied by
82 fault. Please contact customer another error code
service with code: describing which device(s)
disconnected. You can
look at Scanner Control GUI
for a status of which
devices are present.
Not all devices were found
on Disk CAN bus (or a
device has become
disconnected). This should
NOT ALL DISK DEVI Disk communications be accompanied by
83 - = - fault. Please contact customer another error code
CES_PRESENT . . i . .

- service with code: describing which device(s)
disconnected. You can
look at Scanner Control GUI
for a status of which
devices are present.

CCB BATTERY OPER Battery system fault. I_DIeaS(.e CCB dey|ce reported a (not)
90 y - contact customer service with Operational Alarm
ATIONAL . .
code: (scanning not possible).
CCB BATTERY INTER Battery system communication CCB device reported ar.1
91 LOCE - error. Please contact customer Interlock Alarm (scanning
service with code: not possible).
Circuit breaker has been ,[Bj:;:;yor?falgck::::firs
CCB_BATTERY_MAIN | tripped. Please reset and . )
92 . . running on wall power
_BREAKER contact customer service with .
only. (Scanning not
code: .
possible.)
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CCB_LOW_BATTERY_

Low battery condition. Please

CCB device reported a Low

93 charge system as soon as Battery Alarm (scanning
ALARM . .
possible. not possible).
Dead battery condition. The CCB device reported a
CCB DEAD BATTERY system is shutting down. Please | Dead Battery Alarm (a'uto—
94 AL;RM - charge system and report shutdown of scanner is
- condition to customer service imminent) (scanning
with code: DEFINITELY not possible).
High ition h
CCB_HIGH_BATTERy_ | "igh battery condition has CCB device reported a High
95 occurred. Battery charging has
ALARM . Battery Alarm
been disabled.
CCB device reported an
Overcharged Battery
CCB OVERCGARGED Please power down and unplug A!arm. This is beygnd a .
96 - — | system and contact customer High Battery warning and is
BATTERY_ALARM . . . .

- service immediately with code: serious. The system should
be turned off and
unplugged immediately.

57| COBBATIERY HiGH_ | o o eewth | Termp Al oeamming noe
TEMP_ALARM p g
- code: possible).
CCB device reported an
Over temperature battery Over Temp Alarm. This is
CCB BATTERY OVER condition. Please power down beyorld a ngh TerTlp
98 = - and unplug system and contact warning and is serious. The
TEMP_ALARM . .
- - customer service immediately system should be turned
with code: off and unplugged
immediately.
s | COBBATIERY MEAS | 2o o eewith | Mossuroment Error Alarm
UREMENT_ERROR . .
- code: (scanning not possible)
One or more battery
o | CooBATIEN | SV B | st e ot
ANCE_WARNING . . )
- code: action required. System
will try to correct itself.
RECON_PROTOCOL_R . . . .
o | BECTED A o | FTSon st e feon sreneg
OTOCOL_USAGE_PAR | 0 rofoc?)l
AMETER ' P '
RECON_PROTOCOL_R Reconstruction fault. Please Recon received invalid
EJECTED_INVALID_N . . . .
111 - - contact customer service with number of views in

UMBER_OF_VIEWS_P
ARAMETER

code:

protocol.
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RECON_PROTOCOL_R

Reconstruction fault. Please

Recon failed to initialize

112 EJECTED_RUN_DMA_ | contact customer service with DMA in preparation for
SETUP code: scan.
RECON_PROTOCOL_R | Reconstruction fault. Please Recon received undefined

113 EJECTED_UNDEFINED | contact customer service with usage parameter in
_USAGE code: protocol.
RECON_PROTOCOL_R | Reconstruction fault. Please

114 EJECTED_INVALID_RA | contact customer service with Unused error code.
W_DATA_REPLAY code:

RECON_PROTOCOL_R | Reconstruction fault. Please

115 EJECTED_FILES_RETRI | contact customer service with Unused error code.
EVE_FAILED code:

RECON_PROTOCOL_R Reconstruction fault. Please . .

116 EJECTED_INVALID_PA contact customer service with Recon received incorrect
RAMETER_STRUCTUR code: structure size.

E_SIZE
RECON_PROTOCOL_R
Iy y Reconstruction fault. PI
117 EJECTED_INVALID_PR cjr:‘(c)acsttc:igmearl;;rvicza:;ieth Unused error code.
OTOCOL_FLASH_10_C code:
MD
RECON_PROTOCOL_R
- - Reconstruction fault. Please

118 EJECTED_PREPARE_A contact customer service with Unused error code.

ND_PRIME_POST_RE de-:
CON_USAGE code:
RECON_PROTOCOL_R | Reconstruction fault. Please Re(?on r?CEIVEd @ Protocol

119 | EJECTED_INVALID_P | contact customer service with | /M€ still processing
OST RECON_STATE | code: previous protocol/post

recon.
RECON_PROTOCOL_R Reconstruction fault. Please . .

120 EJECTED_INVALID_M contact customer service with Recon received incorrect

ESSAGE_BODY_LENG structure size.
- - code:

TH

RECON_PROTOCOL_R ,

121 EJECTED_INVALID_RE Esri?ancsttzl:csfcfn::arl;:.rvll')(‘!ga::/ieich Unused error code.
LOAD_PARAMETER_F code:

ILES
RECON_PROTOCOL_R Reconstruction fault. Please Recon was sent an

122 EJECTED_INVALID_U contact customer service with unsupported command
NSUPPORTED_COM code: from scanner control.
MAND
RECON_PROTOCOL_R Reconstruction fault. Please Recon was sent an invalid
EJECTED_INVALID_HE L . helical filter kernel from

123 contact customer service with

LICAL_FILTER_KERNE

L_TYPE

code:

workstation/scanner
control.
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RECON_PROTOCOL_R
EJECTED_INVALID_N
124 UMBER_OF_HELICAL
_IMAGES_FOR_WIND

Reconstruction fault. Please
contact customer service with
code:

Recon received an invalid
number of images for
windmill.

MILL
RECON_PROTOCOL_R | Reconstruction fault. Please Recon failed to initialize
125 EJECTED_GPU_FAILE contact customer service with GPU during preparation for
D _TO_START code: scan.
R i |
RECON_PROTOCOL_R | Reconstruction fault. Please WehiloenszﬁfeIrvoecdess?nmtoco
126 EJECTED_RECON_BU | contact customer service with = S &
previous protocol/post
SY code:
recon.
RECON_AIR_CAL FAl Reconstruction fault. Please Air image above threshold
130 LED_NON_AIR_IMAG contact customer service with . . . .
£ code: for air calibration.

RECON_AIR_CAL_FAI

131 LED_SEND_EVENT

Reconstruction fault. Please
contact customer service with
code:

Air calibration failed to be
performed.

RECON_AIR_CAL_IM
132 AGE_EXCEEDS_THRES
HOLD

Reconstruction fault. Please
contact customer service with
code:

Air image above threshold
for air calibration.

RECON_AIR_CAL_FAI

133 LED_NO_VIEW_DATA

Reconstruction fault. Please
contact customer service with
code:

No view data received
during an air calibration.

RECON_AIR_CAL_FAI
134 LED_CORRUPTED_VIE
W_DATA

Reconstruction fault. Please
contact customer service with
code:

Corrupted views received
during air calibration.

RECON_OFFSET_CAL_

Reconstruction fault. Please

Offset calibration failed to

1 . .
35| FAILED_SEND_EVENT Eggz‘d customer service with | . o erformed.
RECON_OFFSET_CAL_ | Reconstruction fault. Please No view data received
136 FAILED_NO_VIEW_D contact customer service with . . .
during an offset calibration.
ATA code:
RECON_OFFSET_CAL_ | Reconstruction fault. Please Corruted views received
137 FAILED_CORRUPTED_ | contact customer service with durin poffset calibration
VIEW_DATA code: & '
RECON_OFFSET_CAL_ | Reconstruction fault. Please Offset calibration failed
138 FAILED_BAD_REFERE contact customer service with
NCE code: due to bad reference.

RECON_OFFSET_CAL_
139 80_PERCENT_BAD_R
EFERENCE

Please contact Customer
Service immediately and run a
Quality Assurance (QA)
Phantom test to verify image
quality. Error code:

80% of reference detector
values are above the
acceptable threshold
during an offset cal.
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Workstation |
140 UPS_LOW_BATTERY._ co?\::liiE:\IO:I;av:eb:;zn; system UPS device reported a Low
ALARM ' . ge sy Battery Alarm.
as soon as possible.
Workstation dead battery
ition. The Workstation i
141 UPS_DEAD_BATTERY condl.tlon e Workstation is UPS device reported a Dead
ALARM shutting down. Please charge
- L. Battery Alarm.
cart and report condition to
customer service with code:
Workstation high battery
142 UPS_HIGH_BATTERY_ [ condition has occurred. Cart UPS device reported a High
ALARM battery charging has been Battery Alarm.
disabled.
UPS device reported an
h B
Please power down and unplug ,cA)l\;er:; aTrﬁiesdis s;teorr\‘/d a
143 UPS_OVERCHARGED_ | \orkstation cart and contact Hioh B.atter warZin and is
BATTERY_ALARM customer service immediately g. ¥ &
with code: serious. The cart should be
' turned off and unplugged
immediately.
Workstati
144 UPS_BATTERY_HIGH_ ¢ olr StTtlon battery system UPS device reported a High
TEMP_ALARM ault. Please contact customer Temp Alarm.
service with code:
b -
Workstation over temperature UPS device reported a.n .
e Over Temp Alarm. This is
battery condition. Please bevond a High Tem
UPS_BATTERY_OVER power down workstation, v . g. . P
145 warning and is serious. The
_TEMP_ALARM unplug cart and contact
. . cart should be turned off
customer service immediately
. and unplugged
with code: . .
immediately.
Workstation batt t
a6 UPS_BATTERY_MEAS fa:’I: SPTefsne c?)nf;Ztscyjsf:mer UPS device reported a
UREMENT_ERROR N . Measurement Error Alarm.
service with code:
One or more battery
UPS BATTERY IMBAL Workstation battery system voltage levels are not the
147 - - fault. Please contact customer same as the others. No
ANCE_WARNING . . . . .
- service with code: action required. UPS will
try to correct itself.
Workstation batt t
UPS_CHARGER_FAUL | .’ orxstation batiery system UPS device reported a
148 fault. Please contact customer
T . . Charger fault.
service with code:
RECON GENERAL FA Reconstruction fault. I?Ieasg Recon' software
149 ILURE - - contact customer service with experienced an unknown
code: failure.
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Reconstruction fault. Please
contact customer service with
code:

Cause

Recon got a Live Scan
request while a Live Scan is
already in progress.

Reconstruction fault. Please
contact customer service with
code:

The QA Phantom was not
found in the reconstructed
image.

Reconstruction fault. Please
contact customer service with
code:

The scanner did not get
End of Exam event from
recon. Possible that recon
did not get all its views,
indicating a DRB/DMA
issue.

Error Error code

code description

150 RECON_LIVE_SCAN_S
TATE_ERROR

151 RECON_QA_PHANTO
M_NOT_FOUND

152 RECON_TIMED_OUT_
WAITING_FOR_EOE

153 RECON_DRB_CONNE
CTION_FAILED

Reconstruction fault. Please
contact customer service with
code:

Recon software was not
able to connect to DRB
device. Possible DRB
device or DMA driver error.
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Table 72: Revision History

Revision ECO number

00

ECO-005397

Revision History

Effective
date
2021/04/28

Author

Stephen Lombadozzi

Changes

New Release

01

ECO-006571

2023/01/30

Keith A. Kaser

Revised BodyTom Elite manual 1-
NL4000-060rev19 to include
updates required for new BodyTom
64 systems. Added error code 78
and updated error codes 140-153.

02

ECO-006643

2023/03/29

Keith A. Kaser

Updated Laser Safety Section, page
58 (Bug# 5763)

Removed unnecessary sentence
from Administrative privileges
section, page 73 (Bug# 5765)
Modified Window Center/Level
inconsistencies to all say Window
Center (Bug# 5767)

Modified use of the term Cine
Backward to Cine Reverse for
consistency with Ul (Bug# 5769)
Corrected typographical error on
page 239 (Bugtt 5774)

Added detailed Scanner Start-up
Shutdown directions as well as note
that scanner shutdown will not
occur if Tube Heat higher than 19%
(Bug# 5781)

Added unit values to graph on page
383 (Bug# 5772)

Updated CTDI Values in Tables 32,
33, 34, 35,36 and 37.

03

ECO-006933

2023/12/05

Keith A. Kaser

Update to Table 15 per Intertek
review to match testing report.
Replace I-Book symbol with Blue
Man symbol per Intertek feedback.
Updated Window Width/Center
information in table 64: Viewing
Tools to be more in line with UL.
Updated Error codes to re-number
Recon error codes and added Error
code 77 which was missing from the
document.
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Effective

Revision ECO number

date

Author

Changes

Made minor grammar and spelling
corrections throughout the
document.

04

ECO-007472 2025/03/24

Keith A. Kaser

Added Warning in Safety
Information section related to
decommissioning system to remove
health software.

Updated trade name and device
name for clarity.

Updated missing cross reference on
page 70.

Updated Product Marking plate in
Figure 1.

Reformatted and updated Contact
Information table to include CE
mark for European distributer as
well as updated address for Brazilian
Distributer.

Added CE mark to Table of Symbols.
Updated Table 62: Symbols.
Updated Tables 33, 34, 35, 36 and
38 to resolve Bug# 6339.

Updated the “Using the
Interventional Package” section to
include the new Instant Repeat
functionality.

Update Workstation Product
Marking Plate to include proper
“Refer to instruction in user
manual/booklet” icon.
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